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Sections

This book is the maintenance manual for the EM 3000 multibeam echo sounder. It
describes how to perform intermediate maintenance on the system.

1 Introduction

This section presents a general introduction to the echo sounder system, and
defines the maintenance philosophy. Refer to page 1.

2 Technical specifications

This chapter presents the main technical specifications. Refer to page 6.

3 Cable layout and interconnections
This chapter describes the cabling, and details the necessary cable
specifications. Refer to page 10.

4 Processing Unit

This chapter describes the design and operation of the Processing Unit. Each
circuit board is explained, as well as overall block diagrams and the theory of
operation. Refer to page 53.

5 Sonar Head

This chapter gives a description of the design and operation of the Sonar Head.
Each circuit board is explained, as well as overall block diagrams and the
theory of operation. Refer to page 89.

6 Troubleshooting

This chapter provides basic procedures for automatic and traditional
troubleshooting. Refer to page 99.

7 Replacement procedures

This chapter explains how to perform replacement of the line replaceable units
(LRU). Refer to page 161.

8 Datagram formats

The formats for data input and output to and from the EM Series multibeam
echo sounders are described here. Refer to page 167.

9 System administration

This chapter provides basic information useful for the EM 3000 system
supervisor. Refer to page 210.
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10 Spare parts
This chapter provides a listing of the line replaceable units with illustrations
and order numbers. Refer to page 247.
11 Drawing file
Remarks

References

Further information about the EM 3000 system may be found in the following manuals:
* EM 3000 Operator manual

* EM 3000 Installation manual

The reader

This maintenance manual is intended to be used by a trained maintenance technician or
engineer, with experience of electronic and digital circuitry, computers and
electromechanical design. The level of information is based on Kongsberg Maritime’s
maintenance philosophy: The onboard technical personnel shall, with the help of the
documentation and the system’s built-in test functions, be able to identify malfunctions,
locate the fault, and replace major parts, modules and components on the “Line
Replaceable Unit” (LRU) level. He/she will however not attempt to repair the LRUSs.

Note

This manual is issued according to a registered distribution list. In the event of changes
to this manual, only authorized copies with copy numbers will be updated.
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High voltage safety
warning

The voltages used to power this
equipment are potentially lethal. Even
110 volts can kill.

Whenever possible, the following precautionary measures
should be taken before any work is carried out inside the
equipment:

* Switch off all high-voltage power
supplies.

* Check the operation of any door
interlocks and any other safety devices.

* Completely discharge all high-voltage
capacitors.

It should be noted that interlocks and safety devices are
normally located only at regular access points, and high
voltages may be exposed during dismantling.

NEVER WORK ALONE ON
HIGH-VOLTAGE EQUIPMENT!

FIRST AID IN THE EVENT OF
ELECTRIC SHOCK

Normally, even a high voltage electric shock will not kill
instantly. The victim can still be revived even when his
breathing and heart-beat have ceased.

Could YOU save someone’s life? In the event of electric
shock, the correct actions, performed quickly may well
save the victim’s life. Make sure you know what to do!

Immediate action

While shouting for help, remove the source of power
from the victim. Switch off the supply if possible, or
using a dry, non-conductive material (rubber gloves,
broom handle etc.) to insulate yourself, separate the
victim from the source. If the voltage exceeds 1000 volts,
switch off the supply and be ready to catch the victim.
Take care- do not become a victim yourself.

Commence first aid on the spot. Continue to shout for
assistance till someone arrives.

852-164371/E

1 Lay the victim flat on his back and loosen any
tight clothing (collar, tie, belt etc.).

2 Open his mouth and check for and remove any
false teeth, chewing gum etc.

3 Check if the victim is breathing. If not, check if
his heart is beating. The pulse is normally easily found in
the main arteries of the neck, either side of the throat, up
under the chin.

If his heart is beating but he is not breathing, commence
ARTIFICIAL RESPIRATION. If the victim’s heart is
not beating, commence EXTERNAL CARDIAC
MASSAGE (ECM). Continue to shout for assistance till
someone arrives.

EXTERNAL CARDIAC MASSAGE

1 Kneel beside the victim. Place the heel of one
hand in the centre of his chest, at a position half way
between the notch between the collar-bones at the top of
his chest, and the dip in the breast-bone at the base of his
rib cage. Place the other hand on top of the first.

2 Keeping the arms straight and using your entire
weight, press down rapidly so that the breast bone is
depressed four- five cm, then release the pressure. Repeat
rhythmically at a rate of one cycle per second. This will
be hard work, but keep going. His life depends on YOU.
Do not worry about breaking his ribs - these will heal if
he survives.

IX
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ARTIFICIAL RESPIRATION

1 Kneel besides the victim’s head.
Place one hand under his neck and lift,
allowing his head to fall back. This will
lift his tongue and open the air passage in
his throat.

2 Place the palm of the hand on his
forehead to maintain the chin-up”
position.

3 Using the index finger and thumb of
the same hand, pinch the victim’s nostrils
closed. Open his mouth.

4 Take a deep breath and cover his
mouth with yours. Blow steadily into his
lungs to expand his chest. Remove your
mouth from his to allow the air to escape
from his chest. You should be able to see
his chest deflate.

5 Repeat the "inflation-deflation”
cycle at a rate of about 12 cycles per
minute till the victim begins to breath
normally again.

COMBINING EMC AND
ARTIFICIAL RESPIRATION

If you are alone, perform ONE cycle of artificial

respiration for every FIVE cycles of EMC. This will be
hard work, but keep going. His life depends on YOU!

If there are other people available to help, one should
perform the EMC while one performs the artificial
respiration for every five cycles of EMC. It will be much
more efficient with two people.

Once the victim’s heart is beating and he is breathing, roll
him onto his side and support him in that position. As
consciousness returns he may vomit, and this will allow
any liquid to drain out of his mouth.

Remove the victim to a hospital as soon as possible, but
do not interrupt the artificial respiration and EMC cycles
till his heart beat and breathing returns.

If started quickly and performed correctly, the
resuscitation methods described will keep a sufficient
volume of oxygenated blood flowing trough the victims
body to allow full recovery.

Proficiency in the resuscitation methods can only be
achieved trough training. All personnel concerned should
attend courses on a regular basis. Remember, someone’s
life could depend on you.

DO YOU KNOW WHAT TO DO?
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1 INTRODUCTION

1.1 Overview

Note

This is the maintenance manual for the EM 3000 multibeam
echo sounder system.

This manual is common for the AUV Processing Unit and the
Standard Processing Unit.

The manual contains detailed descriptions of each of the units in
the system. Each circuit board and mechanical assembly is
described. The manual also describes the troubleshooting
process based on the Built-In Self test (BIST) software, and it
includes procedures for disassembly and reassembly of the
replaceable items.

This manual does not describe the maintenance of the Operator
Station and the peripheral devices (printers, plotters and
sensors). For information about these items, refer to the
applicable manufacturer’s documentation.

1.2 Maintenance philosophy

852-164371/E

Kongsberg Maritime AS defines three levels for maintenance
manuals:

Organizational - You will only perform limited preventive and
corrective maintenance on the system. There is no need for
technical education or training, and no need for any instruments.
Typical tasks are exterior cleaning, or changing fuses.

Intermediate - You will perform overall preventive and
corrective maintenance on the system. It is recommended that
you are an educated engineer with experience from
computerized design and mechanical systems. It is further
expected that you can use standard electronic instruments, such
as an oscilloscope. You should be trained by Kongsberg
Maritime to perform maintenance on the system. Typical tasks
may include troubleshooting, testing and circuit board
replacement.
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Depot - You will perform detailed maintenance on the system
and on the circuit boards and modules. You must be an educated
engineer with experience of computerized design and
mechanical systems. It is further expected that you can use
standard electronic instruments, such as an oscilloscope. You
should be trained by Kongsberg Maritime to perform
maintenance on the system. Typical tasks are circuit board
repair.

Note This maintenance manual is prepared for the intermediate level.

2 852-164371/E
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1.3 Overview

852-164371/E

The EM 3000 multibeam echo sounder is the ultimate shallow
water mapping and inspection system with respect to high
accuracy and resolution.

The minimum operating depth is from less than 1 m below its
transducers, and in typical sea water conditions the system
operates to more than 150 m depth (less in warm water and
more in fresh water). Small dimensions and low weight makes
the system portable and easy to install allowing use both on
survey launches and subsea vehicles to 1500 m water depth.

The EM 3000 system has a very high ping rate of up to 40 Hz, a
large number of measurements per ping (typically about 120),
1.5° beamwidth, and electronic pitch stabilization. 100%
coverage of the bottom is achievable at vessel speeds of about
10 knots in shallow waters with acrosstrack coverage of up to
four times depth beneath the transducers with a basic system. In
deeper waters the achievable coverage may be up to 200 m, and
100% coverage is achievable with vessel speeds up to 20 knots.

The EM 3000 may be configured to use two sets of transducers
(Sonar Heads). This increases the shallow water coverage to up
to ten times the depth, and the number of measurements per
ping to typically 220. With an angular coverage sector of
nominally 200° the dual system also allows surveying to the
water surface along shorelines, river banks and man-made
structures.

The system sonar frequency is 300 kHz allowing small
dimensions, good range capability and high tolerance to turbid
waters.

Integrated seabed acoustical imaging capability (sidescan) is
included as standard as is a nearfield mode for increased
resolution in very shallow areas. A combination of phase and
amplitude detection is used, resulting in a measurement
accuracy of 5 cm RMS being achievable practically independent
of beam pointing angle.

The EM 3000 is a complete system with all necessary sensor
interfaces, real-time compensation for vessel motion and
ray-bending, data displays for quality control including sensor
calibration, and data logging included as standard.

Postprocessing software for the EM 3000 is available from both
Kongsberg Maritime and third-party suppliers. A world-wide
marketing and service organization, having many years of
multibeam experience, is available for supporting the EM 3000.

— A system overview is shown in figure 1.
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1.4 Processing Unit hardware overview

Note

The EM 3000 is delivered in different versions. Below is a list
of what the different versions are called and what the differences
between them are.

* PU = Processing Unit

“New” PU*

The EM 3000 Processing Unit hardware was upgraded summer
2002. The new PU is available as standard rack or desk mount
unit and as a unit intended for AUV use.

Registrations numbers:
- 299-218014 (AUV single)
- 125-218079 (single)
- 125-218084 (dual)

Software release 5.1u30A or newer is required to run this
hardware.

The CPU board and the serial interface boards are upgraded.

The AUV Processing Unit has all serial interfaces on the CPU
board. The number of external serial lines is three, compared to
four on the Standard Processing Unit.

The ethernet interface on the new Processing Unit is only
available with RJ45 connector.

“Old” PU*

This manual also supports information for the older version of
the Processing Unit.

The software release 5.1u30A will not run on this hardware.
Registration numbers:

- 125-133927 (single)

- 125-134252 (dual)

General

All Processing Units are clearly labeled with their registration
numbers.

The new Processing Unit has a ping rate of up to 40 Hz, while
the old Processing Unit is limited to maximum 25 Hz.

Itis VERY important that the correct software is installed.

852-164371/E
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Note The apperance of the AUV Processing Unit and the AUV
Operating Station is different.

Interfaces:
Storage Sound Speed Sensor
media Tide

Center depth output

Operator
Station

Optional, may also be connected to the
ship's ethernet.

Optional ethernet
Internal
ethernet

Processing Unit

(CD3802B / GIF / WMF)

Serial interfaces:
Positioning systems

Attitude (roll, pitch and heave)
Heading

Clock

Special interfaces:
Trigger input/output
Clock synchronization

Supply voltage:
115 or 230 Vac 50/60 Hz

Sonar Head

Secondary Sonar Head
(optional) |

Figure 1 EM 3000 System overview

852-164371/ E 5
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2 TECHNICAL SPECIFICATIONS

Please note that Kongsberg Maritime is engaged in continuous
developments of its products and reserves the right to alter the
system specifications without prior notice.

Overall specifications per Sonar Head

Maximum ping rate 40 Hz
Number of beams per ping max 125
Beamwidth 1.5°x1.5°
Beamspacing 0.9°
Coverage sector 130°
Transmit beam steering +25°in 0.5° steps
Depth resolution 1cm
Pulse length 150 uS
Range sampling rate 15 kHz (5 cm)
Beamforming method FFT
Depth range from Sonar <1mto > 150m
Head (depending upon conditions)
Maximum swath width > 200m
(depending upon conditions)
Depth accuracy better than 5cm RMS
(excluding external sensors)
Data storage rate 40 to 300 MB/h
(max at about 10m depth)
Frequency 300 kHz
Note Frequencies of 293 and 307 kHz are also available, and are

used in dual Sonar Head systems.

Both beam width and beam spacing are inversely proportional
with the cosine of the beam pointing angle with respect to the
Sonar Head (i.e. beam width is 2.1° at +45° beam pointing angle
and 3.0° at +60°, and beam spacing is 1.3° at +45° and 1.8° at
+60°)

Transmitter

Alongtrack beamwidth: 1.5° (4° in nearfield mode)
Number of elements in array: 56

Source level: 214 dB/uPa at 1 meter

Sidelobes: < -22 dB

Receiver and beamformer
Acrosstrack beamwidth: 1.5° (4° in nearfield mode)

6 852-164371/E
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Beam spacing: 0.9°

Alongtrack beamwidth: 30° (usable to 45°)
Sidelobes: < -20 dB

Range sampling distance: 15 kHz

Number of elements in array: 80 x 3
Bandwidth: 8 kHz

Maximum analog gain: 100 dB

TVG dynamic range: 85 dB

ADC resolution: 12 bits

Interfaces
» Serial lines with operator selectable baud rate, parity, data
and stop bit length for:

- Motion sensor (roll, pitch, heave and optionally heading)
in format supported by sensors from Applied Analytics,
Seatex and TSS

- Gyrocompass in either NMEA 0183 HDT or
SKR82/LR60 format

- Positions in either Simrad 90, NMEA 0183 GGA or GGK
format

- Sonar head depth in Digiquartz compatible format
- External clock in NMEA 0183 ZDA format

- Sound speed profile

- Sound speed at transducer

- Sea level height (tide)

- Datum height(s)

- Output of depth straight down in NMEA 0183 DPT
format

* Interface for a 1 PPS (pulse per second) clock sync signal

* SCSI interface for tape drive (DAT or Exabyte), additional
disk drives, and optional greyscale recorder for seabed
imagery.

» Parallel interface for Postscript color graphic printer or
plotter.

* Optional Ethernet interface for input of sound speed data and
output of all data normally logged to disk and/or tape.

Physical specifications

Sonar Head

Diameter 332 mm
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Height 119 mm (+ 27 mm for con-
nector)

Weight 25 kg (15 kg in water)

Diameter of cable to Sonar |17 mm

Head

Connector Subconn LPBH9F

Material Titanium

Power 24 Vdc, 1 A (available
from the Processing Unit)

Pressure rating 500 m water depth

Note A Sonar Head with pressure rating of 1500 m water depth is

available with the same specifications except for height (121
mm) and a restriction in maximum swath width to 3.5 times
depth (120 °angular coverage sector).

Standard Processing Unit

Height 178 mm

Width 448 mm (excluding rack
fixing brackets)

Depth 370 mm (excluding
handles and connectors)

Weight 10 kg

Power 100 to 240 Vac, < 100 W,
47 to 63 Hz

AUV Processing Unit*
* external harddisk not included (optional)

Height 182 mm (including top
cover)

Width 140 mm

Depth 421 mm (excluding
handles and connectors)

Weight 4.5 kg

Power** 24 -32Vdc, 1A
5Vdc, 8 A

8 852-164371/E
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** These power measurements are at normal operation.
Startup values may be higher. The external power sup-
ply must be rated for higher, inrush current.

The 5 Vdc power should be rated for minimum 12 A
and 24 Vdc for minimum 1.5 A.

Operator Station

(Dimensions will depend upon choice of workstation
model and peripherals. The following figures must
serve as a guideline only).

External storage unit 68 mm

height

External storage unit width | 190 mm

External storage unit depth 310 mm

External storage unit 3 kg

weight

Chassis height 103 mm

Chassis width 418 mm

Chassis depth 443 mm

Chassis weight 10 kg

CRT-monitor

Height 487 mm

Width 475 mm

Depth 506 mm

Weight 31 kg

LCD-monitor

May vary in size.

Power 100 to 240 Vac, < 300 W,
47 to 63 Hz

852-164371/E 9
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3 CABLE LAYOUT & INTERCONNECTIONS

3.1 Introduction

The standard cables used between the EM 3000 system units
and between the units and their external devices are shown here.
For larger installations where the EM 3000 is a subsystem, the
cables will also be shown in the cable layout plan and
interconnection diagram specific for the vessel into which the
system is installed.

Note All cable connections may have to be made in accordance with
the guidelines laid down by the vessel’s classification society.

If no such guidelines exist, Kongsberg Maritime AS
recommends that Det norske Veritas (DnV) Report No. 80-P008
«Guidelines for Installation and Proposal for Test of
Equipment» be used as a guide.

10 852-164371/ E



Cable layout

3.2 System cabling

852-164371/E

Cable layout

The interconnection cables are identified on the cable layout
drawings. Each cable is then listed in the corresponding list,
which contains the required cable specifications. On the
following pages, each cable is identified with the appropriate
terminations.

Refer to the Cable layout plan and interconnection diagram on
page 12 and to the Processing Unit cable connections diagram
on page 19.

Cable specifications

General

Each individual cable is identified on the cable plan. The cables
fall into two categories:

* Cables provided by the installation shipyard or owner
» System cables supplied with the delivery

Shipyard cables

The cables that must be provided by the shipyard or owner are
identified as such in the tables. Note that the cable specifications
given are the minimum specifications.

For each cable, the following information is provided:

» Connection to be made on each end of the cable (including
system unit, terminal board identification and plug/socket to
be used)

* Number of cores
* Recommended cable type
* Minimum cable specifications

The necessary considerations must be taken to suit special
requirements. Kongsberg Maritime accepts no responsibility for
damage to the system or reduced operational performance if this
is caused by improper cabling.

System cables

Several cables will be supplied with the system. Such cables
normally comprise power cables for peripheral equipment, and
interconnection cables for computers and/or workstations. These
cables will normally be delivered with the units.

11
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HWS 10 Operator Station cables

The illustration and the list below specifies each cable used on
the EM 3000 Operator Station. References are made to detailed
cable drawings.

Note that this information includes several cables that may not
be in use on all installations.

C10
AC power

C11

AC power
C8

AC power

Cl
Display

External tape C4
SCSI cable

|| g% C31orC32
‘ USB?2 cable or

FireWire cable

C9
AC power

External hard disk or tape

Cc2

C15 Serial A Keyboard

C16 Serial B

C6 Parallel interface to printer/plotter

C7 Ship’s ethernet C3 Mouse @

C17 Ethernet to Processing Unit (CD21508)

Figure 2 EM 3000 Operator Station - Cable plan

C1 - Display

This is a standard DVI cable. It is normally supplied with the
display unit.

—  Cable details on page 43.

Specific installations may include multiple display
configurations with video splitters and/or switches.

C2 - Keyboard
This is a standard keyboard cable.
—  Cable details on page 40.

12 852-164371/E



Cable layout

852-164371/E

C3 - Mouse or pointing device
This is a standard mouse cable.
—  Cable details on page 41.

C4 - SCSI cable

This cable is used only if the Operator Station is used with
external SCSI storage devices.

When applicable, the cable is provided by the user.

C6 - Centronics printer

The Operator Station only provides one parallel interface to
plotter or printer. In most cases, plotters and printers are
connected directly to the ship’s ethernet network.

—  Cable details on page 42.
When applicable, the cable is provided by the manufacturer.

C7 /7 C17 - Ethernet

The Operator Station is equipped with two Ethernet ports
interface boards, one is used to communicate with the ship’s
Ethernet (C7) while the other (C17) is used to communicate
with the Processing Unit.

—  Cable details on page 36.

The Ethernet cable must be provided by the installation
shipyard.

C8/7C9/ C10/ C11 - AC power

These are AC mains cables. Note that C10 and C11 are only
required if external SCSI storage devices are implemented.

—  Cable details on page 34.
All AC mains cables are normally supplied by the manufacturer.

C15 - Serial A

This serial line is intended for a sound speed probe, which is
normally interfaced by means of a small junction box and a
power supply.

If a sound speed probe is not used, the serial line may be used
for other purposes.

—  Sound speed probe cable details on page 29.
—  Standard 9-pin RS-232 serial line details on page 28.
The cables must be provided by the installation shipyard.

C16 - Serial B

This serial line is intended for a tide sensor. If such a sensor is
not used, the serial line may be used for other purposes.

—  Standard 9-pin RS-232 serial line details on page 28.
The cable must be provided by the installation shipyard.

13
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C31 - USB cable

This is a standard USB2 cable for connecting external storage
devices.

There are four USB ports in the back of the Processing Unit and
two USB ports in front. The two USB in front are normally
blanked to allow for I1P22.

One USB port is used for a software protection dongle.
—  Cable details on page 38.
The cable(s)s must be provided by the user.

C32 - FireWire cable

This is a standard FireWire cable, connecting a storage device.
There is one FireWire port in the back of the Processing Unit.
The cable must be provided by the user.

852-164371/E



Cable layout

Ordinary Operator Station cables

The illustration and the list below specifies each cable used on
the EM 3000 Operator Station. References are made to detailed

cable drawings.

Note that this information includes several cables that may not
be in use on all installations.

C10
AC power
c5 Ci1
External
tape storage SCSI cable AC power
| C8
AC power
External C4 Cl
hard disk SCSi cable Display
C9
/ AC power
(CD7030)
Cc2
Keyboard

C15 Serial A

C16 Serial B

C6 Parallel interface to printer/plotter

C7 Ship’s ethernet

C24 Remote

Remote

C19 Synchronisation system control

The synchronisation system may be connected
to the remote control box, or directly to the Transceiver Unit.

C3 Mouse

Coax to Transceiver Unit C18

Ethernet to Transceiver Unit C17

Figure 3 EM 300 Operator Station - Cable plan

852-164371 /E

15



EM 3000 / Base version

16

C1 - Display

This is a standard VGA cable. It is normally supplied with the
display unit.

—  Cable details on page NO TAG.

Specific installations may include multiple display
configurations with video splitters and/or switches.

C2 - Keyboard

This is a standard keyboard cable. It is normally supplied with
the keyboard.

—  Cable details on page 40.

C3 - Mouse or pointing device

This is a standard mouse cable. It is normally supplied with the
keyboard. Note that different workstation types allow for
different mouse connections. On Unix workstations, the mouse
is often connected to the keyboard, while most PCs provide a
socket on the computer assembly.

—  Cable details on page 41.

C4 / C5 - SCSI cables

These cables are used only if the Operator Station is supplied
with external SCSI storage devices.

When applicable, the cables are provided by the manufacturer.

C6 - Centronics printer

The Operator Station only provides one parallel interface to
plotter or printer. In most cases, plotters and printers are
connected directly to the ship’s ethernet network.

—  Cable details on page 42.
When applicable, the cable is provided by the manufacturer.

C7 - Ship’s’ethernet

The Operator Station may be equipped with one or two ethernet
interface boards. When two -2- boards are provided, one is used
to communicate with the ship’s ethernet while the other (C17) is
used to communicate with the Transceiver Unit.

—  Cable details on page 36.

The ethernet cable must be provided by the installation
shipyard.

852-164371/E



Cable layout
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C8/7C9/ C10/ C11 - AC power

These are AC mains cables. Note that C10 and C11 are only
required if external SCSI storage devices are implemented.

—  Cable details on page 34.
All AC mains cables are normally supplied by the manufacturer.

Cl2 /7 C13 / C14 - Not used
For future expansion.

C15 - Serial A

This serial line is intended for a sound speed probe, which is
normally interfaced by means of a small junction box and a
power supply.

If a sound speed probe is not used, the serial line may be used
for other purposes.

—  Sound speed probe cable details on page 29.
—  Standard 9-pin RS-232 serial line details on page 28.
The cables must be provided by the installation shipyard.

C16 - Serial B

This serial line is intended for a tide/depth sensor. If such a
sensor is not used, the serial line may be used for other
purposes.

—  Standard 25-pin RS-232 serial line details on page 25.
—  Standard 9-pin RS-232 serial line details on page 28.
The cable must be provided by the installation shipyard.

C17 - Transceiver Unit RJ-45 interface

The Operator Station may be equipped with one or two ethernet
interface boards. When two -2- boards are provided, one is used
to communicate with the ship’s ethernet (C7) while the other
(C17) is used to communicate with the Transceiver Unit.

The interface between the Operator Station and the Transceiver
Unit is made with either C17 or C18. In some cases two parallel
ethernet cables may be used. These are then normally identified
as C17A and C17B.

—  Cable details on page 36.
The cable must be provided by the installation shipyard.

17
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C18 - Transceiver Unit Coax interface

The interface between the Operator Station and the Transceiver
Unit is made with either C17 or C18.

—  Cable details on page 27.

When applicable, the cable must be provided by the installation
shipyard.

C19 - Synchronisation system
Refer to the Processing Unit cabling.

C24 - Remote
Refer to the Processing Unit cabling.

852-164371/E



Cable layout

Processing Unit cables

The illustration and the list below specifies each cable used on
the EM 3000 Transceiver Unit. References are made to detailed
cable drawings.

Note that this information includes several cables that may not
be in use on all installations.

C17 Ethernet to Operator Station Sonar Head 1 C28
C18 Ethernet to Operator Station (Older systems only) Sonar Head 2 C29
C27 Ground ‘
(CD3071E)
© © © © ©
e N 4
10§UV>Z£XZAC NETHERNET EXTERNAL SENSORS
Max 6 Amp @(-)[
SERTI \
@ e @
SER\ALPDRTZK
)
= @Q@ SERIAL PORTR
A AA @’i}[
A /VSER\ALPORTA
© © © © © ©
C26 AC power Serial 1 C20
C25 1PPS Clock Serial 2 C21
C24 Remote Serial 3 C22
C19 Synchronisation Serial 4 C23

C30 Ethernet to Operator Station (Older systems only)

852-164371/E

Figure 4 EM 3000 Processing Unit - Cable plan

C17 - Transceiver Unit RJ-45 interface
Refer to the Operator Station cabling.

C18 - Transceiver Unit Coax interface
Refer to the Operator Station cabling.

C19 - Synchronisation

An external system may be used to synchronise the echo
sounder’s transmissions. This system is connected to the
Remote plug on the Processing Unit.

In most cases, an external junction box is located in the
vincinity of the Operator Station to facilitate on/off control. The
synchronisation system may then be connected to this junction
box, or directly to the Remote plug.

19
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—  Cable details on page 33.
The cable must be provided by the installation shipyard.

C20/7 C21 /7 C22/ C23 -Serial lines 1 -4

The Transceiver Unit is equipped with four serial lines. All
connectors are 9-pin male D-connectors. The serial lines are
normally set up as follows:

Serial Port 1 - Positioning systems

Serial Port 2 - Motion sensor

Serial Port 3 - Auxiliary 1

Serial Port 4 - Auxiliary 2

—  RS-232 cable details on page 28.

The cables must be provided by the installation shipyard.

C24 - Remote

In most cases, an external junction box is located in the
vincinity of the Operator Station to facilitate on/off control. The
cable from this box is connected to the Remote plug on the
Processing Unit.

—  Cable details on page 33.
The cable must be provided by the installation shipyard.

C25 - 1PPS

This is a timing signal terminated in a coax connector.
—  Cable details on page 27.

The cable must be provided by the installation shipyard.

C26 - AC power

This is the AC mains cable to the Processing Unit.
—  Cable details on page 34.

The cable is provided by the manufacturer.

C27 - Ground

This is a standard ground cable.

—  Cable details on page 35.

The cable must be provided by the installation shipyard.

C28 / C29 - Sonar Head cable(s)

The Sonar Head cable is a special cable. There is one cable for
each Sonar Head, and it is terminated in three plugs. These are
colour coded.

—  Cable details on page 45.
The Sonar Head cable is provided by the manufacturer.
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Cable layout
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C30 - Operator Station interface

This interface is made using an AUI connector. It is only used
on older EM 3000 system.

—  Cable details on page 37.

When applicable, the cable must be provided by the installation
shipyard.

21
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C1
1 { Serial line 1
o AW\ N
]
= Pin 1 — ® e
OGO CCD D U SER(IDAL PORT TITRIG
System:EM[_____]/AUV PROCESSING UNIT
2327323?::;?\;'205 :;\?:ZZ@ZAVDC
kONGSBERG EIMRAD ™
®)
C5 C3
1 PPS Clock Serial line
c2 C10
Serial line 1 [ Hard Disk (optional)
”T — 0 I —
l e | |
2L (0T ET _
I ) &
R e
g -
o A 1 C9
D]i& | [H [H U\ Serial line and +24 Vdc
cs | [ c6
Ethernet | H “ C‘ m Sonar Head
o cr
= @@@ ||| Sonar Head
7 (I

Figure 5 Cable plan - AUV Processing Unit
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Cable layout

3.3 AUV Processing Unit Cable specifications

The cables identified in the cable plan are listed here. Each
cable is identfied with a cable identificator (Cxx). References
are made to dedicated specification sheets with cable details and
connections.

MFS = Manufacturer supply

ID Specifications From/To MFS
C1 Page 30 Serial line 1, trigger

c2 Page 26 (Note 3) Serial line 2

C3 Page 26 (Note 3) Serial line 3

C5 Page 27 1 PPS clock

Ccé6 Page 32 (Note 2) Transducer cable to Sonar Head

Cc7 Page 32 (Note 2) Transducer cable to Sonar Head

(61:] Page 36 Ethernet, RJ45

C9 Page 31 (Note 2) Serial line and +24Vdc to Sonar Head

Optional cables

C10 (Note 1)

| External hard disk

Note

852-164371/E

Note 1 - This is a standard hard disk cable. The physical
properties of these cables are not specified in this
documentation.

Note 2 - The connection is described below and on page 48.
These signals must be connected to a watertight plug. The Sonar
Head cable delivered with the system must be modified with a
new connector to fit this plug.

Note 3 - Some sensors may require RTS and CTS.

—  Refer to cable description on page 28.

Power cables

The AUV Processing Unit uses +5Vdc and +24Vdc for the
Sonar Head. These cables are delivered without connectors.

100 cm cables are supplied by Kongsberg Maritime. They
should be shortened as much as possible to minimize voltage
drop.

The power cables are brown for +5V and red for +24V. Both use
black as ground.

The 5V ground and the 24V ground must be connected together
externally.

The 5V power measured at the motherboard terminals should be
minimum 5.0Vdc. The 5V power should be rated for minimum
12A and 24V power should be rated for minimum 1.5A.

23
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3.4 Sonar Head connection to
AUV Processing Unit

Sonar Head cable

The standard Sonar Head cable delivered by Kongsberg
Maritime has three plugs for connection to the standard

Processing Unit. These plugs must be substituted by one
underwater plug with minimum 10 pins.

A 4 meter cable without connectors in the “Processing Unit
end” is available from Kongsberg Simrad.

This can be ordered on registration number:
e 380-212989

Internal wiring inside the bottle

Cabling from the underwater plug to the AUV Processing Unit
BIFB board:

* Two mini coax cables must be used for the TAXI high speed
up-link.

e A multi wire cable must be used to connect 24 VV, RS485
serial line.

Plug and cable specifications (not supplied by Kongsberg
Maritime):

* 2 mini coax connectors to plug into the BIFB board.
* 2 mini coax cable for the TAXI link.

* Plug for power and serial link for connection to the BIFB
board: standard 9 pins delta plug.

- Minimums cable dimensions: 0.5 mmz2.
—  For more details, refer to figure on page 48.

3.5 Cable terminations

The termination of all the cables into plugs or terminal blocks
are shown on the referenced pages.
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Cable layout

Generic RS-232 serial line (DCE)

This cable described the pin configuration for an RS-232
interface. The Data Circuit terminating Equipment (DCE) end is

852-164371/E

shown.
1 Shield
5 Received data (Rx) 25-pin D-sub connector
3 Transmitted data (Tx) Original and complete RS-232 signal
4 Clear to send (CTS) definition shown. The most commonly
: Request to send (RTS) used signals are shown in bold.
6 DCE Ready (DCE = Data Circuit terminating equipment)
7 Signal ground
3 Received line signal detect
9 Reserved for testing
10 Reserved for testing
11 Unassigned
12 Sec. Rx line signal detect
13 Sec. Request to send
14 Sec. Rx data 13 1
15 Transmitter signal timing
16 e 000000000006
Rx signal timing (DCE source
17 Rxsignal iming (DCE source) | @) \OOOOOOQOOQOO/ @
18 Local loopback
19 Sec. Clear to send
20 DTE Ready 25 14
21 Remote loopback Looking into a female 25-pin D-pin connector
22 Ring indicator
23 Data signal rate selector
24 Tx signal timing (DTE Source)
o5 Test mode
W102 / Rev. B RS-232 serial line (DCE )

Conductors 25x1x0.5 mm2

Screen Overall braided

Voltage 60V

Max.diameter Set by the plugs
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Generic RS-232 Serial line

This cable comprises a multi-purpose serial line. It provides
interface with any peripheral unit. One end of the cable connects
to the local unit (DTE) with a 9-pin "D’ connector, while the
other connects to the peripheral (DCE) as described in the

peripheral unit’

s documentation.

Note that this cable does not support all the signals in the
standard RS-232 specification.

Remote

unit (DCE) to

be connected as described
in applicable documentation

Local (DTE) 9-pin
‘D’ connector

Rx 2
< Tx 3
Screen Ground 5

Looking into
female 9-pin
D-pin connector

Looking into
male 9-pin
D-pin connector

5‘ 1

[.i%ooooobﬂ.’

. To plug housing

W103/Rev G

26

Standard RS-232 serial line
Conductors 3x2x05mm2
Screen Overall braided
Voltage 60V
Max.diameter Set by the plugs
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Cable layout

Generic coax cable

This cable is used for connections to peripheral units or

networks.

Peripheral unit to
be connected as described
in applicable documentation

Live

Local

Coax connector
Live Live
Ground Gnd

Ay ‘—-}‘ -
'\}f ¥ <«—— Screen/Ground

W105 / Rev.D Coax connection to peripheral unit or network

852-164371/E
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Generic RS-232 with CTS and RTS

This is a standard serial cable terminated into a 9-pin
D-connector.

Peripheral unit to
be connected as described
in applicable documentation

Female 9-pin
D-pin connector

Male 9-pin
D-pin connector

[ -!

1

6

9

Local

9-pin ‘D’ connector
Rx 2
T 3
Ground 5
‘ RTS 7
CTS 8

5

(OJOJOJOIO)
=)

W118 / Rev B

Standard RS232 serial line

28

Conductors 6 x 0.5 mm2
Screen Overall braided
Voltage 60V

Max.diameter

Limited by the plugs
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Cable layout

Sound speed probe interface

This cable provides the interconnection between the Processor
Unit work station and the sound speed probe. This connection is
normally made through a small junction box and with a power
supply as indicated in the drawing.

AC Power

(W301)

2

Work Station

Tx

Power

supply 1:1 Junction box

Probe

8-16 Vdc

Rx

3

Ground

X

Male

This cable can be either
male 25-pin D-connector (x=7) ~ hessseeeeecaeeeead
or

9-pin

D-pin connector

1 5
—
0000® Male 25-pin
0000 D-pin connector
—
6 9

male 9-pin D-connector (x = 5)

1
|
¥

13

!
14

|
i i View
0000000000006 —>
@) \\ @@@@@@@@@@@g // o
I

25

W119 / Rev.C

Sound speed probe interface

852-164371/E

The cable between the junction box and the probe is supplied by

the probe manufacturer.

Conductors 2x2x0.5 mm2
Screen Overall braided
Voltage 60V
Max.diameter Set by the plugs
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RS-232 Serial line with Trigger signals
This cable is used by the AUV Processing Unit.

Local

9-pin ‘D’ connector
Peripheral unit to Trig-Out 1
be connected as described RxD-In 2
in applicable documentation TxD-Out 3
Ground 5
F Blanking (RTS) 7
Trig-In (CTS) 8

Female 9-pin oo 00 .
D-pin connector Q oo
1 5
. N
Male 9-pin ) @@@ ) View _>
D-pin connector @@

6 9
W123/Rev A AUV PU - Trigger, RS232 serial line
Conductors 6 x 0.5 mm2
Screen Overall braided
Voltage 60 V
Max.diameter Limited by the plugs
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Cable layout

RS-485 Serial line and power

To Sonar Head

5
|

1
|

le9

Female 9-pin 00000

D-pin connector @ [o 00 OJ @ ’
[

D-pin connector

Male 9-pin [. § T?@@@@@@@%? 2 . ’

T
6

T
9

Local
9-pin ‘D’ connector
GND 1

RS-485 ref 2
RS-485 B 3
RS-485 A 7

+24V 5
L6
GND 7
L8

W124 / Rev.A

RS485 Serial line

852-164371/E

Conductors

6 x 0.5 mm2

Voltage

60V
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Mini Coax

Local Mini

Coax connector

Peripheral unit to Live Live
be connected as described Ground Gnd

in applicable documentation

W125 / Rev.A

Mini coax connection to peripheral unit or network

32
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Cable layout

Note

EM Remote synchronisation and On/Off

This cable connects the Transceiver Unit to a remote On/Off
switch located in a Remote Control junction box (type
EM1-212595). The same connection allows trigger output and
remote control (synchronisation) with a serial line.

This information is also valid for Remote Control junction box

108-212591.

|

Junction box EM1-212595
Terminal block

Transceiver Unit
9-pin ‘D’ connector
‘Remote’

Trigger out

=

/

Trigger GND

—

Standby +

Standby -

On

RTS

CTS

GND

(Not connected)

"tﬁ)m\ld)cﬂ-l}(.JL.)I\Z'IA

Trigger out

O OINOO O WN

______ + Junction box EM1-212595

Trigger GND

RTS |

Trigger out to
external system
(synchronisation)

cTs |

System On/Off

Serial line to/from
external system (synchronisation)

OO N ORI WIN|

W202 / Rev C

Transceiver Unit - Junction Box

852-164371/E

Conductors 5x2x 0.5 mm2
Screen Overall braided
Voltage 60V
Max.diameter Set by the plugs
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Standard AC power cable

This cable is a standard three-wire power cable. It is
commercially available in standard lengths, or may be produced
locally to suit the specific installation needs. The instrument end
is terminated in a standard IEC female socket, while the other
end is terminated in a plug suitable for the local standard.

plug used as example only.

Use the applicable plug to suit
local standard. British standard

&——— Live (normally Blue)
> Ground (always Yellow or Yellow/Green)
R——— Neuitral (normally Brown)

IEC plug

W301/Rev B Standard power cable for 115/230 Vac 2-phase

Note

34

Different cable colours may be used for the *““live” and
“neutral” wires. Ground is however always on green/yellow.

Conductors 2x 1.5 mm?2 + GND
Screen None
Voltage 750 V

Max. diameter

Set by the plugs
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Cable layout

EMC ground

This cable is used to connect the system unit to the ship’s
ground.

Note that this cable must be as short as possible.

Units's ground tag

Ships' ground

W311 / Rev B Ship's ground
Conductors 1 x 6 mm2
Screen None
Voltage 60 V
Max.diameter N/A
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Ethernet with RJ-45

This cable contains the Ethernet connection. RJ-45 plugs are
used to terminate the cable. Note that these plugs must be
screened to comply to EC rules.

LI view
I 4 ’
RJ45 plug Pin1 RJ45 plug
~ TX Data + (White/Orange)
1 1
2 I Tx Data - (Orange) 2
3 ~ Recv Data + (White/Green) 3
|
D e :
5 (White/Blue) 5
6 A Rec\\:v I;ath- (Green) 6
7 i ( :;e rown) 7
3 (Brown) 3
Pairs
Ethernet 10Base-T “Straight Through”
RJ45 plug RJ45 plug
~ (1) TX Data + to (3) Recv Data + |
1 1
2 I (2) Tx Data - to (6) Recv Data - o 2
3 ~ (3) Recv Data + to (1) Tx Data + 3
4 = 4
5 I 5
6 S (6) Recv Data - to (2) Tx Data - 6
7 i 7
8 & . 8
Pairs
Ethernet 10Base-T “Crossover”
NOTE: In order to prevent noise and crossover, The “crossover” cable is used to cascade HUBS,
you are strongly adviced to use the cable pairs or for connecting two ethernet stations or
indicated above. computers back-to-back without a HUB)
W400/ Rev E Ethernet 10Base-T with RJ45 plugs
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Ethernet with 1EEE 802.3

This is a standard ethernet connection. It complies to IEEE

852-164371/E

802.3.
L8
Male 15-pin Female 15-pin
‘. .] D-pin connector D-pin connector .]
|
[ |
9 15
Ethernet Remote
socket system
1 -, Screen
5 Collision presence (+)
3 Transmit (+)
5 Receive (+) ]
6 0 Vvdc
9 Collision presence (-)
Transmit (-)
10 -
Receive (-)
12 +15 Vdc
13 \. .
15-pin [ Connect to connector housing T
D-pin connector
-—
2
View —} I U |:| H D
(\)
W404 / Rev B Ethernet (IEEE 802.3)
Conductors 6 x 0.5 mm2
Screen Overall braided
Voltage 60V
Max.diameter Limited by the plugs
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Standard USB cable

This is a standard commercial USB cable terminated with A and
B plugs in either ends. The cable can be used for most kind of
external devices.

The order number provided is for a 4.5 m cable.

Universal Serial Bus (USB) cable
terminated with an A-plug in one end
and a B-plug in the other.

Internal cables:

Pair 1.

28 AWG twisted pair
(data, green, white) = L]
Pair 2: ;

20 AWG twisted pair
(Power, red, black)
Shield:

Foil and braid & L
£

Length: 4.5 m
Order no: 719-078524

W501 / Rev.A Commercial USB cable

38 852-164371/E



Cable layout

VGA Display cable

This is a standard display cable used to connect the video
signals. Depending on the computer type, the cable may be
terminated in:

» Standard VGA plug (typical on most commercial computers)
* Multiconnector for Unix work stations
» Seperate RGB connectors (used on high-quality monitors)

The cable is normally physically fastened to the display unit,
and it is provided with the plug(s) readily attached.

15-pin ‘D’ connector
(VGA type)

Multi-connector
for Unix work stations

[}
[}

Seperate R, G and B connectors =
(used with monitors)

]

W502 / Rev B

Display Unit

852-164371 /E
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Keyboard cable

This is a standard keyboard cable. In most cases, the cable is
physically connected to the keyboard. It is terminated in a plug

suited to fit the computer.

Plug suited for the computer

In most cases, the keyboard
cable is physically connected
to the computer

(Different keyboard types are supplied)

keyboard

W503/Rev C

Keyboard

40
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Cable layout

Mouse or pointing device cable

This is a standard mouse cable. It is physically connected to the
mouse. It is terminated in a plug suited to fit the computer.

Various mouse types support two
or three buttons, and may also

Plug suited for the computer provide a scroll wheel.

- /

The cable is physically connected
to the mouse

Note that certain mouse types
for Unix work stations Mouse
are connected to the keyboard. (Different mouse types and other pointing devices are supplied)

W504 / Rev C Mouse / Pointing device

852-164371/E 41
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Centronics printer cable
This is a standard Centronics printer cable.

The socket on the rear 1!3 1!
side of the computer I !
is normally a 25-pin female ‘ @ R\6°°°°°°§°°°°°°°°°°°°°°96/} .’
D-connector. i i
25-pin 25 14 Printer
D-connector plug
1 Strobe
2 Data O
3 Data 1
4 Data 2
5 Data 3
6 Data 4
7 Data 5
) Data 6
9 Data 7
10 Acknowledge
11 Busy
15 Error
18- |Ground
24
W505 / Rev C Centronics printer cable

42
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Cable layout

Digital Video Interface (DVI) display cable
This cable is a standard DVI-I cable. It is connected to the LCD

display.

NNNOONNN
— NNNOONNN

NNNOONNN

W508 / Rev.A

DVI cable

852-164371/E
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W600 - Remote synchronization
The cable is supplied by the manufacturer.

Processing Unit

9-pin ‘D’ connector

‘Remote’ _
1 Trigger out >
2 RX (for test) >
3 TX (for test) >
4 >
5 GND >
6 >
7 RTS >
8 CTS R
9 >

W600 / Rev A Remote synchronization

44

Conductors 5x2x0.5mm2
Screen Overall braided
Voltage 60 V

Max.diameter

Limited by the plugs
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Cable layout

W801 - Sonar Head cable

This is the cable from the EM 3000 Processing Unit to the
Sonar Head(s). The cable is supplied by the manufacturer.

Processing Unit Sonar Head
P1/P2/P3 Watertight connector
1 ~ Taxi (-) ~ 1
5 T Taxi (+) T 5
P1 - Red socket \f
3
1 O 4
2 T 5
P2 - Green socket 6
1 iNfD 7
2 ~eL 8
3 Ser!al I!nk 9
4 Serial link :
z +24 Vdc |
—— GND
6 P3
5 1
4 2 /
View:
3 \ Sfe\zl\rl1 into the plug.
W801 / Rev B Sonar Head

852-164371/E
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3.6 Sonar Head cable drawings

46

LB

View:
© Seen into the plug.

© ©
@ @

In-line UV plugg LPIL9F (370-086953)
47

Approx 550 mm

-

(CD3739/380-133240/C)

. <

i

]

1

1

1

1

! A

Approx 60 mm '

L]

1

. Length

15m

]

1

1

]

' cable

1 RCOP

1 60V

. MX(2x0.5) L,

. 4
UV cable . !
12-6621 Pur orange
(642-086803) '

Plug 6-pin EGG.2B.306
CNAD99-COMP
(370-086957)

~ - - ¢ [
- —] /
Heat-shrinkable sleeve

—

7 mm
7 mm

Dismantling the coax cables

Heat-shrinkable sleeve

o]

T

Protection cap
GMA.1B.045.DV
379-086961

Protection cap
GMA.1B.045.DR
379-086962

Plug FFA.1S.250
CTAC52Z-COMP
(370-086959)

I

View:
Seen from solder side.

5/

Figure 6 Sonar Head cable, assembly drawing
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Cable layout

Note On newer BIF boards the TAXI interface is the same as in figure 8.
r——— T T T T T T T T T T T T T T T T T T T ‘:
| ____________________________________
I _: I
| Ser.link | I
: RS485 | :
| B A | +24Vdc +24 Vref : |
| > s |
| - Lo
| o
| z - L
| : L
g -l 1 — po |
| ) |
| 1 2 3 4 5 6 7 8| __J |
| 9-pin |
I —_ — Delta |
I PROCESSING I
:UNIT :
| |
I I
I I
| |
I
: P1 P2 — a6 P3 :
Lo Red Green N ) s . . o ]
(CD3740/824-133234/C)
[. ?ILO %| 00 _ 9 0 09
¢ q H B
£ E 0
Ef' ; 4 g Sonar Head cable
g g g || 2  642-086803
- 2 Diameter 16.9 mm
Oy 2 3 g & s s 8%
5 __1 I O I
SUBCON[~ () o 0 0 60 0 0
-r————- — 1 2 3 4 5 6 7 g8 9 —————————= |
I
| 0 9_9 _90_00 04 owr |
I ® HEAD :
|
| ol |
I I
| % |
I .18 ‘ I
| |
| I S - - r——"fr-"r———""r-fT1T- - il
| 1 O% I I I R I | i
I I 00 0 P06 0 6 © 01 L
I : 3 4 6 5 1 2 : |
l 51500 =0 le o 9.0 0 0] L
I = B IR B B | I
: : C ( —— +24 Vdc : :
B
| : ?_| ?_| ‘Ref Host Sefi‘aIA ‘ : |
: | Out Out | :
I | | I
- | |

852-164371 /E

Standard Sonar Head cable

Figure 7 Sonar Head cable; connection diagram for
Standard Processing Unit.
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AUV Sonar Head cable
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Figure 8 Sonar Head cable; connection diagram for AUV Processing Unit.

48



Operator Station

4 OPERATOR STATION HWS 10

4.1 Description and main functions

852-164371/E

Overview

The HWS 10 is normally the Operator Station used by the EM
3000. UNIX work stations may also be used.

All components making up the HWS 10 are standard PC parts.

This chapter provides the following information:

—

—

—

Description and main functions, page 49.
Operator Station outline, page 50.
Theory of operation, page 51.

Operator Station installation, page 52.
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Depth 480 mm
(excluding handles
and connectors)

(CD25000)

Width 427 mm

v

(excluding rack fixing brackets)

Figure 9 HWS 10 - outline dimensions
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Operator Station

4.2 Theory of operation

852-164371/E

Overview

The HWS 10 is equipped to handle the heavy processing
requirements and high-speed, largevolume data storage demands
of today’s hydrographic systems. It has been specifically
designed as the optimal platform for running the Seafloor
Information System (SIS) real-time operating software used on
the Kongsberg EM multibeam echo sounders. Special features
of SIS include real-time:

* Gridding of sounding data.
* Filtering of sounding data.
» 3-D visualization of sounding data.

» Storage and visualization of high resolution backscatter data
from the seabed and the water column.

Software

The partitioned system disk is dual bootable with Linux® and
Microsoft Windows XP® respectively. SIS software is factory
installed and tested on both operating systems.

Data storage

The primary task of the HWS 10 is to safeguard the collected
data and to visualize it for quality control. All data is initially
stored on a pair of high performance Serial ATA disks. These
disks are run in a RAID1 configuration, thus ensuring against
loss of data even if one disk should fail. They are mounted in
hot swappable enclosures, so that the collected data may be
transported on the disk. An 8x DVD recorder is the standard
means for permanent archiving of the collected data. For users
having preferences for other storage devices or media, the HWS
10 includes USB 2.0, Firewire (IEEE 1394) and SCSI
interfaces. Gigabit Ethernet is available for transfer of the data
to another network computer. For temporary storage data may
also be backed up to the system drive.
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4.3

Note

52

Installation

The HWS 10 is prepared for mounting in a 19” rack. The
system’s 17.4” Industrial LCD monitor is also rack mountable,
and a universal bracket is supplied for tabletop, overhead or
bulkhead mounting. Both the workstation and the monitor are
IP22 rated. A spill-proof US keyboard and a standard optical
mouse is included, but a small P65 keyboard with integrated
track stick is optionally available. A 5.25” externally accessible
drive bay is available for customer use. The system supports the
use of a second LCD monitor, this may be a 15” unit for use as a
helmsman display.

The IP22 rating requires that the two front USB ports (of a total
of six) are covered. If the IP22 rating is not required, and the
two front USB ports are needed, this cover may be removed.

852-164371/E



Processing Unit

5 PROCESSING UNIT

5.1 Description and main functions

Overview

The EM 3000 Processing Unit performs the data acquisition,
signal processing and function control.

This chapter provides the following information:
—  Description and main functions, page 53.

—  Processing Unit outline, page 54.

—  Theory of operation, page 59.

—  Circuit board descriptions, page 63.

852-164371/E 53
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5.2 Standard Processing Unit drawing

Unit body width
448 mm

Front panel width
Unit body 482,6 mm

depth

370 mm

Front panel height
178 mm (4U)

Figure 10 Processing Unit - Outline dimensions
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Processing Unit

5.3 AUV Processing Unit drawing

2235

Min.g220

Liiii A
1apu [ .
1 el 7
]
|
(i
S DL
U v
I« 124 ol 4
) g 1
1< 139.7 > Chassis shown with top cover, mounted in tube.
< 421 >
« 208 | o 192.4 «20.8
S22 @
[IE 0 | ‘

nn ue-

(CD6429b/834-216073a)

—

Figure 11 AUV Processing Unit - Outline dimensions
(shown with Fan Unit and cover).

852-164371/ E 55



EM 3000 / Base version

Circuit boards and modules

The Processing Unit holds several circuit boards, fans and a
power supply. All connections are made on the rear panel.

]l_
ik
0 N N ToSorarteaa 2] | | B
0 IQ’AE‘» * _ __mv_He_au'_:lll
a 1
== B B
== bl
——c—
== 1T~ |- I
S= sl % &l 5
% EL 1N r]
[ g 5
2
[ — -n] N
==l i 1 [u
[ — c— L
%% =l =
E= - *
== :
il il : 7 []:H]
— i N
—c T
i\
\
0 l I + \tt\
% ! '¢' '¢' 3
% (A
: D i 2
il

(CD5868e/125-134252I/GIF)

Figure 12 Processing Unit, wired
The unit holds the following circuit boards and modules:
* 4-Ports Serial Line board

The different versions of the EM 3000 has different serial
line boards:

“OIld” PU: C114P (Reg.no: 719-087002)
“New” PU: CI-104JS (Reg.no: 719-098382)
* Beamformer & Signal Processor (BSP1 and BSP2)

The BSP has two different versions of the U16 EPLD to
interface to the actual CPU board:

“Old” PU: Reg.no: 382-215990,
EPLD version 1.33

- “New” PU/ AUV PU: Reg.no: 382-218016,
EPLD version 7.0

56 852-164371/E



Processing Unit

Note

852-164371/E

Beamformer Interface (BIF1 and BIF2)

If the EM 3000 has a single head, the system uses one BSP
board and one BIF board. If the system has a dual head, it uses
two BSP boards and two BIF boards.

—

Ethernet Adapter
- The Old PU may have a seperate ethernet interface board.
ROM board

On newer systems, made after summer 2001, the ROM board
has been replaced with a DiskOnModule flash disk mounted
on the Control Processing Unit board. The ROM board will
be replaced on older systems too.

Passive Backplane
Control Processing Unit board

The different versions of the EM 3000 Transceiver Unit has
different CPU boards:

“Old” PU: SSC-486H / SSC-5x86H
“New” PU: VIPer 629

- AUV PU: CoolMonster

Power supply

Fan

A more detailed description of all the circuit boards and
modules is found on page NO TAG.

57



EM 3000 / Base version

AUV Processing Unit

Circuit boards and modules

The Processing Unit holds several circuit boards and a fan. The
power must be supplied by the customer.

Fan Unit

— L

CPU . BIF B
K

| o BSP |
_}

B 100 10 100 0

(642d/860-18013a)
The unit holds the following circuit boards and modules:

* Beamformer & Signal Processor (BSP1)

* Beamformer Interface (BIFB)

* Passive Backplane (made by Kongsberg Simrad)

* Control Processing Unit board

Optional:

* External harddisk

Power for external hard disk must be supplied by the customer.

The fan is supplied internally by 5 Vdc.
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5.4 Theory of operation

852-164371/E

Overview

This chapter presents a functional description of the Processing

Unit.

Serial lines to/from Ethernet to/from the
the sensors Operator Station

(CD5841)

— I ....................

Control Processor

A

v

Beamformer and Signal
Processor (BSP)

A

A 4

Beamformer Interface
Board (BIF)

Processing Unit

Command and
control (serial line)

16-bit
sampled
data

HCT = Head Control and
Transmit board

HRX = Head Receiver
board

Sonar Head

Receive/Transmit array

Figure 13 EM 3000, simplified block diagram

Simplified block diagram
The simplified block diagram for the Processing Unit presents

the following main functions:
* Transmission

* Reception

* Processing

—  Refer to figure 13.
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The various parameter settings made on the Operator Station are
sent to the Control Processor in the Processing Unit. The
information is interpreted, and passed on to the Head Control
and Transmit board. After the transmission, the Head Control
and Transmit board read data from 80 channels on the Head
Receiver board, and pass these to the two Signal Processors in

the Processing Unit.

Control functions

The control functions in the Processing Unit are mainly handled
by the control processor board, but additional boards are also

used.

Ethernet to/from the
Operator Station

Serial lines to/from

Processing Unit

the sensors

Ethernet Serial
adapter lines
Bus system
Control
PROM bank processor BSP
BIF Board
: A
b T e
Command and A 4
control (serial line)
» HCT Board

4

v
Receive/Transmit circuitry

Figure 14 The control functions

The Control Processor in the Old PU is not equipped with
interface capabilities, and thus requires external boards to
handle ethernet and serial lines interface.

The New PU CPU is equipped with ethernet interface.
The AUV PU CPU has all serial lines internally on the board.

It also relies on a memory disk for the software contained in the
DOM (DiskOnModule) device. This is located on the Control

Processing Unit Board.
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Note

852-164371/E

On older systems there is no DiskOnModule, but a ROM (Read
Only Memory). This is an external memory board for the
software.

All the peripheral boards used here are commercial.

One serial line, on the Control Processor board, is used to
interface the command and control signals to and from the
Sonar Head. The RS-232 line is converted to RS-485 on the
BIF-board.

External synchronization

The serial lines RTS (Request To Send) and CTS (Cleared To
Send) signals are used for external syncronization. In addition a
Trig out signal is issued by the BIF (Beamformer Interface)
board.

Levels

RTS, CTS = high +3to +15V
RTS, CTS = low -3to-15V
Trig out TTL level

Outputs from PU

Trig out = 1 TXis off (high TTL level)

Trigout=0 TXis active (low TTL level)

RTS = high PU is ready for a new ping

RTS = low PU is not ready

RTS is pin 7

Inputs to PU

CTS = high Ping command

CTS = low Wait

CTSis pin 8 The CTS pulse length must be minimum

30 milliseconds

GND (ground) is pin 5

When the Processing Unit is ready for a new ping, RTS is set to
high. When the external device is ready for a new ping, CTS is
changed into high. The Processing Unit will then start a ping,
change RTS to low (busy), and the Trig out will be low for 10 -
30 uS, when the transmit pulse starts. After the Trig out is
received, the external device should turn CTS to low, or at least
keep it high for 30 milliseconds.
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62

External synchronization, typical sequence:

CTS TX
command

RTS ____________ ...

(PUready) -

(PU busy) (PU busy)

Trig OUt oo . .
> o 3
pulse 8

When the received period is finished and the Processing Unit is
ready for a new ping, the RTS will be changed to high, and the
Processing Unit will wait for a new trigger (a high level on
CTS).

If CTS is high at all times, or if external synchronization in the
installation menu is switched off, the Processing Unit will ping
at its maximum rate.

1PPS

The 1PPS input signal is normally “resting” at a high level.
Each second, a pulse (100uS-1000uS) adjusts the second
counter in the Processing Unit. Since 1PPS isa TTL-signal, a
high level at the input connector must be higher than 2,7 VVdc
(margin is 0.3 VVdc) and a low level (during the pulse) must not
exeed 0.6 Vdc (margin is 0.2 Vdc).
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Processing Unit

5.5 Circuit board descriptions

Overview

This chapter describes all the circuit boards and modules in the
EM 3000 Processing Unit. A functional description with a block
diagram is provided, as well as the facilities provided for
maintenance.
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Serial Line Board (C1-104JS)

If more information is needed, refer to webpage
WWW.moxa.com.

Purpose and description

This is a commercial circuit board designed and produced by
Moxa Technologies. It is located in the Processing Unit.

The board is a cabling space saver that features a built-in RJ45
bracket to save cable layout space and reduce cost.

It has surge protection and ISA bus.

Note A software setup has been done at Kongsberg Maritime to
configure the board.

How it works

The Smartio CI-104JS Series provides 4 RJ-45 sockets for
connection, which save a lot of cable space.

Surqge Protection

To prevent the board from damage caused by lighting or high
potential voltage, TVSS (Transient Voltage Surge Suppressor)
technology is introduced in Smartio CI-104JS to protect the
board. This is critical to harsh environment such as factory.

Specifications

Connector type RJ-45

Bus ISA (16 bit)

Serial RS-232

Ports (interface) 4

Power requirements 83 mA max. (-12V),

57 mA max. (+12V),
100 mA max. (+5V)

Operating temperature 0° - 55°C

Dimensions 157 x 83 mm (width x depth)
Surge protection 25 KV ESD, 2 KV EFT
Facilities

No switches.
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CAP

= . q
= E=(ﬂm 4
i

Figure 15 Illustration of the Serial Line Board.

OoOooOoad

Smartio CI-104J series
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4-Ports Serial Line Board (C114P)

Purpose and description

This is a commercial circuit board designed and produced by
Moxa Technologies. This is identified as C114P, and is located
in the Processing Unit.
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Figure 16 The C114P layout

How it works

Each of the 4 ports can be configured to RS-232, RS-422, or
RS-485 interface individually, but only RS-232 will work on the
EM 3000 system.

Facilities
LEDs
None.

Jumpers

The C114 is set up with IRQ 11 on the jumpers JP9, JP10, JP11
and JP12.
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Links

Note The following settings are only valid for new boards. For
boards older than spring 2001 the settings will be inverted. The
settings that are OFF on these drawings will be ON and vice

versa.

The settings of the C114P DIP switches for use in the EM 3000

are listed in the table below:

Switch 1 2 3 4 5 6 7

SW5 ON ON OFF |OFF |OFF [ON ON
SWi ON ON ON ON OFF |OFF |ON
Sw2a OFF |ON ON ON OFF |OFF |ON
SW3 ON OFF |ON ON OFF |OFF |ON
SW4 OFF |OFF |[ON ON OFF |OFF |ON

Connections

The C114P contains one DB-37 female connector on the rear
side of the circuit board. It comes with a cable; one terminal is a
37-pin male D-type and the other terminal is a four 9-pin male
D-type connectors. This is not used.

RI2
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n
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2 DSR2

EN
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32 RTS1
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DTRO
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GND
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7 RXDO

TXDO

(CD5567,

i§>

Figure 18 DB-37
pin assignment
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—

—

Refer to figure 17 for pin assignments.

In addition, four 10-pin pin-head connectors
corresponds to the DB-37 connector on the board of
C114P. These four connectors are called COML,
COM2, COM3 and COM4, and are connected
directly to the Processing Unit bottom plate.

Figure 19 DB-9 pin
assignment

Figure 17 10-pin
header connector

pin assignment

GND

DTR/RX-

TXITX+

RX/RX+

DCD/TX-

NC

R

CTs

RTS

DSR

(CDS573)

¢ oo

I PP
AEEE,

J

IR SRR

%

Refer to figure 18 and 19 for pin assignments.

o

GND

IN

DTR

w

TXD

N

RXD

[

DCD

DSR/RTS-
RTS/RTS+
CTSICTS+

RICTS-
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Note
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Control Processor Unit board
This board is used by the “Old” PU.

Purpose and description

This circuit board is an ISA Half-sized Single Board Computer
delivered by ICP. It is equipped with a 486 CPU and advanced
high performance multi-mode 1/O. There are two variants of the
circuit board that might be placed in the system. These are

identified as:
* SSC-486H
or

* SSC-5x86H

Both of them are explained in this chapter. The Control
Processor Board is located in the Processing rack.

Specifications

The Half-sized Single Board Computers SSC-486H and
SSC-5x86H provides the following specifications:

clock/calendar

quartz oscillator, 128B
CMOS memory, pow-
ered by lithium battery
for over 10 years of
data retension.

SSC-486H SSC-5x86H

CPU 486SX/DX/DX2 or DX4 |486SX/DX/DX2/DX4 or
Cyrix/AMD 5x86

Bus PC/104 bus ISA bus and PC/104
bus

DMA channels (7 7

Interrupt levels |15 15

Chipset UM8498F and UM8496 | M1489 and M1487

Real-time DS-12887 chip and DS-12887 chip and

quartz oscillator, 128B
CMOS memory, pow-
ered by lithium battery
for over 10 years of
data retension.

drive interface

drives.

RAM memory 1MB to 64MB 1MB to 64MB, EDO
and standard DRAM
supported.

IDE hard disk Up to two IDE hard Up to two PCI Enhance

IDE hard drives.

Floppy disk
drive interface

Two 2.88MB, 1.44MB,
1.2MB, 720KB or
360KB floppy disk
drives.

Two 2.88MB, 1.44MB,
1.2MB, 720KB or
360KB floppy disk
drives.

High speed
serial ports

Two NS16C550 com-
patible UARTs

Two NS16C550 com-
patible UARTs

Bi-directional

Parallel Port

Yes

Yes
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SSC-486H

SSC-5x86H

Watch-dog
timer

Canbesetby 1, 2, 10,
20, 110 or 220 seconds
period. Reset or NMI
was generated when
CPU did not period-
ically trigger the timer.
Your program use hex
043 and 443 to control
the watch-dog and
generate a system
reset.

Canbe setby 1, 2, 10,
20, 110 or 220 seconds
period. Reset or NMI
was generated when
CPU did not period-
ically trigger the timer.
Your program use hex
043 and 443 to control
the watch-dog and
generate a system
reset.

Consumption

(486DX2-66, 4MB
RAM)

+/- 12V @ 20mA (for
RS-232 only)

External power |Yes Yes

connector

Keyboard Yes Yes

connector

Mouse PS/2 Mouse Port on- PS/2 Mouse Port on-
board board

Power +5V @ 2.5A +5V @ 1.75A

(5x86-133, 4MB RAM)

Operating
temperature

0° ~ 60°C (CPU needs
cooler)

0° ~ 60°C (CPU needs
cooler)

—  The set-up procedures for SSC-486H and SSC-5x86H are
described on page 154

Facilities

Jumpers

All the SSC-5x86H- and SSC-486H circuit board’s jumpers are
preset at the factory. The default settings are listed in the tables.

—  Refer to figure 20 for different jumper settings.
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Figure 20 Different applicable jumper settings

The SSC-486H circuit board:

Jumpers Settings Description
SSC-486H CPU JP1 2-3 -
JP2 1-2 -
3-4
JP3 Open -
JP4 Open -
JP5 1-2 -
JP6 Open -
JP7 Open -
CPU Clock JP8 1-2 Closed |-
Generator Speed (33 3-4 Closed
MHz) 5-6 Open
7-8 Open
CPU Voltage JP12 2-3 -
(+3.3V)
JP24 Open -
Upgrade the JP13 2-3 -
External Cache
(128KB, 32K x 8) JP14 1-2 -
3-4
Watch-Dog Timer, JP18 1-2 Open when
Active Type WDT time-out
WDT Time-out period |JP17 1-2 Open -
(10 sec.) 3-4 Closed
5-6 Open
7-8 Open
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Jumpers Settings Description
Parallel Port JP22 1-2 -
Interface,
Parallel Port
Interrupt Setting
(IRQ7)
Parallel Port Data JP20 2-3 -
Request Setting
(DRQ3)
Parallel Data JP19 2-3 -
Acknowledge
(DACK3)
Serial Port Interface, |[JP21 1-2 -
COM1 Serial Port
Interrupt Setting
(IRQ4)
COM2 Serial Port JP23 1-2 -
Interrupt Setting
(IRQ3)
IDE Host Adapter JP11 Open IDE IOCHDRY
Interface Non-Connected
FDC47C665 JP16 Open Enable
Multi-1/O Chipset FDC37C665
PS/2 Mouse IRQ JP15 Closed -
Selection (IRQ12)

The SSC-5x86H circuit board:

Jumpers Settings Description
SSC-5x86H CPU JP1 2-3 -

JP2 2-3 -

JP3 3-4 -

JP4 3-4 -

JP5 3-4 -

JP6 5-6 -

JP7 2-3 -

JP8 2-3 -

JP9 Closed -

JP10 Open -
CPU Clock (33MHz) JP11 1-2 Closed |-

3-4 Closed

JP12 Open -

JP14 1-2 -
CPU Voltage (+3.3V) |JP13 2-3 -
Watch-Dog Timer, JP15 1-2 Open when
Active Type WDT time-out
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Jumpers Settings Description

WDT Time-out period |JP16 1-2 Open -
(10 sec.) 3-4 Closed

5-6 Open

7-8 Open
DiskOnChip Memory |JP17 5-6 Address
Address E000
PS/2 Mouse JP18 Closed Enable PS/2

Mouse, IRQ12

Connections

COML1 is used for external sync (RTS, CTS). COML, pin
RX/TX, is also connected to the test connector at the Processing
Unit bottom plate, for debug purposes and factory production

testing.

—  Refer to description page 61.

1PPS signal is connected from the parallel port (signal on pin
10, GND (ground) on pin 23) to the bottom plate in the
Transceiver Unit.
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VIPer 629 Control Processor Board
This board is used by the “New” PU.

Purpose and description

This is a commercial circuit board designed and produced by
Kontron.

—  Refer to webpage www.kontron.com for more information.

A DiskOnModule (DOM) or a DiskOnFlash (DOF) module is
mounted on this board. This module contains the software
needed for this CPU board, and for the BSP boards. It can be
upgraded from the release CD.

The LAN / Ethernet to and from the Operator Station is
connected here.

(AMEL4 )

Figure 21 VIPer 629
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Cool Monster C37400
Control Processor Board, AUV PU

Purpose and description

This is a commercial circuit board designed and produced by
JUMPtec Industrielle Computertechnik AG.

—  Refer to webpage www.jumptec.de for more information.

A DiskOnModule is mounted on this board. This module
contains the software needed for this CPU board, and for the
BSP boards. It can be upgraded from the release CD.

Cable From To (1) To (2)

Position No.

#7 BIFB-P1 BSP2-P1 BSP1-P1

#8 CPU-COM1 |BIFB-P13 CHASSIS-
serial port 1/trig

#9 CPU-COM2 [BIFB-P2 -

#10(1) CPU-COM3 | CHASSIS-serial port 2 | -

#10 (2 CPU-COM4 | CHASSIS-serial port 3 | -

#11 CPU-LPT1 |CHASSIS-1PPS -
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Figure 22 CoolMonster board details
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ROM board

This board is used by older systems only.

Purpose and description

The ROM (Read Only Memory) board is an ISA bus card that
adds an EPROM socket to a PC motherboard. This is a
commercial circuit board designed and produced by Blunk
Microsystems. The ROM board is located in the processing
rack.

It provides a means of auto-starting embedded applications. If a
properly formatted EPROM is installed, the BIOS will
recognize the EPROM during its ROM scan and pass control to
it after completing the power-up tests. The ROM board uses one
27010, 27020 or 27040, booting applications as large as 128K,
256K or 512K, respectively.

Facilities
LEDs
None

Test points
None

Links

Jumper Base Address
1-8 CE000
2-7 CE800
3-6 CF000
4-5 CF800

When used in EM 3000, the default settings for the ROM board
are jumpers 2-7, and base address CE800.
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Beamformer & Signal Processor (BSP)

Purpose and description

The Beamforming & Signal Processing (BSP) board is a multi
digital signal processor (DSP) board. It is designed to perform
the beamforming and signal processing in sonars and multibeam
echo sounders. It is controlled from a host processor.

The processing power in the Beamforming & Signal Processing
(BSP) board is based on eight Texas TMS320C50 fixed point
digital signal processors working in parallel while beamforming
the data. Next, there are four Texas TMS320C44 floating point
digital signal processors interconnected to use both parallel and
sequential processing of the beamformed data from the fixed
point processors.

The Beamforming & Signal Processing (BSP) board is a single
slot full length standard ISA format circuit board made to fit
into a personal computer.

How it works

The Beamforming & Signal Processing (BSP) board contains
four main sections:

¢ Sonar Input Data
* Beamforming
* Signal Processing
* Host Interface

The Sonar Input Data interfaces an 18-bit wide and 1k deep
Input FIFO (First-In-First-Out) register. This input FIFO holds
the data received from the transducer array through the receiver
processing circuitry. A dedicated digital signal processor reads
the input FIFO.

There are two identical Beamforming digital signal processing
branches. Each consists of four digital signal processors and a
16-bit wide and 8k deep dual port memory (DPRAM). The two
branches are exchanging data by means of this DPRAM.

The Signal Processing section comprises three digital signal
processors dedicated to do further processing of the
beamformed data.

The Host Interface function is maintained by the master
processor on the Beamforming & Signal Processing (BSP)
board. It exchanges data with the host processor via a 16-bit
wide and 8k deep dual port memory (DPRAM) on the ISA bus.
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Facilities
LEDs
D1 (LED): C44 D

Test points

There is one test point for each C50 digital signal processor
(eight total). These testpoints are all connected to the XF/ signal
which is active while that particular C50 access the shared
DPRAM.

There is also one test point for each C44 digital signal processor
(four total). These test points are connected to the I1OF2/ signal,
which is a general purpose 1/O port bit that can be controlled by
the software.

The C44-D testpoint is also connected to a light emitting diode
(D1) for visual observation. The LED will be activated during
each ping.

TP1 C50 EO
TP2 C50 ET
TP3 C50 E2
TP4 C50 E3
TP5 C50 FO
TP6 C50 F1
TP7 C50 F2
TP8 C50 F3
TP11 C44 A
TP12 C44 B
TP13 C44C
TP14 (& D1) [C44D

The testpoints will be active when the corresponding processor
is working.

Links

A number of links are implemented on the board to allow for
several different applications. Links LK1, LK2 and LKS3 are
used to identify the board as one out of maximum eight boards
in one system.
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LK3 LK2 LK1 BSP ID
0 0 0 BSP 0
0 0 1 BSP 1
0 1 0 BSP 2
0 1 1 BSP 3
1 0 0 BSP 4
1 0 1 BSP 5
1 1 0 BSP 6
1 1 1 BSP 7

Link applications
The following links are ON (closed) in this application:

- BSP0 is the master processor (no links).
- BSP1 is the slave processor (link LK1).
Switches

There are no switches on the board.

Connections

The Beamforming & Signal Processing (BSP) holds the
following plugs and sockets:

P1 Sonar input data

P2 ISA bus component

P3 Emulator

P4 Direct memory access

P5 External communication port
P6 Test access port

P7 External communication port

The P1, sonar input data, is connected to BIFB via a flat cable
plug.
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Beamformer Interface Board
(BIFB)

The old version of the BIFB board is called BIF board. It is a
full length ISA board and the functionality is exactly the same as
the newer version BIFB. The BIF board was a part of the EM
3000 until the year 2000.

Purpose and description

The Beamformer Interface Board (BIFB) is an interface board
between the BSP (Beamformer and Signal Processing) board in
the Processing Unit (a PC), and a EM 3000 transducer head with
high-speed serial data sent on TAXI line. The BIFB board
receives data, decode and write them into a FIFO (First In, First
Out), located on the BSP board. A converter between the
RS232, from the Processing Unit, and RS485, to the transducer
head, is implemented. RS232 data is received through a 10-pin
connector (P2). The direction on RS485 (P9) is controlled by
RS232 signal RTS.

The BIFB board is a single slot half-length ISA board made to
fit into a personal computer.

How it works
The BIFB board contains 4 main sections:
» Serial to parallel conversion

BIFB board receives data on high-speed serial line (Taxi
line) and write it into a FIFO located on the BSP board.
All data and all commands other than SYNC are written to
the BSP board.

¢ Power to transducer head

24Vdc is sent down to the transducer head, on connector
P9 from the Processing Unit internal power supply

e Commands to transducer head

All commands to the transducer head are sent on a
standard RS485, half duplex on connector P9. RS232
signals from the CPU (in the Processing Unit) are
converted to RS485 and the direction is controlled by the
RS232 signal RTS (Request To Send).

* Trig out during transmit

During transmit time, a Trig out is sent out on the
minicoax connector P14 and a signal on the connector
P13. This is to synchronise other systems. Only Master
boards (programmed by the CPU) may run the trig signal.
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Facilities
LEDs

There are two LEDs used on the BIFB board. LEDL1 is used as
the "MASTER”, programmed by the CPU. LED4 is the ”ping
activity” LED.

Jumpers
One jumper, ST1, is implemented on the BIFB board.

When ST1 in: Interface for transducer head 1
When ST1 out: Interface for transducer head 2
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Passive Backplane BP-10S

Purpose and description
This is a passive backplane. It has ten ISA-bus slots.

Note The AUV Processing Unit has a special 4 slot backplane.
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How it works
There are no active components on this backplane.

Facilities

LEDs

The LEDs are used as power supply indicators. There are five

LEDs on the backplane:
e +5V

e -5V

+ 12V

e -12V

- 5V is not used and therefore not lit. The three other LEDs

should be lit at all times.

Test points
None
Links
None

Connections
+ 5V, + 12V and - 12Vdc.
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Ethernet Adapter

This board is used in older systems only.

Purpose and description

This is a 16-bit ISA adapter designed and produced by 3Com,
identified as 3C509B-COMBO. The purpose of the adapter is to
connect the transceiver unit to the operator unit. The circuit
board is located in the Processing Rack.

How it works

The cable types and connector specifications in the Ethernet
Adapter are:

¢ 10BASES5 thick Ethernet coaxial, 10BASE?2, fibre etc. with
an AUI connector.

* 10BASEZ2 thin Ethernet coaxial with a BNC connector.
* 10BASE-T, twisted-pair cable with a RJ-45 connector.
—  The 3C509B-COMBO edge connectors is shown in figure 24.

The 3C509B-COMBO has a LED for the link beat. This LED
confirms that there is an active connection between the adapter
and the hub. The thin ethernet segment is terminated at both
ends with a 50 Q terminator.

The maximum bus speed supported by the Ethernet Adapter is
10 MHz.
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Figure 24 The 3C509B-COMBO backplate with its
connectors

86 852-164371/E



Processing Unit

852-164371/E

Facilities
LEDs

Confirms that there is an active connection between the adapter
and the hub.

* If the LED is on, the link beat is working. (The connection is
correct).

* If the LED is off, the link beat has not been established or
there is a problem with the connection between the adapter
and the hub.

* If the LED is blinking, the cable polarity is reversed.
—  Seefigure 24
Connections

The internal wiring gives access to the BNC and RJ45
connections at the bottom plate of the Transceiver Unit.

Setup of the board

If the type of ethernet cable is known at delivery time, the board
is set up accordingly. If not, the board is set up for 10BASE-T
(RI-45).

It is difficult to reconfigure the board on site. (A PC with
ISA-bus and special software is needed).
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Processing Unit Power Supply

Purpose and description

The purpose of the power supply is to feed +5 Vdc, -12 Vdc and
+12 Vdc to the Processing Unit. It also supplies 24 Vdc to the
Sonar Head. It is located on the front side of the Standard
Processing Unit.

How it works
This is a commercial switch mode power supply.

punoib

A A A A
(WA
~AA
ANAA
~
v
A
(UAUAVAVAUAY,

U

AN O A A
~
v

U
~
vuUuuuUuuUyu

0SS

(726€€T-062/8758500)

Figure 25 Power supply, wired
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6 SONAR HEAD

6.1 Description and main functions

852-164371/E

Overview

The EM 3000 Sonar Head contains the transducers and all
transmitter and receiver electronics. It is the only part of the
system that needs to be submerged in water.

A single cable with an underwater plug, connects the Sonar
Head to the EM 3000 Processing Unit.

This chapter provides the following information:

—

—

—

Description and main functions, page 89.
Sonar Head outline, page 90.

Circuit boards and modules, page 94.
Theory of operation, page 92.

Sonar head, details, page 94.
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6.2 Sonar Head drawings

Cable
(max 45 m)

Plug height
27 mm

Unit height
119 mm

vy

(CD3072B)

Unit diameter 332 mm

Figure 26 Sonar Head, outline dimensions

90 852-164371/E



Sonar Head

6.3 Circuit boards descriptions

Circuit boards descriptions

transducer with 80 staves.

The Sonar Head is a watertight unit containing two circuit
boards, a transmit transducer with 56 elements and a receive

The Sonar Head - as seen from above - is shown in figure 27.
* HRX board
* HCT board

o

\

\

=

(CD5844/211463A)

Figure 27 the Sonar Head

852-164371/E
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6.4 Theory of operation

Overview

This chapter presents a functional description of the Sonar
Head.

Note Figure 28 shows the EM 3000 system with a dual head. That is
why two BSP boards and two BIF boards are mentioned. If your
system only has a single head, there is only one BSP board and
one BIF board.

Serial lines to/from Ethernet to/from the
the sensors Operator Station

(CD5841)
>

Control Processor

T 7

Beamformer and Signal
Processor (BSP)

A

Beamformer Interface
Board (BIF)

Processing Unit

HCT = Head Control and

Command and 16-bit Transmit board
control (serial line) sampled
data HRX = Head Receiver
board
v
HCT Board < > HRX Board
A A
v v
TX td. RX td.

Sonar Head

Receive/Transmit array

Figure 28 EM 3000, simplified block diagram

Simplified block diagram

The diagram presents the following main functions:
* Transmission

* Reception

* Processing

—  Refer to figure 28.
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Control functions

The control functions in the Sonar Head are handled by the
HCT board.
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6.5 Sonar Head details

94

Circuit boards and modules

Head Control and Transmit (HCT)
The HCT receive commands from the host computer.

—  The board is described on page 95.

Head Reciever (HRX)

The HRX is a 80 channel receiver, that together with the HCT
PCB, is a complete 80 channel transceiver unit.

—  The board is described on page 97.
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HCT board

Purpose and description

This board is, together with the HRX board, designed to control
transmit and receive tasks in the EM 3000 Sonar Head.

The Head Control and Transmit (HCT) board recieve commands
from the host computer, on half duplex RS-485 serial line, and
send data out on a high speed serial line (TAXI link). Its
purpose is to transmit amplitude and phase variation into the 56
TX channels. It should also read data from the 80 RX channels
on the HRX board.

The board is connected to the HRX board, the TX transducer
and the Processing Unit through seperate connectors.

This board should only be repaired, tested or maintained by
Kongsberg Maritime AS or other personnel approved by
Kongsberg Maritime AS.

Facilities

LEDs

None

Test Points

Testpoint |Function

TPO1 TX_HV. Transmit voltage

TPO2 Not mounted

TPO3 Not mounted

TPO4 Not mounted

TPO5 RENTXFIFO~.Transmit from TX fifo(TXENABLE)
TPO6 Not mounted

TPO7 4xRXFREQ. Four times RX frequency to PDH
TPO8 Not mounted

TPO9 RSDATI. RS485 data input from PU
TP10 RSDATO. RS485 data output from PU
TP11 Not mounted

TP12 SAMP-INT~. Sample interrupt to CPU
TP13 Not mounted

TP14 Not mounted

TP17 RST~.Reset input to processor.

TP18 Chassis. Connect GND to chassis.
TP22 Not mounted
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TP24 TAXI_STRB. Write signal to taxi transmitter
TP25 TVG voltage to PDH

TP28 FILTCLK. Filter clock to PDH
TP29 IFX_VPP. Program voltage to PLD
TP30 GND point for scope

TP31 IS~. 10 strobe from CPU

TP32 DS~. Data strobe from CPU

TP33 STRB~. Strobe signal from CPU
TP34 PS~. Program strobe from CPU
TP35 Not mounted

TP36 Not mounted

TP37 Not mounted

TP38 + 5V digital

Connections

Electrical Interface, interconnection sockets:

P1 Connector to TX transducer
P2 Connector to TX transducer
P3 Connector to Processing Unit
P4 Connector to DSP emulator
P5 Connector to Flexlogic PLD
P6 Taxi connector

P7 Taxi connector

P8 Control Interface to HRX
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HRX board

Purpose and description

The circular HRX board is mounted between the HCT2 board
and TX/RX transducer modules.

Power supplies and all control signals to the HRX are supplied

by the HCT2 board. There are no links on the board, but a few
test points are added.

The Head Receiver PCB (HRX) is a complete 80 channel
receiver system, and consists of the following functions:

* 20 4-channel TVG-amplifier and demodulator hybrids (PDH)

* 20 8-channel 12 bit A/D converters for digitising phase- and
quadrature signals

¢ Bus Interface circuits

The HRX has interface for test-signal injection. All digital
control signals, TVG control voltage and power supplies are
supplied by the HCT (Head Control and Transmit PCB).

How it works

The main function blocks are:
* 20 “rxad” blocks

* One ana_ctrl block

* One dig_ctrl block

The rxad - receiver and analog to digital converter block, consist
of four identical receiver channels. On the left side of the blocks
the channel numbers and plug pin numbers are shown.

The ana_ctrl block consist of the analog circuit functions for the
BITE test signal, TVG control and AD-converter reference
voltage.

The dig_ctrl block consist of the digital circuit functions for the
bus interface between the HRX and HCT.

The signals from the transducers are brought through a
matching filter, that has an input impedance of about 3 kohm.
The input signal is amplified in the VCA (Voltage Controlled
Amplifier). This is located on the PDH hybrid with the rest of
the modules.

The signal is then filtered in a low-Q bandpass filter, and
through a second amplifier before being applied to the
quadrature demodulator.

The quadrature demodulator. consist of two parallel channels,
each with a mixed, programmable amplifier (0 - 30 dB in 6 dB
steps), switched capacitor lowpass filter and simultaneous
sample/hold amplifiers.
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Facilities

LEDs

None

Test points

Testpoint |Function

TPO1 AVCC, +5V analog supply

TPO2 AGND, analog ground

TPO3 AVEE, -5V analog supply

TPO4 VTEST, BITE test signal

TPO5 VCTRL, TVG control voltage

TPO6 ADCREF, 2.5V buffered reference voltage for AD-con-
verters

TPO7 GND, digital ground

TPO8 VCC, +5V digital supply

Connections

Testpoint |Function

P1 Connector to the RX Transducer
P2 Connector to the RX Transducer
P3 Control Interface to the HCT
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7 TROUBLESHOOTING

7.1 Messages (for UNIX only)

852-164371/E

Introduction

The EM 3000 provides numerous messages to inform you of
major and minor hardware and software errors.

The messages, if they occur, will be displayed in the Status
Display in the Message field.

The different utilities operating on the EM 3000 Operator
Station each issue several messages. These messages can be
sorted in four categories:

* display warnings
* display errors

* warnings

* errors

The messages presented as display warnings and warnings
merely point out small inaccuracies, and must be regarded as
guidelines to the normal operation of the system.

The display errors and operational errors reflect major and
minor hardware and software errors, some of which must be
acted upon to ensure the normal operational capability.

The following chapters present all the possible messages, and
briefly explain the proper action to be taken.

The information is provided as follows:
<Nxxx>: - <Message text>
Necessary action with applicable references.

<Nxxx> is the message identifier. The number will allow you to
find the message easier in this document, and it tells you which
utility issued it.

N - module/utility identifier.
XXX - message identifier

In the list below you will find one letter representing each
module. Each module is described in its own chapter. The
number xxx is only an identifier.

S: setup messages
W: ESO/workstation messages
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L: launchpad messages
E: sound speed profile editor messages
P: Ping Display messages

p: Transceiver / Processing Unit messages (Hardware
messages)

The Hardware and CPU CMOS setup messages are presented
with the exact same layout. The Hardware messages also start
with a message identifier <Nxxx>, and have a following
message text.

The message text contains an error code which has to be
decoded to get the exact error condition.

Most display errors are equipped with a help-textfunction,
giving additional help on the errors. This text will, in most
cases, be identical to the action text found in this manual.
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Setup messages
The following messages are presented by the Setup utility.

Display Warning

$10: - Remember to set correct Gain parameters when using Manual
bottom detection!

Normal mode should be Range And Gain, which uses Automatic bottom
detection!

This mode should only be used when automatic bottom
detection doesn’t work. Make sure that the Depth To
Normal Incidence depth indicator has a sensible value -
it should have a value fairly close to the expected depth.

Display Error
S$15: - Unable to write BIST output buffer to printfile <filename>.

An attempt was made to open the printfile in the system
defaults directory for writing, but the operation failed.
You should have full read and write access to the
directory and all files in the directory.

Display Error
$17: - Unable to write BIST output buffer to file <filename>.

An attempt was made to open the savefile in the system
defaults directory for writing, but the operation failed.
You should have full read and write access to the
directory and all files in the directory.

Display Error
$18: - No reply to the current BIST test!

Each of the Built In Self Test (BIST) commands is required
to give a response within a fixed period of time. The
length of this period varies with the type of test. The
Processing Units has sub- units that may not respond in
time, but this should be reported back to the operator as
part of the reply to the current BIST test.

If the Processing Unit does not respond within the
allocated time period, you should try one of the other
tests to see if this is a general problem. If this is the case,
or if the problem persists, you should try rebooting the
Processing Unit.

Display Warning

$21: - The profile is not deep enough, and should be extended. When
you select the OK button, the profile will be sent to the profile editor for
automatic extension.

All profiles used by the system require a maximum
depth of 12000 meters. Profiles less deep will be
extended by the system, starting from the original
maximum depth. The extension is based on standard
table values, with two points interpolated between last
value pair in profile and first table value pair.
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Error

$25: - The Profile contains errors and will not be used. Errors detected:
The same message is used for several types of warnings:

1. Out- of-bounds depth values. Legal interval is
0 - 12000m.

2. Out- of-bounds sound speed values. Legal interval is
1400 - 1700 m/s.

3. Fewer actual samples than stated in profile header,
using actual no. of samples in profile.

4. Gradient anolomies checking two neighbouring value
pairs.

Even though you are given the choice to use the profile,
it is recommended that you use the profile editor to
verify and correct it. Otherwise, the echo sounder
soundings may suffer quality degradation.

Error

$28: - Too step gradients...

If one or more of the samples are spike values, they
should be removed from the profile.

Display Warning
S$32: - The sound velocity profile <name> contains too few samples.

The profile header says that the profile contains less than
two entries. Atleast two entries are required, and for any
real life sounding that is really too few entries.

Display Warning

S§33: - The sound velocity profile <name> contains more than 1000
samples!

The system is not designed to handle profiles exceeding
1000 depth/speed pairs. You should use the profile, or
download again, using 1000 depth/speed pairs as a
maximum.

Display Error
$37: - Sound Velocity Profile <name> was not found!

The specified profile was not located in the directory
containing the sound speed profiles ($SHAREDHOME).
You could have misspelt the profile name, or the profile
has been removed from this directory after it was
selected. Try selecting the profile from the pull-down
menu. This menu is updated every time itis opened, and
should give you the exact list of available profiles.

Display Error

S50: - The file <filename> is not found in the $SHOME/<directory>, or in
the SNEPTUNEHOME/defaults directory.
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Error

$61: - The following entries in the set-up-file are missing or contain an
error in value specification:

All set-up parameters are checked when a set-up file is
opened. Any parameters that are not within legal range
or missing from the file will be listed in this message. By
following the instructions, it is possible to get around the
problem and recreate the set-up file. You may instead
check if you have a backup version of the installation file
in the system directory by selecting the ‘File- >Read...
option. You will probably find some older version of the
file, because any modification of the installation
parameters followed by a File-Save’creates a backup
version of the file to be modified.

Display Error

S$64: - Profile <name> has an error in line 1. The line should contain a
space after the opening parenthesis and one space before the closing
parenthesis. Correct the profile before reselecting...

According to the Simrad ASCII profile format, this space
is required. You can fix the problem using a text editor.
If you have downloaded the profile from an external
source, please verify that your profile source or
download programs adheres to the file syntax.

Display Error

S65: - Profile <name> has an error in line 1.
It seems that the header does not contain the correct no. of elements.
Create the profile before retrying.

The profile header should start with ”(” and close with
”)”. One or both of these elements could not be located
in the header line. You can fix the problem using a text
editor. If you have downloaded the profiles from an
external source, please verify that your profile source or
download programs adheres to the file syntax.

Display Error

$66: - Sound Velocity Profile directory <name> not found!

The missing directory ($SHAREDHOME) is created
during installation, and should always be present. If not,
it means that someone has modified the file system. You
should reinstall the system to recreate the proper
operating environment.

Display Warning

$69: - Profiles in Simrad Survey Format cannot be downloaded...
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The system cannot use this format for sound speed
profiles. These profiles are produced when logging data,
based on a Simrad ASCII format profile selected by the
user. If this ASCII profile is no longer available, and you
would like to use it again, you could use the Profile
Editor to convert the profile into the Simrad ASCII
profile format.

Display Error

$70: - The BIST for SW version returned an empty string!

Error

Each of the Built In Self Test commands will return with
the result being displayed in the BIST output area. This
message informs you that a reply arrived, but that the
reply contained no text to be displayed. This is clearly an
error. Please repeat BIST command to check if the
problem is repeatable. Errors like this should not occur,
and if the problem persists, you are advised to reboot the
Processing Unit and restart the operation station
software.

S$71: - The Set-up-file is empty. Do you want to reinstall the default
Simrad file?

The file containing installation parameter set- up values
was empty. When this happens, the system can
automatically install the default version of the file. The
file may have been corrupted during a program crash.
Confirming installation of default file allows you to
continue. Otherwise, the system cannot be operated...

Display Error

$73: - Format error in BIST return for SW version request!

Each of the Built In Self Test commands will return with
the result being displayed in the BIST output area. This
message informs you that a reply arrived, but that the
reply did not match the expected format. This is clearly
an error. Please repeat BIST command to check if the
problem is repeatable. Errors like this should not occur,
and if the problem persists, you are advised to reboot the
Processing Unit and restart the operation station
software.

Display Error

S74: - '‘BSP Test’ failed - do you want to reboot the BSP unit?
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The BSP sub-unit may occasionally lock up, with no
pings being produced from the echo sounder. When that
happens, the BSP BIST command will fail with this
message. It is, however, possible to restart the BSP
without rebooting the Processing Unit. This will happen
when you confirm that a reboot is wanted. When the
boot is completed, you should run the BSP BIST
command again to verify that the unit responds
correctly.

Display Warning
$93: - Both Heads are currently deactivated! Pinging is disabled...

When configuring a dual head system, at least one of the
heads must be set up with one of the available
frequencies. Of course, an actual dual head requires both
heads being assigned frequencies. A dual head system
can also be configured as a single head system, assigning
frequencies to only one of the heads.

Display Warning
$94: - You cannot use the same frequency on both sonar heads!

Because of interference problems, running both sonar
heads with the same frequency is disabled.

021 S93: - Both Heads are currently deactivated! Pinging is disabled...

When configuring a dual head system, at least one of the
heads must be set up with one of the available
frequencies. Of course, an actual dual head requieres
both heads being assigned frequencies. A dual head
system can also be configured as a single head system,
assigning frequencies to only one of the heads.

022 S94: - You cannot use the same frequency on both sonar heads!
Because of interference problems, running both sonar
heads with the same frequency is disabled.

Display Error

§96: - Environment ’'MODULE_ADDRESSES’ undefined!

The program cannot operate without the specified
environment. Please verify that the correct start-up
procedure is used.

Display Error
$§97: - Network Configuration File not found! File: <filename>

The program cannot operate without the specified file.
Please verify that the file specified by the environment
'MODULE_ADDRESSES’” with hostname as extensionis
present in your home directory, and that you at least
have "Read’ permission.
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Error

$98: - Error in connecting to input socket for program <program name>.

The set-up program tries to open an input socket, but the
operation failed. The most likely explanation, is that the
port no. specified for the set-up program already is in
use. Check if any of the programs started from a
previous session of the system are still running. If so,
terminate these programs. If you do not know how to do
this, it will in most cases be sufficient to log out and then
back in. This will terminate any running programs and
free up resources. Then restart the operator station
software...

Display Error

$147: - Error sending datagrams to Ping Display!

Communication with the Ping Display uses IP socket
communication, where the Ping Display has opened a
specific port for data input. This error occurs when the
set-up program tries to send to that port. The most likely
explanation is that the port no. specified for the Ping
Display is in use by another program.

Display Error

$148: - No profile name entered!

You have not specified a profile name - the input field is
empty. Enter a profile name to proceed...

Display Warning

S$150: - The file <filename> was empty, and factory defaults was read.
Please verify all settings and save all settings using the 'File->Save’
menu option.

The specified file containing set-up parameters
(runtime or installation) was empty. When this happens,
the system automatically installs the default version of
the file. The file may have been corrupted during a
program crash.

Display Error

S$151: - The file <filename> is not found in the $SHOME directory, or in
the SNEPTUNEHOME/defaults directory. After verifying the settings,
you may create the file by using the °File->Save’ menu option. The
program terminates when you select the OK button.

The specified file containing set-up parameters
(runtime or installation) is missing from the system
directory, and was not located in any of the predefined
locations for the file. The error indicates that the system
somehow has been corrupted, possible due to manual
operations in the file system. It is advisable to reinstall
the system to re-establish system integrity.
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Display Error

S$152: - Not able to copy the file <filename> to $HOME/<filename>.
The program terminates when you select the OK button.

The specified file containing set-up parameters
(runtime or installation) was missing from the system
directory, and could not be copied to this directory. Due
to problems with the directory access. The errorindicates
that the system somehow has been corrupted, possible
due to manual operations in the file system. It is
advisable to reinstall the system to re-establish system
integrity.

Display Error
$206: - Min. Depth must be less than Max. Depth!

It should be fairly easy to fix - just enter a minimum
value less than the maximum value...

Display Error
$207: - Max. Depth must be greater than Min. Depth!

It should be fairly easy to fix - just enter a maximum
value greater than the minimum value...

Display Error

$208: - Legal interval: [<value>, <value>]
The input value is outside the specified interval -
re-enter value to proceed...

Display Error

$209: - Max. Port Angle - Max. Starboard Angle must be > 40!

The Max. Port Angle and Max. Starboard Angle are
restricted with respect to the angle of each other in order
to avoid too wide swath. Re-enter value, keeping the
input value within restrictions indicated by the message.

Error
033 S209: - Max. Port Angle - Max. Starboard Angle must be > 40!

The Max. Port Angle and Max. Starboard Angle are
restricted with respect to the angle of each other in order
to avoid too wide swath. Reenter value, keeping the
input value within restrictions indicated by the message.

Display Error

$211: - Couldn’t locate Workspace of Main Program!

If this error occurs, it means that certain workspace
functions will be disabled, but that the overall
functionality will be present. It has been observed that
restarting the Operator Station software may remove the
problem.
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Display Error

S212: - Couldn’t connect to SMS Server!

Occurs when the program is started independent of the
rest of the system, or when the operating environment is
insufficiently defined. It means that none of the
functionality based on running an integrated system
will be present, thereby rendering the system
inoperable. If restarting the system does not remove the
problem, it is likely, that the easiest way to fix it is to
reinstall the software.

Display Error

$213: - lllegal Window Configuration Command received: <command>

An unknown workspace or window command was
received. Should not affect the main functionality of the
program.

Display Error

S214: - Couldn’t send status to SMS Server!

This is a serious error, which should not occur. It reflects
internal corruption in the communication link with the
rest of the system. It means that none of the functionality
based on running an integrated system will be present,
thereby rendering the system inoperable. If restarting
the system does not remove the problem, it is likely, that
the easiest way to fix it is to reinstall the software.

Display Error
S215: - Server Connection Broken!

This is a serious error, which should not occur. It reflects
internal corruption in the communication link with the
rest of the system. It means that none of the functionality
based on running an integrated system will be present,
thereby rendering the system inoperable. If restarting
the system does not remove the problem, it is likely, that
the easiest way to fix it is to reinstall the software.

Display Warning
$237: - No profile downloaded...

The system has not received any download profiles.
When downloading takes place, the set-up program is
notified of the profile name. So far, it seems that nothing
has arrived.

Display Warning
$238: - Profile not located in profile directory!

When downloading takes place, the set-up program is
notified of the profile name. The system has received a
download profile, but it could not be located in the
directory used for sound speed profiles.
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Display Error

$239: - Sensor Offset + current sound speed exceeds maximum speed
of 1700.0 m/s.

The system does not recognise sound speeds in water
exceeding 1700 m/s. To correct, enter an offset value,
which keeps the sum of sound speed and offset value
below or equal to 1700 m/s.
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ESO messages
The following messages are presented by the ESO utility.

Display error

WS5: - Serial Set-up-file <filename> missing. Install Default file?

The specified file is either removed or renamed.
However, the default file provided will enable all
functions on a system not extended with a serial port
expansion card.

Display error

W9: - No Serial input device is open! Select the 'Smart Probe Profile
Inputs’ as the current serial 1/0 function in the ’Workstation 1/O
Interfaces’ menu.

The serial port specified for this function could not be
opened as expected probably due to error in read / write
permission, or that a non-existing device is specified in
the set-up-file.

Display error

W12: - Unable to open temporary file <filename>!

The error occurs because of inaccurate read/write
permissions to the system directory. This is either an
installation error, or an error introduced after
installation.

Display error

W17: - Input Error. To enable new input, you must reselect the current
input function.

The input format was not recognised. Reading from the
serial port was disabled to avoid further input, and must
be reactivated by reselecting the input function.

Display warning

W22: - No probe samples logged!

The sampling of probe values was terminated, but no
values were actually received. Check probe connections
and serial port set-up.

Display warning

W26: - The file <name> was empty. Factory Defaults was used instead.
Please verify settings and use the ’File -> Save’ command to make
settings permanent.
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This means that the set-up-file somehow has been
corrupted. (E.g. system crash, text editor). A
workaround is to set all parameters in the menus as
required, and recreate the set-up-file using the
'File->Save’ command. If this is followed by the
'File->Read” command, full functionality should be
restored. Alternatively, you could exit the program -
remove the empty file - and then restart the program.
This will enable you to install the default set-up-file
delivered with the system.

Display error

W27: - The file <filename> is not found in the $HOME directory, or on
$SNEPTUNEHOME/defaults directory.

The set-up-file should be present in both the indicated
locations. If you at any point have done a system
upgrade, you should check for backup copies in any of
the system directory backups in the login directory.
Backup file syntax: ”.eso_system<date_time>/
.esoSetup.serial”. If no such files are found, search for the
file on the CD-ROM containing the installation.

Display error

W28: - Not able to copy the file <filename> to $SHOME/.eso_system.
Program terminates when you select the OK button.

The error occurs because of inaccurate read/write
permissions to the system directory. This is either an
installation error, or an error introduced after
installation.

Display error

W29: -Not able to remove the file <filename>. Check access and owner
of the file. Program terminates when you select the OK button.

The error occurs because of inaccurate read/write
permissions to the system directory. This is either an
installation error, or an error introduced after
installation.

Display error

W30: - Unable to open device <device-name>! You may have a
permission problem.

The error occurs because of inaccurate read/write
permissions to the specified serial port device. This is
either an installation error, or an error introduced after
installation.

Display error

W40: - The set-up file is incomplete. Verify all parameters. Then save
your configuration using the °File->Save Set-up’ menu option. Then
read the set-up using the 'File->Read Set-up’ to reinitiate the system!
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The file could be corrupted (system crash), or modified
outside the program (text editor), accidentally removing
parts of the file.

Display error
W41: - Incomplete SVP CALC profile received on the network...

When receiving from the network, AML CALC files are
supposed to be received in one go, i.e. complete with
both profile identifier and termination sequence. In this
case, no termination sequence was found in input.

Warning

W43: - The device associated with this function is in active use by the
following function:
<function>.
To use the selected function:
1. Switch OFF the other function
or
2. Change device associated with one of the two functions.

Warning

W44: - You must terminate any active functions before reading set-up
file!

Warning

W45: - Could not open tide output file: <filename>. You may have a

permission problem...
An attempt was made to open the tide file in the current
survey directory, but the operation failed. You should
have full read & write access to the directory and all files
in the directory.
Correct the directory & file access and activate the tide
input function again.

Warning

W46: - The <name> function cannot share device with the <name>
function. Per definition, only the following functions may share device:

<list of functions>

These functions may all be active at the same time.

Warning

W53: - Serial Port input not recognised! To enable new input, you must

reselect the last selected input function
The input received was not recognized. This could be
due to errors in the format used for transmitted data, or,
if a serial line is used, errors in setting up serial line
characteristics.
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Warning

W54: - Input buffer overrun - function disabled! To enable new input, you
must reselect the currently disabled input function.

Error

W60: - The last command sequence to the probe failed. Repeat your
latest action to retransmit sequence. If this message was issued when
bringing up this window, select the ’Apply Settings’ button in the
‘'Sampling Parameters’ section to repeat sequence.

The probe did not recognize the last command issued.
This could be caused by garbled serial line transfer.
Verify your serial line settings and retry the command
once again.

Error

W61: - No reply to last SV Plus command! Probe may be disconnected
or without power...

Error
W62: Format Error in SV Plus Input!

The input from the probe was not recognized.This could
be caused by garbled serial line transfer. Verify your
serial line settings and retry the command once again.
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Launchpad messages

The following messages are presented by the Launchpad

utility.

Display Error

L12: - The following Program(s) should always run, but is still NOT

running:

The Operator Station software is an integrated system,
and is based on having a predefined set of programs
running. If not, the echo sounder cannot be operated.
You may look for any messages related to the offending
program in the "Messages’ area of the ’Status Display’,
or use the ‘File- >Print / View’ menu item to bring up the
"Message Viewer’.

Select the icon for the offending program(s) to check for
any messages that could help you locate and fix the
problem.

Display Error

L13: - Echo Sounder Not Ready!
The Initial 'Power Up’ Built In Self Test (BIST) has failed. Details may be
found in the ESO Set-up BIST Self Test (Show->Testing) menu.

The Echo Sounder has a range of Built In Self Test (BIST)
commands, testing various parts of the Sounder.

Every time the Operator Station software is started, a
link to the Processing Unit is established and the Initial
Power-Up-Test is performed. If this fails, the Echo
Sounder is inoperable, and the operator should examine
the error messages in the BIST test window in the
Set-up- program.

Additional status information may be obtained using
the other BIST tests available.

Display Error

L15: - Error in Runtime or Installation set-up values!
Must be corrected before activating!

All parameters go through verification checks. First
while reading from the Set-up-file, and second while
entering parameters manually. The reported error is
detected while reading from a Set- up-file, and will block
Echo Sounder operation until corrected.

Set the correct value for the offending parameter(s) in the
set-up program, and use the ’File’ menu ’'Read’
command to read the set-up back in.

This will automatically verify the new set-up.

Display Warning

L16: - No reply from PU on 'Time Request’. Logging NOT started!
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When activating logging of data, the system timestamps
some of the datagrams used in the process.

The time to use was requested from the Processing Unit,
but the reply did not arrive within a fixed period of time.
This may be due to a Processing Unit running at full
capacity, or - if the situation continues, while having a
normal load on the system - that you may have network
problems.

Display Warning

L39: - The <program name> program has not yet registered.
Do you still want to wait for the program to come up?

When starting one of the programs used by the system,
it will try to hook up to enable the necessary
communication and supervision. If a program does not
succeed with this initial registration or hook up, it may
have problems in the initial phase of starting up.
Please refer to the "Status Display, Messages Section” for
possible error messages that may help sorting out the
problems.

Display Error

L40: - The following Program(s) has not yet registered:

All programs started and supervised by the Launchpad
establishes a communication link with the system when
they are launched. The listed program(s) did not succeed
in establishing this link. It could be that the program (s)
crashed before the linkup was attempted. If so, the
program(s) has no possibility to communicate with the
rest of the system. You may try a manual start of the
system in a window, to see if you can find any useful
messages written in the window.

Warning
L45: - Error reading input datagram...

Reading from the communication input socket failed.
This is a low-level error, and should not occur if the
system managed to start properly. If the error persist, try
terminating the system and restart the software again.

Display Error

L47: - The Initial Power Up Self Test failed.
Do you want to repeat the test?

Please refer to the test menus in the Echo Sounder Set- up
program for details.

Warning

L52: - Sound Speed At Transducer deviates more than X m/s from the
corresponding value defined by the current Sound Speed Profile!
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The sound speed at transducer depth received from the
probe exceeded the selected alarm offset 5 times in a row.
You should verify that you are using the correct sound
speed profile, and also verify the size of the alarm offset.

Warning

L54: - Current Center Depth exceeds original maximum depth from the
current Sound Speed Profile!

Center Beam Depth = <depth>
Profile Max. Depth = <depth>.

The original profile had a maximum depth before the
automatic profile extension extended the profile down to
12000 m. The depth you now are registering exceeds this
depth. This could mean that your original profile isn’t
deep enough for this area.

Display Error

L59: - Echo Sounder Not Ready!
Error in Sound Speed Profile!

There are no samples in the current Sound Speed Profile!
Verify & correct current profile, or select a new one! After
doing this, you should run the Power Up Built In Self
Test (BIST) to enable the system.

Display Error

L60: - Echo Sounder Not Ready!
Error in echo sounder set-up parameters!

All parameters go through verification checks. First
while reading from set-up-file and second when
entering parameters manually. The reported error is
detected while reading from the set- up- file, and must be
corrected before continuing! After doing this, you
should run the Power Up Built In Self Test (BIST) to
enable the system.

Display Error

L62: - No Processing Unit has been detected while scanning the
Network.
Do you want to terminate the Launchpad?

The Operator Station is not receiving broadcast
datagrams from the Processing Unit. The continuing
flow of broadcast datagrams tells the rest of the system
that the PU is still alive. To prevent gaps in the line and
possible data corruption, logging was stopped. Possible
reasons for loss of contact:

. Processing Unit is not Powered On

. Network Cable Problems

. Configuration Errors

. Processing Unit Hardware / Software malfunction
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Error

L64: - Connection timeout - Logging switched Off!

Error

The Operator Station stopped receiving broadcast
datagrams from the Processing Unit. The continuing
flow of broadcasts datagrams tells the rest of the system
that the PU is still alive. To prevent gaps in the line and
possible data corruption, logging was stopped. Possible
reasons for loss of contact:

.Processing Unit is not Powered On

.Network Cable Problems

.Configuration Errors

Processing Unit Hardware / Software malfunction

L65: - Connection timeout - Pinging switched Off!

Error

The Operator Station stopped receiving broadcast
datagrams from the Processing Unit. The continuing
flow of broadcast datagrams tells the rest of the system
that the PU is still alive. The system status was set to No
Pinging. Possible reasons for loss of contact:

.Processing Unit is not Powered On

.Network Cable Problems

.Configuration Errors

.Processing Unit Hardware / Software malfunction

L66: - Timeout in Processing Unit <-> Launchpad Connection!

The Operator Station stopped receiving broadcasts from
the Processing Unit. The continuing flow of broadcasts
tells the rest of the system that the PU is still alive.
Possible reasons for loss of contact:

.Processing Unit is not Powered On

.Network Cable Problems

.Configuration Errors

.Processing Unit Hardware / Software malfunction

Display Error

L67: - Format Error in Processing Unit Broadcast!

The Processing Units broadcast their presence on the
Network. Such a broadcast message was received, but
did not meet the format specification.

Display Error

L76: - No reply to the Initial Power-Up BIST.
Do you want to Retry?
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The network connection is OK, but the Processing Unit
is not responding. Cancel the current attempt. Power the
Processing Unit "Off” and then 'On’ again. Then try
restarting the operating software.

Display Error
L83: - Could not create Config-file!

An attempt was made to store the current layout
configuration onto the system defaults directory, but the
operation failed. You should have full read & write
access to this directory.

Display Error
L84: - Error in retrieving "All Workspaces’ infol

This is an internal error in the Launchpad, and should
never happen. If it does occur, it will be during saving of
the layout configuration to file. You should then restart
the Operator Station software, and try the same
command once again. This error may indicate internal
problems for the Launchpad program, and should be
reported.

Display Error

L85: - Program <name> contains an error in the configuration-file
start-string!

This is a serious error. An attempt was made to update
the main configuration file from data in memory. The
attempt failed because the internal information did not
adhere to the syntax for this type of information. You
should exit and restart the system to avoid loss of
operational control.

Display Error
L89: - Could not create Log-file Backup!

An attempt was made to open the log-file in the system
defaults directory, but the operation failed. You should
have full read & write access to this directory.

Display Error

L99: - Not able to change to Raw Data Directory <name> when
generating Survey Parameters file.

An attempt was made to change the internal working
directory to the one wused for raw data
(SRAWDATAHOME), but the operation failed. Please
verify that you have full read, write & execute access to
this directory.

Display Warning

L111: - Tape Operation Aborted!
Reason:
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The reason for an aborted tape operation may vary. With
the exception of a user- triggered abort, the reason stated
in the message body originates from the operating
system, but should be fairly easy to understand.
Examples of this could be a message stating that the tape
drive is offline or that no data cartridge is loaded.

Display Warning

L112: - You cannot delete the current survey!
The current survey could be active, meaning that the
associated directories and files are in use for data storage
and processing. Removal of the current survey is
therefore prohibited.

Display Warning

L113: - The Log-file is quite large: size X Mb - reset recommended!

The messages in the log-file may be viewed using the
"File- >Print / View’ command. If the file contains too
many messages, it may be prove too 'crowded’ for
practical purposes. Itis recommended that you pay heed
to the suggestions of reset offered by the system. Use the
"File- >Reset Log- file’ option. If you are afraid of loosing
useful information, please note that any errors reported
while logging data, is logged in a separate log- file along
with the survey data. Also remember, that you are
offered the option of backing up your log-file before
resetting.

Display Warning

L114: - You cannot alter logging set-up while logging is Active!
Due to the programmed functionality of the system,
some parameters (logging set-up & installation
parameters) may not be modified, because that would
disrupt proper functionality and data integrity.

Display Warning

L117: - The root partition of this system now has less than 2Mb space
left...
If the disk space on the root partition falls to zero, you
may experience various types of problems while
operating the system. It is advisable to increase this
space to a minimum of 10 - 20 Mb.

Display Warning

L118: - Both Heads are currently deactivated!

Pinging is disabled...
When configuring a dual head system, at least one of the
heads must be set up with one of the available
frequencies. Of course, an actual dual head requires both
heads being assigned frequencies. A dual head system
can also be configured as a single head system, assigning
frequencies to only one of the heads.
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Display Warning

L119: - You cannot use the same frequency on both sonar heads!
Pinging is disabled...

Because of interference problems, running both sonar
heads with the same frequency is disabled.

Display Error

L120: - The main configuration file <flename> was not found. Since this
is a vital file for the system, the Launchpad will terminate when you select
the OK button...

This file contains the overall configuration of the
operator station software. The system can’t operate
without this file. The file was copied to the system
directory during installation, and may have been
accidentally removed.

Display Error

L121: - Error(s) found in the Launchpad Configuration File!

When you select the 'OK’ button, the file will be deleted and this program
will terminate.

When restarting the system, the Factory Default Configuration File will
be installed.

The Launchpad program uses a text-file to define which
programs are included in the system. Quite a few bits of
information are stored here, using a fixed syntax. This
error occurs because the line for this program does not
adhere to the syntax. An erroneous modification may
have been done using a text editor. A new default
version of the file will automatically be installed when
restarting the system.

Error

L122: - There are too many entries in setup-file! Max = 18.

The configuration file contains all programs included in
the integrated system, but may also contain programs
added by the user. These programs may be started from
the Launchpad, but are not supervised as the other
programs.

The total number of entries has exceeded the maximum
limit, probably due to manual modifications of this
configuration file.

To restore the default file supplied by the system,
remove the $HOME/ .eso_system/esoEmX_config file,
and restart the system.

Error

L123: - Not able to obtain the icon for <this utility>!
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Each of the programs integrated into the system has a
button in the rightmost part of the Launchpad, and each
of these buttons should have a symbol / icon for
identification purposes.

The symbol name specified in the external configuration
file was not found, indicating an error in the file, or a
mismatch between the configuration file and the file
containing the icon descriptions.

If this error occurs, a capital "X’ is drawn instead of the
proper icon.

Error
L124: - Not able to obtain default icon!

Each of the programs integrated into the system has a
button in the rightmost part of the Launchpad, and each
of these buttons should have a symbol / icon for
identification purposes.

The symbol name specified in the external configuration
file was not found, indicating an error in the file, or a
mismatch between the configuration file and the file
containing the icon descriptions.

If this error occurs, a capital "X’ is drawn instead of the
proper icon. This message indicates that the "X" icon was
not found.

Display Error

L137: - A survey name must be provided before this program can start!

Fill in or select a survey name to continue!

Display Error

L140: - lllegal character(s) in the Survey Name!

The characters ('>" or '<’) are illegal as part of all
file-names, survey-names and operator names. Space (’
") will be substituted with * ".

Display Error

L141: - lllegal character(s) in the Operator Name!

The characters (">’ or '<’) are illegal as part of all
file-names, survey-names and operator names. Space (’
") will be substituted with * ".

Error

L142: - Environment ’'MODULES_ICON_FILE’ not found, or empty! Fix
and restart!

The file containing the icon descriptions used by the
system cannot be located, because the environment
variable, giving the name of this file, was undefined. All
environment variables used by the system are defined
when installing the system, so this message indicates a
system installation error.
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Error

L143: - Unable to open module icon description file <name> specified
in environment 'MODULES_ICON_FILE. Fix and restart!

The file containing the icon descriptions could not be
opened. The file may be missing, or you do not have the
proper file access.

Display Error

L144: - Program <name> (possibly specified by the environment symbol
<symbol name> in the start-up script) was not found in the Network
Configuration File.

File: DPC.addresses.<hostname>

The system cannot work until the problem is fixed, and will terminate
when you select the ‘OK’ button.

The specified file contains network addresses and port
no.’s for all programs attached to the system. The error
occurs when the program listed in the error message
does not have an appropriate entry in the file.

Display Error

L145: - Error opening Network Configuration File!
File: DPC.addresses.<hosthame>

The system cannot work until the problem is fixed, and will terminate
when you select the ’OK’ button.

The specified file contains network addresses and port
no.’s for all programs attached to the system. The error
occurs when your program tries to access this file, but is
denied access. Several possible reasons:
1. The file does not exist. Removed? Wrong Name?
2. You have no file system access.

Display Error

L146: - Error in connecting to socket given by <entry name> in the file:
DPC.addresses.<hostname>.

The system cannot work until the problem is fixed, and will terminate
when you select the ‘OK’ button.

All programs in this system have an entry in the
specified file. The most likely reason for this problem is
that this entry is in use by a process (program) running
on the system now. If you cannot find and terminate
such a process, then try logging out and logging on
before restarting the system.

Display Error

L147: - The following environment variables are undefined:
<variable list>
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Part of the system uses external definition of various
elements used within the programs. One such type of
external definition is Environment Variables. One or
more of these are undefined, leaving the system without
all information needed to function properly. The
environment variables should be defined as part of the
installation process, and these error points to either an
error in the installation, or manual interference in the
files defining these variables.

Display Error
L149: - Active Pos. Sys.: No Input...

The system does not receive any input from the
positioning system defined as Active. This could be due
to the wrong system being selected as Active. You
should also check input port parameters in the set-up
program, and finally, check that the cabling is OK and
that the positioning system unit generates the correct
datagrams.

Display Error

L150: - Heading Sensor: No Input...

The system does not receive any input from the system
generating the Heading. This could be due to the wrong
system being selected for Active Heading. You should
also check input port parameters in the set-up program,
and finally, check that the cabling is OK and that the unit
from which heading is used, generates the correct
datagrams.

Display Error

L151: - Attitude Sensor: No Input...

The system does not receive any input from the attitude
sensor. You should check input port parameters in the
set-up program, and that the cabling is OK. Also check
that the attitude sensor generates the correct datagrams.

Error
L152: - Clock: No Input...

The system does not receive any clock input from the
positioning system. You should check input port
parameters in the set-up program, and that the cabling
is OK. Also check that the positioning system generates
the correct datagram.

Error

L154: - Logging of Survey Data to Disk was switched Off due to an error
in the <name> program!

Refer to messages in the Status Display for further
details.
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Error

L155: - Logging of Raw Data to Disk was switched Off due to an error
in the <name> program!

Refer to messages in the Status Display for further
details.

Display Error

L163: - Quit Signal Received! System will shut down when you select
the 'OK’ button!

The system uses built-in mechanisms to handle signals
(interrupts) originating both internally and externally.
The type of signalis described in the message. All, except
the external Terminate Signal, is caused by errors in the
program.

Display Error

L164: - Floating Point Exeption! System will shut down when you select
the 'OK’ button!

The system uses built-in mechanisms to handle signals
(interrupts) originating both internally and externally.
The type of signalis described in the message. All, except
the external Terminate Signal, is caused by errors in the
program.

Display Error

L165: - Bus Error! System will shut down when you select the 'OK’
button!

The system uses built-in mechanisms to handle signals
(interrupts) originating both internally and externally.
The type of signalis described in the message. All, except
the external Terminate Signal, is caused by errors in the
program.

Display Error

L166: - Segmentation Violation! System will shut down when you select
the 'OK’ button!

The system uses built-in mechanisms to handle signals
(interrupts) originating both internally and externally.
The type of signalis described in the message. All, except
the external Terminate Signal, is caused by errors in the
program.

Display Error

L167: - Terminate Signal Received! System will shut down when you
select the 'OK’ button!

The system uses built-in mechanisms to handle signals
(interrupts) originating both internally and externally.
The type of signal is described in the message. All except
the external Terminate Signal, is caused by errors in the
program.
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Display Error

L168: - lllegal Instruction Signal Received! System will shut down when
you select the ’OK’ button!

The system uses built-in mechanisms to handle signals
(interrupts) originating both internally and externally.
The type of signalis described in the message. All, except
the external Terminate Signal is caused by errors in the
program.

Display Error

L169: - SIGNAL <signal no.> received! System will shut down when you
select the 'OK’ button!

The system uses built-in mechanisms to handle signals
(interrupts) originating both internally and externally.
The type of signalis described in the message. All, except
the external Terminate Signal, is caused by errors in the
program.

Error

L170: - Unable to create Process List!

An attempt was made to open the process id log-file in
the system directory for writing, but the operation failed.
You should have full read & write access to the specified
file and directory.

Error

L171: - Unable to open Process List!

An attempt was made to open the process id log-file in
the system directory for reading, but the operation
failed. You should have full read & write access to the
specified file and directory.

Display Error

L172: - The following Programs are still running, and must be terminated
before continuing:

The operating software uses several programs in an
integrated system. Each running program is represented
internally as a process. It has been observed, mostly after
a crash, that these processes may continue to be active
when they should not have been. The system detects
these processes when it is restarted, and will, on users
confirmation, issue termination commands before the
system continues initialisation. But on rare occasions,
the termination signal sent to these processes fails, and
manual intervention is required as instructed in the error
message.
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Display Error

L173: - The following Programs could not be terminated:

The operating software uses several programs in an
integrated system. Each running program is represented
internally as a process. It has been observed, mostly after
a crash, that these processes continue to be active when
they should not have been. The system detects these
processes when it is restarted, and will, on user
confirmation, issue termination commands before the
system continues initialisation. But on rare occasions,
the termination signal sent to these processes fails, and
manual intervention is required as instructed in the error
message.

Display Error

L176: - The following Program(s) should always run, but is still NOT

running:

All programs started and supervised by the Launchpad
establishes a communication link with the system when
they are launched. The listed program(s) did not succeed
in establishing this link. It could be that the program (s)
crashed before the linkup was attempted. In that case,
the program(s) has no possibility to communicate with
the rest of the system. You may try to start the system
manually in a window, to see if you can find any useful
messages written in the window. These programs are so
called system programs, and it will be impossible to run
the system when they are not running as intended.

Display Error

L177: - Could not read Raw Data directory for survey <name>.

You do not have the correct access to the specified
directory. Correct ownership of directories and files are
defined when the system is installed, so this problem
could be the result of a manual operation in the file
system. Please verify that you have read, write & execute
access to the storage directories for raw data
($SRAWDATAHOME).

Display Error

L178: - Not able to change to Survey Directory <name> when fetching
Line Statistics file!

The system could not perform an internal change of
directory to the specified directory due to error in
directory access. You should have read, write & execute
access to all directories and files in the data storage
locations. Please verify and correct.

Display Error

L179: - Not able to change to Home Directory when fetching Line
Statistics file!
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The system could not perform an internal change of
directory back to your login directory due to error in
directory access. You should have read, write & execute
access to all directories and files in the data storage
locations. Please verify and correct.

Display Error

L181: - Not able to copy the file <filename> to $HOME/<filename>.
Program terminates when you select the OK button!

This is the file setting up the configuration of the status
filed in the Launchpad. An attempt was made to copy
this file from the system defaults directory, but failed.
You should have read & write access to all files in the
system directory and to the directory itself. Please verify
and correct.

Display Error

L182: - Could not open Operators File!

Open a terminal window, and go to the
$HOME/ .eso_system directory. Verify that you have
both Read and Write access to the file
‘esoSetup.operators’.

Display Error

L183: - Not able to copy the Status Config file to <directory name>.
Using default values...

This is the file setting up the configuration of the status
fields in the Launchpad. An attempt was made to copy
the file from the system defaults directory, but failed.
You should have read & write access to all files in the
system directory and to the directory itself. Please verify
and correct.

Display Error

L184: - Status Config file not found.
Using default values...

This is the file setting up the configuration of the status
fields in the Launchpad. It was not located in any of the
predefined locations. This is an error by itself - but the
system uses a default set- up, and will be operable. If you
define a new status set- up, remember to save the set-up
for later use.

Display Error

L186: - Could not init log-file!

It was not possible to create the file due to error in
permissions. You should have read & write access to all
files in the system directory and to the directory itself.
Please verify and correct.
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Display Error

L187: - Could not open log-file for append!

It was not possible to open the file for append due to
error in file access. You should have read & write access
to all files in the system directory. Please verify and
correct.

Display Error

L189: - Line Statistics File could not be opened!

Survey: <survey name>
File: <line name>.linestat

The line statistics file for the specified line exists, but it
could not be opened due to error in file access. You
should have read, write & execute access to all files in the
data storage directories. Please verify and correct.

Display Error

L190: - Statistics File for Survey <survey name>, line <line name> is
empty!

The line statistics file for the specified line exists, but it
was empty. It is difficult to state the reason for this,
because all lines, no matter how small, should have
something in this type of file. The file should be
removed.

Display Error

L193: - Raw Data Parameters File for Survey <survey name> could not
be opened!

The line parameters file for the specified line exists, but
it could not be opened due to error in file access. You
should have read, write and execute access to all data
storage files and directories. Please verify and correct.

Display Error

L194: - Survey Parameters File for Survey <survey name>, line <line
name> is empty!

The line parameters file for the specified line exists, but
it was empty. It is difficult to state the reason for this,
because all lines, no matter how small, should have
something in this type of file. The file should be
removed.

Display Error

L198: - Not able to change to Survey Directory <directory name> when
fetching Line Statistics file!
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There can be several reasons for this error, the most
probable is that you don’t have the correct access to the
specified survey directory. Please verify that you have
read, write & execute access to all directories in the
$PROCHOME location. '$PROCHOME’ is an
environment variable defining the top location of your
storage area for processed data (not raw data).

Display Error

L209: - You do not have WRITE access to file <name>.

You do not have the correct access to the specified file.
Correct ownership of directories and files are defined
when the system is installed, so this problem could be
the result of a manual operation in the file system. Please
verify that you have read, write & execute access to the
shared system directory ($SHAREDHOME) and all files
and subdirectories.

Display Error

L212: - Operation cancelled!
Echo Sounder not ready!

The system was interrupted while performing a Power
Up test. One of the main criteria for initiating the system
is that the Power Up test is completed without error.
When this test is cancelled, the system is defined to be
inoperable. It will remain so until the test is completed
successfully.

Display Error
L222: - Line Statistics File not found.

Survey: <survey name>
File: <line name>.linestat

The specified Line Statistics File does not exist. When
terminating logging to a line, such a file is produced
automatically. This error indicates that the file system
has been manually modified.

Display Error

L228: - The file <filename> is not found on $HOME/<name> directory,
or on SNEPTUNEHOME/defaults directory.

Since this is a vital file for the system, the Launchpad will terminate when
you select the OK button...

The main configuration file is not located in any of the
predefined locations. The system cannot be operated
without this file. You should check if you have any
backups of the system directory - one is made during
every upgrade / reinstall of the system. If that fails,
reinstall the system.
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Display Error

L229: - The file <filename> is not found on $HOME/<name> directory,
or on SNEPTUNEHOME/defaults directory.
Using default set-up...

The main configuration file is not located in any of the
predefined locations. The system cannot be operated
without this file. You should check if you have any
backups of the system directory - one is made during
every upgrade / reinstall of the system. If that fails,
reinstall the system.

Display Warning
L230: - Operator <name> has no Config-file...

Use the "Update Operator’s ‘Config-file’ popup menu
option on the "All Programs’ icon in the 'Programs’
section of the Launchpad. This will generate a default file
for the current operator.

Display Error

L231: - The file <filename> is not found on $HOME/<name> directory,
or on SNEPTUNEHOME/defaults directory.

The specified file is not located in any of the predefined
locations. The system cannot be operated without this
file. You should check if you have any backups of the
system directory - there is made one during every
upgrade / reinstall of the system. If that fails, reinstall
the system.

Display Error
L232: - Not able to remove the file <file name>.

Check access and owner of the file. Program terminates when you select
the OK button.

You do not have the correct access to the specified file.
Correct ownership of directories and files are defined
when the system is installed, so this problem could be
the result of a manual operation in the file system. Please
verify that you have read, write & execute access to the
system directory and all files in this directory
($HOME/ .eso_system).

Display Error
L233: - Unable to open Table Of Contents!

You do not have the correct access to the selected file.
Correct ownership of directories and files are defined
when the system is installed, so this problem could be
the result of a manual operation in the file system. Please
verify that you have read, write & execute access to the
system directory and all files in this directory
($HOME/ .eso_system).
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Display Error

L234: - Unable to open temporary copy of the log-file!

It was not possible to open the file, due to an error in file
access. You should have read & write access to all files in
the system directory ($HOME/.eso_system). Please
verify and correct.

Display Error

L235: - Cannot allocate enough memory for viewing the log-file. You
should reset the file using the 'File->Reset Log-file’ option.

The log-file was too big for the available memory
resources. If it is important to view the log-file, you
could try terminating as many of the programs as
possible before retrying. If the problem persists, you
should reset the log- file. When resetting, it is possible to
take a backup copy of the log-file.

Display Error

L297: - Raw Data Parameters File for
Survey <survey name>

Line <line name>

could not be opened!

The parameter file for the specified survey exists, but it
could not be opened due to error in file access. You
should have read, write and execute access to all data
storage files and directories. Please verify and correct.
Due to the sequence of events producing this file, this
error is not likely to occur.

Display Error

L298: - Survey Parameters File for Survey <name> does not exist!

The survey parameter file is based on the parameters for
eachline, and presents information regarding changesin
line parameter set-up. For some reason, this file could
not be produced. It may be, that there are no lines in the
survey, or that the logged lines are corrupted.

Display Error

L299: - Raw Data Parameters File for
Survey <survey name>

Line <line name>

does not exist!

The file contains the parameter set- up being used when
logging the line. For some reason, this file could not be
produced. It may be that the logged line is corrupted.
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Display Error

L300: - Environment variable for Network Configuration File not defined!

Some of the information required to have the system
running properly, is set outside of the actual programs,
using environment variables. The specified variable is
not defined, and probably means an installation error, or
manual modification in the definition of variables.

Display Error

L301: - Could not open Network Configuration File!
File: <filename>

It was not possible to open the file due to error in file
access. You should have read & write access to all files in
the system directory. Please verify and correct.

Display Error

L302: - Unable to open Serial Datagram Set-up-file

It was not possible to open the file due to error in file
access. You should have read & write access to all files in
the system directory. Please verify and correct.

Display Error

L303: - Unable to open Datagram Set-up-file!
File: <filename>

This file contains the datagrams available for
subscription. It will not be possible to use the
subscription facility without this file. You should have
read & write access to all files in the system directory.
Please verify and correct.

Display Error

L304: - Format error on input from Datagram Set-up-file!
File: <filename>

Datagrams available for user-defined distribution are
defined using a fixed format. One or more of the entries
in this file does not fit this format. The safest way to fix
the problem is to remove the file, and restart the system.
The file will then be copied to the system directory, using
the default version supplied with the installation.

Display Error

L318: - lllegal format on IP address!

Format: ddd.ddd.ddd.ddd, where 'd’ is a digit.
Leading zeros may be omitted.

The networking addresses used by the system must
follow the specified syntax. Normally, if you have
subscribers running on the same computer as the
operating software, you should use the IP address of this
computer.
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Display Warning

L321: -This is the system’s broadcast |IP address, and cannot be
deleted. If you were thinking of defining a new broadcast address, this
one will be automatically adjusted whenever the system’s IP address is
modified.

When removing an IP address, all programs having the
selected address will be modified. Since the selected
address is of vital importance for the system, deletion or
modification is not allowed. The address is used to
establish and maintain the connection with the echo
sounder.

Display Warning

L325: - You cannot change the datagram set-up of the system’s
reserved programs!

Currently, only user-defined datagram subscriptions
may be modified. Allowing the user to modify the flow
of datagrams needed for proper operation of the system
could result in operational problems.

Display Warning

L326: - You cannot modify the IP address of the system’s reserved
programs!

Currently, only user-defined datagram subscription
set-up may be modified. Allowing the user to modify
the networking set-up, needed for proper operation of
the system, could result in operational problems.

Display Warning

L327: - The specified IP Port no. is outside bounds!
Legal interval: [2000, 6000]

The interval is limited to avoid interfering with the
internal port no. usage of the system. Using port no.’s
already in use will give operational problems, both for
the system programs and for user programs.

Display Warning

L328: - IP Port no. <port no.> is already in use by the <subscriber name>
subscriber!
Legal IP Port interval: [2000, 6000]

Opening and using the same port no. for reading is not
allowed. You may send datagrams to the same port no.
from several programs, but since you are defining
datagram distribution, you cannot use the same port as
another program.

Display Warning

L333: - Logging cannot be started when Edit Mode is enabled in the
Set-up menul
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The reason for this restriction is that when logging to a
line is started, all current values of the installation
parameters are logged with the data. And since only one
such representation is possible per line, editing of these
parameters is prohibited when already logging.

Display Error
L334: - PPS not received!

The system does not receive any input from the system
generating the 1PPS. This could be due to the wrong
system being selected for 1PPS. You should also check
input port parameters in the set-up program, and
finally, check that the cabling is OK and that the unit
from which heading is used, generates the correct
datagrams.

Display Warning

L335: - Initial Power-Up Test was interrupted!
Echo Sounder Not Ready!

The initial power-up test was interrupted by the user.
And since it is an absolute requirement that this test is
successfully completed, this test should be performed
(with no errors reported).

Display Warning
L336: - No Sound Speed Probe values received!

The system is supposed to receive Sound Speed Probe
values, bot does not receive any. Verify probe
connections, set-up and power.

Display Error
L337: - Depth/Height Sensor: No Input...

The system is supposed to receive sensor input, but does
not receive any. Verify sensor connections, set-up and
power.

Warning
L355: - Unknown NMEA Telegram received...

The datagram received were not uniquely recognised. It
seems to be a NMEA datagram, but one not supported
by the system. The datagram may also contain format
errors. Please refer to separate documentation on
datagram definitions.

Error
L356: - Format Error in Remote Control Telegram!

The datagram received was recognised as a Remote
Control datagram, but the content does not adhere to the
datagram  syntax. Please refer to separate
documentation on datagram definitions.
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Display Warning

L357: - Datagram subscriber ‘remoteLogging’ not defined!

Use 'Options->DatagramSubscriptions...to enter 'remotelLogging’ as a
subscriber. Remember to supply IP address and port.no. to receive
datagrams on!

The system has received a Remote Control datagram,
but vital information is missing from the datagram
distribution set-up. Without this, none of the remote
control functionality will be available. The rest of the
sounder will operate as normal.

Display Warning

L358: - No datagrams are selected for the 'remoteLogging’ subscriber!
Use ’Options->DatagramSubscriptions...” and select datagrams for
subscription for the 'remotelLogging’ subscriber.

When using the Remote Control functionality, you must
define a selection of datagrams that you want
distributed to the ’'remoteLogging’ subscriber.
Otherwise, nothing will flow to this subscriber, even
though itis properly defined with an IP address and port
number.

Display Error

L364: - The system is currently configured NOT to launch the Survey
Display automatically. Changing this mode requires changing the
configuration file...

Some installations have their own Survey Control
software. The message indicates that the current
configuration of the system has disabled this particular
feature. Please refer to the documentation for
information on how to enable this software.

Display Warning
L372: - Could not verify incoming profile!

The Profile Editor is already running, and profile
verification is currently suspended. Terminating the
current editor session will automatically bring up the
received profile for verification.

Display Error
L400: - Could not open print tmp-file.

You do not have the correct access to a work- file in your
own home directory. Correct ownership of directories
and files are defined when the system is installed, so this
problem could be the result of a manual operation in the
file system. Please verify that you have read, write &
execute access to your login directory and the files in this
directory.

Display Error
L401: - Error in Launchpad Message Server Initialize!
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Some system resources could not be allocated, because
some other program is holding these resources. Check if
any of the programs started from a previous session of
the system are still running. If so, terminate these
programs. If you do not know how to do this, it will in
most cases be sufficient to log out and then back in. This
will terminate any running programs and free up
resources. Then restart the operator station software...
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Sound Speed Profile Editor messages
The following messages are presented by the SSP Editor utility.

Warning

E10: - Profile contains fewer points than specified in Profile Header.
Using number of points read from file!

The profile may have been edited manually, creating a
mismatch between header no. of entries and actual no.
of entries. The profile was automatically corrected.

Warning

E11: - Profile contains more points than specified in Profile Header.
Using number of points read from file!

The profile may have been edited manually, creating a
mismatch between header no. of entries and actual no.
of entries. The profile was automatically corrected.

Warning
E13: - You have no WRITE access to profile directory <directory name>.

The profile directory is created with full Read and Write
access when installing the system. This problem may be
caused by manual modifications of the file system. Set
the correct directory access before retransmitting.

Warning

E33: - Thefile <filename> containing the selected Sound Profile was not
found.

Someone has deleted the selected Sound Velocity Profile
from the disk after the list was created! The list was
produced using only actual and existing profiles. If you
have noidea how this could have happened, get in touch
with the System Administrator.

Warning

E38: - You have no WRITE access to the selected Sound Velocity Profile

directory!
The File Selection Box enables traversal of the file system
directory structure, which means that you may select
any directory as a storage area for the SV Profile - even
those you do not have WRITE access to. If you are denied
access to a directory that you would like to have access
to, check the System Manager to see if this is permissible.

Warning

E42: - You have no DELETE access to the selected Sound Velocity
Profile!

The profile directory is created with full Read and Write
access when installing the system. This problem may be
caused by manual modification of the file system. Set the
correct directory & file access before retrying.
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Error

E46: -

Environment 'SVP_EDITOR_MODULE_NO’ not defined or empty!
Environment 'SVP_EDITOR_MODULE_NAME’ not defined or empty!
These errors results in a program that does not work properly. Fix and
restart!

Most of the variable elements of the system
configuration can be configured outside the programs.
This is done by quite a few ’environment variables’,
which is set to an initial value when installing the
system, and then fetched by the programs when needed.
The environment variables listed in the error message
must be set to match the initial values.

Warning
E54: - Please use the 'Save As...’ command to give the profile a name.

Warning
E56: - No points in Profile...

The editable buffer is empty. Create a profile using the
New Profile command in the File menu. You may also
use the Copy SV Profile or the Combine SV Profiles in the
Edit menu.

Warning
E60: - lllegal Survey Format File Name: <filename>

The survey format profile name does not match the
syntax, which is as follows:

<line_no_yyyymmdd_hhmmss_sensor_version>.sfsvp

The only way to correct this is to do a manual profile
rename. Since the survey profiles are named
autmatically, this is an error that should not have
occurered.

Warning
E61: - Empty file: <filename>

The file does not contain any samples, and cannot be
used. It is not possible to state any reasons for this. The
file should be removed from the profiles directory.

Warning
E62: - Currently no editable profiles in work area to save!
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Ping Display messages

The following messages are presented by the Ping Display
utility.

P32: - No information received from the ESQO! Ignore this message if
used in stand-alone mode.

When starting up, the program tries to get some
information from the ESO system. But when running in
a standalone mode, it does not receive any answer. The
requested information is not important in the standalone
mode.

If you get this message when running as part of the complete
system, try restarting the operator software.
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7.2 CMOS SETUP - AUV Processing Unit

Setup for Cool Monster (C3/400)

To change the setup you must mount a standard VGA card and
connect a VGA monitor and a keyboard.

Main
System Time
System Date
Legacy Diskette A: [1.44/1.25 MB 31/2]
Legacy Diskette B: [Disabled]
Primary Master:
- Type: [Auto]
- 32Bitl/O [Disabled]
Primary Slave:
- Type: [Auto]
- 32Bit1/O [Disabled]
Secondary Master:
- Type: [Auto]
- 32 Bit1/0 [Disabled]
Secondary Slave:
- Type: [Auto]
- 32Bit1/O [Disabled]
Memory Shadow:
- CCO00 - CFFF [Disabled]
- D000 - D3FF [Disabled]
- D400 - D7FF [Disabled]
- D800 - DBFF [Disabled]
- DCO00 - DFFF [Disabled]
Memory Cache:
- Memory Chache: [Enabled]
- Chache System BIOS Area: [Write Protect]
- Chache Video BIOS Area: [Write Protect]
- Chache Extended Memory Area: [Write Back]
- Chache CC00 - CFFF:  [Disabled]
- Chache D000 - D3FF: [Disabled]
- Chache D400 - D7FF: [Disabled]
- Chache D800 - DBFF:  [Disabled]
- Chache DCOO - DFFF:  [Disabled]
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Note
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System Memory: 640 KB
Extended Memory: 62 MB

Advanced

Setup Warning: Setting items on this menu to incorrect values
may cause your system to malfunction.
Advanced Chipset Control:

- Graphics Aperture: [64 Mb]

- Enable memory gap: [Extended]

- EEC Config: [Disabled]

- SERR signal condition:  [Multiple bit]

- 8-bit I/0 Recovery: [4.5]
- 6 bit I/0 Recovery: [4.5]

PNP OS Installed: [No]
Reset Configuration Data:  [No]
Secured Setup Configurations: [Yes]

PCI Configuration:
* PCI Device, Slot #1
- Option ROM Scan: [Enabled]
- Enable Master: [Enabled]
- Latency Timer: [0040h]
* PCI Device, Slot #2
- Option ROM Scan: [Enabled]
- Enable Master: [Enabled]
- Latency Timer: [0040h]
* PCI Device, Slot #3
- Option ROM Scan: [Enabled]
- Enable Master: [Enabled]
- Latency Timer: [0040h]
* PCI Device, Slot #4
- Option ROM Scan: [Enabled]
- Enable Master: [Enabled]
- Latency Timer: [0040h]

PCI IRQ line 1: [Auto Select]
PCI IRQ line 2: [Auto Select]
PCI IRQ line 3: [Auto Select]
PCI IRQ line 4: [Auto Select]
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PCI/PNP ISA UMB Exclusion:
- CCO00 - CFFFF: [Available]
- D000 - D3FFF: [Available]
- D400 - D7FFF: [Available]
- D800 - DBFFF: [Available]
- CO00 - DFFFF: [Available]
PCI/PNP ISA IRQ Resource Exclusion
- IRQ 3: [Available]
- IRQ 4: [Available]
- IRQ5: [Available]
- IRQ 7: [Available]
- IRQ9: [Reserved]
- IRQ 10: [Reserved]
- IRQ 11: [Available]
- IRQ 12: [Reserved]

Default Primary Video Adapter: [AGP]
ISA graphics device installed: [No]
Assign IRQ to PCI VGA [No]

PS/2 Mouse: [Disabled]
Keyboard Features:
- NumLock: [Auto]
- Key Click: [Disabled]
- Keyboard auto-repeat rate: [30/sec]
- Keyboard auto-repeat delay: [1/2 sec]

1/0 Device Configuration:

* Local Bus IDE adapter: [Both]

* Floppy disk controller: [Enabled]
- Base I/O address:  [Primary]
- Floppy Drive Swap: [Disabled]

» Serial port A: [Enabled]
- Base I/O address:  [3F8]
- Interrupt: [IRQ 4]

» Serial port B: [Enabled]
- Mode: [Normal]
- Base I/O address:  [2F8]
- Interrupt: [IRQ 3]
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* Serial port C: [Enabled]

- Base I/O address:  [3E8]

- Interrupt: [IRQ 11]
 Serial port D: [Enabled]

- Base I/O address:  [2E8]

- Interrupt: [IRQ 11]

- Interface: [RS232]
* Parallel port: [Enabled]

- Mode: [EPC]
Base 1/0 address:  [378]
Interrupt: [IRQ 7]

- DMA channel: [DMA 3]

Legacy USB Support: [Disabled]
Watchdog Setting:

- Mode: [Disabled]
Large Disk Access Mode: [DOS]
Halt On Error:  [Yes]

Security

Supervisor Password Is:  Clear
User Password Is:  Clear

Set Supervisor Password: [Enter]
Set User Password: [Enter]

Password on boot: [Disabled]
Fixed disk boot sector: [Normal]
Diskette access: [Supervisor]

Virus check reminder: [Disabled]
System backup reminder: [Disabled]

Power
Power Savings: [Disabled]

Standby Timeout: [Off]
Auto Suspend Timeout:  [Off]

IDE Drive 0 Monitoring: [Disabled]
IDE Drive 1 Monitoring: [Disabled]
IDE Drive 2 Monitoring: [Disabled]
IDE Drive 3 Monitoring: [Disabled]
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PCI Bus Monitoring: [Disabled]

Boot

Floppy check:  [Disabled]
Summary screen:  [Disabled]
QuickBoot Mode: [Disabled]
Dark Boot: [Disabled]

Boot Device Priority
Hard Drive:

- SanDisk

- Primary Master

- Bootable Add-in Cards
Removable Devices

- Legacy Floppy Drives
ATAPI CD-ROM Drive
Network Boot
Onboard LAN RPL ROM  [Disabled]

Format the Boot drive for SM 2000

* Format the Boot drive for SM 2000 to be a system drive. The
flash disk is mounted as D:

- formatD: /s

* Copy the DOS boot files and VXWorks boot files for this SM
2000 system

The DOS files:
copy AUTOEXEC.BAT D:
- copy COMMAND.COM D:
- copy CONFIG.SYS D:
- The VXWorks files
- copy VXLOAD.COM D:
- copy VXWORKS.ST D:
* Make the directory for DOS commands.

- mkdir c:\dos
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* Copy the DOS files that are needed.

* Make the directory for BSP programs

copy COUNTRY.SYS
copy DISPLAY.SYS
copy EDIT.COM
copy EGA.CPI

copy FDISK.EXE
copy FORMAT.COM
copy HIMEM.SYS
copy KEYB.COM
copy KEYBOARD.SYS
copy MODE.COM
copy QBASIC.EXE
copy SETVER.EXE
copy XCOPY.EXE

mkdir c:\BSP_2000

* Copy the files for the BSP cards.

852-164371/E

copy BBOT.OUT
copy C44A.0UT

copy C44D.OUT

copy C44X.OUT

copy C50.0UT

copy HC.OUT

copy HCT_MON.OUT
copy CALIB.TXT
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7.3 CMOS SETUP - standard Processing Unit

Setup for VIPer

Standard CMOS Setup

Date
Time
HARD DISKS type Mode
Primary Master Auto Auto
Primary Slave Auto Auto
Secondary Master Auto Auto
Secondary Master Auto Auto

Drive A: 1.44M, 3.51n.
Drive B: None

Video: EGA/VGA
Halt On:  All, But Disk/Key

B10OS Feature Setup

Note While setting up the DiskOnModule or DiskOnFlash module,
the CPU has to boot on the floppy drive!

Boot Sequence: A,C,SCsI
Note Remember to put back before booting from DiskOnModule!
Boot Sequence: C,A,SCSI

Virus Warning: Disabled
CPU Internal Cache: Enabled
External Cache: Enabled
CPU L2 Cache ECC Checking:  Enabled
Processor Number Feature: Enabled
Quick Power On Self Test: Enabled
Boot Sequence: C,A,SCSI
Swap Floppy Drive: Disabled
Boot Up Floppy Seek: Disabled
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Boot Up NumLock:

Gate A20 Option:
Typematic Rate Setting:
Typematic Rate (Char/Sec):
Typematic Delay (Msec):
Security Option:

PCI/VGA Palette Snoop:

OS Select For DRAM > 64MB:

Report No FDD Fpr WIN 95:

Video BIOS Shadow:

C8000-CBFFF Shadow:
CC000-CFFFF Shadow:
D0000-D3FFF Shadow:
D4000-D7FFF Shadow:
D8000-DBFFF Shadow:
DCO000-DFFFF Shadow:

Chipset Features Setup
SDRAM RAS-to-CAS Delay:

SDRAM RAS Precharge Time:

SDRAM CAS latency Time:
SDRAM Precharge Control:
DRAM Data Integrity Mode:
System BIOS Chacheable:
Video BIOS Chacheable:
Video RAM Chacheable:

8 Bit I/0O Recovery Time:
16 Bit 1/0 Recovery Time:
Memory Hole at 15M-16M:
Passive Release:

Delayed Transaction:

AGP Aperture Size (MB):

On

Fast
Disabled
6

250
Setup
Disabled
Non-OS2
Yes

Disabled
Disabled
Disabled
Disabled
Disabled
Disabled
Disabled

3

3

3
Disabled
Non-ECC
Disabled
Disabled
Disabled
3

2
Enabled
Enabled
Disabled
64
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CPU Warning Temperature: 66°C/151°F

Current System Temp:
Current CPU Temperature
CPU FAN Speed

VCCP: VTT:
VCCa: +5V:
+12 V: -12 V.
-5V:

Shutdown Temperature: 70°C/158°F

Power Management Setup

ACPI function: Disabled
Power Management: User Define
PM Control by APM: No

Video Off Method: V/H SYNC+Blank
Video Off After: NA
MODEM Use IRQ: NA

Doze Mode: Disable
Standby Mode: Disable
Suspend Mode: Disable
HDD Power Down: Disable
Throttle Duty Cycle: 62.5%
PCI/VGA Act-Monitor: Disabled
Soft-Off by PWR-BTTN: Instant-Off
PowerOn by Ring: Enabled
Resume by Alarm: Disabled

IRQ 8 Break Suspend: Disabled

** Reload Global Timer Events **
IRQ[3-7,9-15],NMI: Disabled
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Primary IDE 0: Disabled
Primary IDE 1: Disabled
Secondary IDE O: Disabled
Secondary IDE 1. Disabled
Floppy Disk: Disabled
Serial Port: Enabled
Parallel Port: Disabled
PNP/PCI Configuration

PNP OS Installed: No
Resource Controlled By: Manual
Reset Configuration: Disabled
IRQ-3 assigned to:  Legacy ISA
IRQ-4 assignedto: Legacy ISA
IRQ-5 assignedto: PCI/ISA PnP
IRQ-7 assigned to:  Legacy ISA
IRQ-9 assignedto: Legacy ISA
IRQ-10 assigned to:  Legacy ISA
IRQ-11 assigned to:  Legacy ISA
IRQ-12 assigned to:  Legacy ISA
IRQ-14 assigned to:  PCI/ISA PnP
IRQ-15 assigned to:  PCI/ISA PnP
DMA-0 assigned to:  PCI/ISA PnP
DMA-1 assigned to:  PCI/ISA PnP
DMA-3 assigned to:  PCI/ISA PnP
DMA-5 assigned to:  PCI/ISA PnP
DMA-6 assigned to:  PCI/ISA PnP
DMA-7 assigned to:  PCI/ISA PnP

Used MEM base addr: N/A

Load B10OS Defaults

NO
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Load Setup Defaults
NO

Integrated peripherals
IDE HDD Block Mode:

IDE Primary Master PIO:
IDE Primary Slave PIO:

IDE Secondary Master PIO:
IDE Secondary Slave PIO:
IDE Primary Master UDMA:
IDE Primary Slave UDMA:

IDE Secondary Master UDMA:

IDE Secondary Slave UDMA:
On-Chip Primary PCI IDE:
On-Chip Secondary PCI IDE:
USB Keyboard Support:

Init Display first:

KBC input clock:
Onboard FDC Controller:
Onboard Serial Port 1:
Onboard Serial Port 2:
UART Mode Select:

Onboard Parallel Port:
Parallel Port Mode:

Supervisor password
PASSWORD DISABLED

User password
PASSWORD DISABLED

Enabled
Auto
Auto
Auto
Auto
Auto
Auto
Auto
Auto
Enabled
Enabled
Disabled
PCI Slot

8 MHz
Enabled
3F8/IRQ4
2F8/IRQ3
Normal

378/IRQ7
SPP
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IDE HDD Auto detection

Do not choose Disk On Module here, it should be set to auto:

Primary Master:
Primary Slave:
Secondary Master:
Secondary Slave:

Save and Exit Setup

YES

No
No
No
No
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Processing Unit messages

The following messages are reported by the software monitoring
the hardware circuitry in the Processing Unit.

After receiving error messages from the Processing Unit, you
should always run the appropriate BIST tests to verify the
hardware status.

Each bit in the trailing number indicates a specific error

condition.

P480: Error status from the Processing Unit = 0x10000
The number is to be decoded as follows:
Sonar Head cross connection.

P480: Error status from the Processing Unit = 0x20000
The number is to be decoded as follows:
No attitude with this data.

Note Please note that the four following messages are for the BSP 1.

P481: Error status from the BSP = 0x0100
The number is to be decoded as follows:
Link communication problem, HCT <-> BSP

P481: Error status from the BSP = 0x0200
The number is to be decoded as follows:
Communication problem, PU <-> BSP

P481: Error status from the BSP = 0x0400
The number is to be decoded as follows:
Communication problem, PU <-> HCT

P481: Error status from the BSP = 0x0800
The number is to be decoded as follows:
Internal problem BSP

Note Please note that, in a dual head configuration, the four

following messages are for the BSP 2.
P481: Error status from the BSP = 0x01000

The number is to be decoded as follows:

Link communication problem, HCT <-> BSP
P481: Error status from the BSP = 0x02000

The number is to be decoded as follows:

Communication problem, PU <-> BSP
P481: Error status from the BSP = 0x04000

The number is to be decoded as follows:
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Note

Note
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Communication problem, PU <-> HCT
P481: Error status from the BSP = 0x08000
The number is to be decoded as follows:

Internal problem BSP
Please note that the four following messages are for the HCT 1.
P482: Error status from the HCT = 0x0001

The number is to be decoded as follows:

Temperature is over limit, power down.
P482: Error status from the HCT = 0x0004

The number is to be decoded as follows:

Voltage error.

Please note that, in a dual head configuration, the four
following messages are for the HCT 2.

P482: Error status from the HCT = 0x0010
The number is to be decoded as follows:
Temperature is over limit, power down.
P482: Error status from the HCT = 0x0040
The number is to be decoded as follows:

Voltage error.
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7.4 CPU CMOS SETUP
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Setup for SSC-486H

To change the setup you must mount a standard VGA card and
connect a VGA monitor and a keyboard.

This setup is based on BIOS:KU26C-03B. Hit "DEL” key after
power on and confirm/change to following settings in CMOS:

Advanced setup

Typematic rate (char/sec): 30
System keyboard: Absent
Primary display: Absent

Mouse support: Disable

Above 1IMB memory test: Enable
Memory test tick sound: Enable
Parity error check: Enable

Hit "DEL” message display: Enable
Extended Bios RAM area: 0:300
Wait for ”F1” if any error: Enable
System boot up num-lock: On
Numeric processor test: Enable
Wietek processor: Absent

Floppy drive seek at boot: Disable
System boot up sequence: A:,C:
System boot up CPU speed: High
External cache: Enable

Internal cache: Enable

Internal cache WB or WT: WR-thru
Turbo switch function: Enable
Password checking: Setup

Video shadow, C000, 16k: Enable
Video shadow, C400, 16k: Enable
Shadow, C800, 16k: Disable
Shadow, CCO00, 16k: Disable
Shadow, D000, 16k: Disable
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Shadow, D400, 16k: Disable

Shadow, D800, 16k: Disable

Shadow, DCO00, 16k: Disable
Shadow, E000, 64k: Disable

IDE multi-sector transfer: Auto
Primary IDE 32-bit transfer: Disable
Primary IDE block mode: Master
Primary IDE LBA mode: Mas/Sla
Secondary IDE present: None
Secondary IDE 32 bit transfer: Disable
Secondary IDE Block mode: Disable
Secondary IDE LBA mode: Mas/sla

Peripheral setup
Onboard FDC: Enable
Onboard IDE: Enb-pri

Serial port 1: 3F8h

Serial port 2: 2F8h

Parallel port: 378h

Parallel port mode: Normal
Parallel extended mode: ECP

Chipset setup

Auto config function: Enable
Cache read: 3-2-2-2

Cache write: 1 ws

DRAM wait: 1 ws

DRAM page: Fast

Keyboard clock: 9.5 MHz

AT clock select: PCLK/4

Local ready: Delay 1T

CPU ADSH# delay: No delay

Alt bit in tag SRAM: 7+1 bit
Signal LDEV# sample time: in T3
HW DRAM parity check: Disable
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ISA bus refresh disable bit: Fast
DRAM refresh method: Ras only
Devider for refresh: Reserved (1/1)
Video ROM cache C000, 16k: Disable
Video ROM cache C400, 16k: Disable
Adapter ROM cache: Disable

System memory remap or not: Enable
LOWA20# select: Chipset

RC reset select: Chipset

10 recovery time select: 5 BCLK
Hold CPU percentage: Disable
Software flush 80486: Disable

Enable force read miss: Disable

Setup for SSC-5x86H

This setup is based on Award Bios v4.51G. ICP version
KU35-LSV3.2. Hit "DEL” key after poweron and
confirm/change to following settings in CMOS:
Standard setup

Primary Master: None

Primary Slave: None

Drive A: None

Drive B: None

Video: EGA/VGA

Halt on: All, but keyboard

BIOS features setup

Virus Warning: Disabled

CPU internal cache: Enabled
External cache: Enabled

Quick power on self test: Disabled
Boot sequence: A,C

Swap floppy drive: Disabled

Boot up floppy seek: Disabled
Boot up Numlock status: On
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Boot up system speed: High

Gate A20 option: Fast

Memory parity check: Disabled
Typematic rate setting: Disabled
Typematic rate (chars/sec): 6
Typematic delay (msec): 250
Security option: Setup

PS/2 mouse functional ctrl: Disabled
PCI/VGA Palette snoop: Disabled
OS selector for DRAM>64Mb: Non OS2
Video bios shadow: Enabled
C8000-CFFFF Shadow: Disabled
D0000-D7FFF Shadow: Disabled
D8000-DFFF Shadow: Disabled

Chipset features

Auto configuration: Enabled
AT-BUS CLK: CLK/4
DRAM read timing: Normal
DRAM write timing: Normal
SRAM read timing: 3-1-1-1
SRAM write timing: 0 Wait
Hidden refresh: Disabled
Memory hole (15M-16M): Disabled
ISA 1/0 recovery: Enabled
Fast back to back: Enabled

Power managment setup
Power Management: Disable

PM control by APM: Yes

Video Off Option: Susp/stby -> OFF
Video Off Method: V/H Sync+Blank
MODEM use IRQ: 3

PM TIMERS

HDD power down: Disabled

157



EM 3000 / Base version

Doze mode: Disabled
Standby mode: Disabled
Suspend mode: Disabled
PM EVENTS

VGA: Off

FDD  (3FxH): On
LPT & COM: LPT/COM
HDD  (1FXH): On
NMI: OFF

IRQ3 (COM2): On
IRQ4 (COM1): On
IRQ5 (LPT2): On
IRQ6 Floppy disk: On
IRQ7 LPT1:On

IRQ8 RTC Alarm: Off
IRQ9 IRQ2 redir: On
IRQ10 Reserved: Off
IRQ11 Reserved: Off
IRQ12 PS/2 Mouse: On
IRQ13 Coprocessor: Off
IRQ14 Hard disk: On
IRQ15 Reserved: Off

Integrated peripherals
On-chip Local Bus IDE: Disabled
Onboard FDC control: Enabled
Onboard UARTL: 3F8/IRQ4
Onboard UART2: 2F8/IRQ3
Onboard paralell port: 378
Parallel port mode: Normal
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7.5 BIST tests
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Software data/version
Presents the software versions of the processors in the system.

Sonar Head Temp

This test checks the temperature inside the Sonar Head. The
normal temperature inside the head is 20° C higher than the water
temperature. If the temperature exceeds 70° C, an alarm message
IS issued.

If the Sonar Head contains a humidity sensor, the reading from this
will also be displayed. Normal humidity should be approximately
40%.

BIF /7 BSP

This test checks the communication between the Beamformer
Interface (BIF) and the Beamformer and Signal Processing (BSP)
circuit boards in the Processing Unit. It tests the ISA-bus interface,
but, the TAXI communication link is not tested. The Processing
Unit uses the BIF ISA-bus interface to load known data into the
Beamformer & Signal Processor (BSP) board. The BSP
processors read and verify these data.

* The equivalent isotropic noise level for each receiver channel
(ref 1 V per uPascal)

BSP test

This test check the Beamformer and Signal Processing circuit
boards in the EM 3000 Transceiver Unit.

Sonar Head HCT pcb

Thisisaself test of the Head Control Transmit (HCT) circuit board
in the Sonar Head.

Sonar Head Serial No

This test reads the serial number(s) from the Sonar Head(s)
connected to the EM 3000 Processing Unit. The numbers for the
Sonar Head, the Head Receiver (HRX) and the Head Control
Transmit (HCT) circuit boards are returned to the message field.

Rx Channels
This test tests all the receiver channels.

This test checks the amplitude and phase on all the receiver
channels. A test signal is injected into all the receivers. Data for all
channels are sent on the TAXI link to the Beamformer & Signal
Processor (BSP) board. The test signal is then turned off, and the
BSP uses the data samples to verify the amplitude and phase
response on all the RX channels.
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Sonar Head Power

The analogue +5 Vdc, the digital +5 Vdc and the +15 Vdc TX
voltage levels in the Sonar Head are measured. Acceptable
deviations for the 5 VVdc supplies are + 0.25 Vdc, and = 1 Vdc for
the 15 Vdc supply. The status and the measured values are
returned.

Noise test
This test measures the noise level on all the receiver channels.

Time Varied Gain (TVG) and fixed gain is set to a maximum level,
and data for all channels are sent on the TAXI link to the
Beamformer & Signal Processor (BSP) circuit board. The data is
analysed by the BSP, and results are displayed.

Normally, the noise level is due to electronic self noise in the
preamplifier circuitry. A very high noise level in the water - either
from the vessel hull or machinery, or for other noise sources in the
vincinity - may result in an increase in the noise level.

* The average equivalent isotropic noise level for all channels.
(Typical value is 50-55 dB ref 1 V per uPascal).

TX Channels

One receiver channel is used to check the output from the
transmitters. The Head Control Transmit (HCT) board transmits
on each of the 56 transmitters, one by one. The signals are received
on RX element number 80. Standard transmit pulse length of 0.15
ms is used. The average of 2 samples is taken and checked against
a limit. If bad channels are discovered, the channel numbers are
displayed.

TVG voltage

HCT (Head Control Transmit) board sends 10 different
TVG-values (Time Variable Gain-values)and reads them back
through an A/D converter and checks that the difference is not
greater than 0.1 volt.

TAXI Link

This test checks the functionality of the TAXI communication link
between the Processing Unit and the Sonar Head(s). The Head
Control Transmit (HCT) board sends a fixed number of bytes with
fixed values on the TAXI line. The Beamformer & Processor
Board (BSP) verifies the data string. If an error is detected, a
detailed error report will be displayed.

Reboot BSP cards

Thisisnotatest, but areboot of the BSP software in the Processing
Unit. This should normally not be used.
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8 REPLACEMENT PROCEDURES

8.1 Introduction

Overview

This chapter presents the basic procedures for disassembly and
reassembly of the replaceable parts in the EM 3000 sonar
system.
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Tools required in general

A standard tool set is required to perform the removal and
replacement of the modules. This tool set should contain the
following tools:

* Cabinet key
» Standard screwdrivers in different widths and lengths

e Standard cross-slot screwdrivers in different widths and
lengths

* Allen keys in metric sizes

* Philips screwdrivers in different sizes

* Pozidrive screwdrivers in different sizes

* Flat nosed pliers

* Lap jointed pliers

*  Wire cutters

* Soldering iron

* Open ended and ring spanners in metric sizes
* Adjustable spanners

* Socket set

The following expendables are recommended:
* Solder

* Wire straps in different sizes

Tools required for changing boards in the
Sonar Head

This list is a supplement to the list of tools required in general.
* Four 5mm screws

* Four 6mm screws

* Four (flat)washer for 6mm screws

* Six 4mm edge key

* Lubricant “AQUA LUBE”

* Lubricant Super-O-ring
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8.2 Processing Unit procedures
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Overview

The Line Replaceable Units (LRUSs) in the EM 3000 Processing
Unit are:

* 4-Ports Serial Line board

* Control Processor board (CPU)

* Beamformer & Signal Processor (BSP1 and BSP2)
- Two boards if dual head

* Beamformer Interface (BIF1 and BIF2)
- Two boards if dual head

* Ethernet Adapter

* Fan

* Motherboard

Other devices:

* AC mains fuse and filters

* Fuses

The replacement procedures for these parts are described in the
following disassembly and reassembly procedures.

The modules that are accessible, are described in this chapter.

Circuit boards and modules

Introduction

The Processing Unit hold plug-in circuit boards and modules.
The replacement of these modules is described in this
procedure.

The system must be switched off prior to disassembly. Access is
gained by opening the top and/or side panel(s) of the Processing
Unit. How to open the Processing Unit is described under the
Disassembly procedure.

Disassembly procedure

1 Remove the mounted cables from the applicable circuit
boards.

2 Release the thumb-screws if required.
3 Pull the board/unit carefully out.

Reassembly procedure

1 Check links and switches on the new board and compare
to the old board.
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2 Insert new circuit boards and modules in reverse order.
Mount the removed cables and the front covers.

3 Check that the circuit boards and modules have been
installed in their correct locations! (Refer to the applicable
pictures and drawings).

Fans

Introduction

Two of the fans are mounted on the bottom plate in the
Processing Unit. One is mounted next to the Power Supply.
Remember to switch off the system.

The system must be switched off prior to disassembly. Access is
gained to the wired rack by opening the top panel of the
Processing Unit. How to open the Processing Unit is described
under Disassembly procedures of the Circuit boards and
modules.

Disassembly procedure

1 When you have reached access to the fan, unscrew it, and
remove the cable connected.

2 Replace the fan with a new one.

Reassembly procedure

1 Mount the screws, and put the cables back to their original
place.

Power Supply

Introduction

How to open the Processing Unit is described under the
Disassembly procedures of the Circuit boards and modules.

Disassembly procedure
1 Switch off the circuit breaker.

2 Unbolt the unit. It is mounted with four captive-bolts so
they cannot fall out. The nuts and spring washers are
accessible.

Reassembly procedure

The new power supply is replaced by reversing the above
procedure.
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8.3 Sonar Head procedures

Caution

Caution
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Overview

The Sonar Head should not be opened by unauthorized
personnel. We recommend that you contact your
nearest Kongsberg Simrad office. When you open the
Sonar Head, your insurance will no longer be regarded
as valid!

The Line Replaceable Units (LRUSs) in the EM 3000 Sonar
Head are:

- HCT board

- HRX board

The replacement procedures for these boards are described in
the following disassembly & reassembly procedures.

The modules that are accessible, are described in this chapter.

Introduction

The Sonar Head hold plug-in circuit boards. The replacement of
these boards are described in this procedure.

The system must be switched off prior to disassembly. Before
removing any modules, be sure that the voltmeter shows zero
(0) volts. Access is gained to the wired rack by opening the top
panel of the Sonar Head. How to open the Sonar Head is
described under Disassembly procedure.

Disassembly procedure

Unscrew the ten titan screws with a 4 mm 6 edge key (Allen
key).

When the cover is loose, be very careful! Do not
remove it from the transducer house before you have
removed the cables from the HCT board.

To change the HCT board (board on top):

1 Remove 11 screws, four nuts, one distance piece and 3 flat
ribbon cables. (check with the drawings).

2 Change the board with a new one.

Mount the screws, nuts and cables back to their original
place.

To change the HRX board (board at the bottom):

1 Remove the HCT board, the distance piece, the shield
plate and three flat ribbon cables on the HRX board.
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2
3

Change the board with a new one.
Mount everything back. (Check with drawings).

Reassembly procedure

1

Before mounting the cover to the transducer house, check
the o-rings.

O-ring used in the cover is 259,3 x 5,7 MIL413. Simrad
reg.number is 540-086946. O-ring used in the transducer house
is 269,3 x 5,7 MIL413B. Simrad reg.number is 540-085883.

2
3

Use super-O-lube to lubricate the O-rings.

When mounting the cover to the transducer, connect the
cables from the cover to the transducer. Check that the
cables lays OK, and not in clamp between cover and
transducer.

To press cover and transducer together, use the 6 mm
screws and washers.

Before putting the titan screws back, be sure that they are
OK. If not, change them. Use “AQUA LUBE”".

Remove the 6 mm screws and washers. Screw the rest of
the titan screws.

852-164371/E



Datagram formats

9 EM DATAGRAM FORMATS

9.1 Introduction

Note

Note

Note

The information herein is common for the EM 3002, EM 3000,
EM 2000, EM 1002, EM 300 and EM 120 multibeam echo
sounders. Some of the information may not be relevant for your
specific system. Please disregard this.

The information in this document is not valid for the EM 12, EM
100, EM 950 and EM 1000 multibeam echo sounders.

The formats for data input and output to and from the EM Series
multibeam echo sounders are described here. The information
given here is valid for the Kongsberg Maritime multibeam echo
sounders introduced after 1995.

In order to meet special customer requirements, Kongsberg
Maritime may have to change the datagram formats described
here. The formats presented in this document may therefore be
altered without prior notice, although backward compatibility
will be maintained as far as possible. Before software is written
in accordance with this document, it is strongly recommended to
contact Kongsberg Maritime to ensure that the latest version is
used, and that any planned changes are taken into account.

9.2 Presentation format
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The format description is according to the NMEA 0183 standard
for ASCII fields, with the ASCII character(s) given as follows:

* “x.X” defines a variable length numerical field, with
optionally included decimal point and sign.

* *“c--c” defines a variable length field of printable characters.
» “x--x” defines a variable length field of numeric characters.

* “a_ " defines a fixed length field of alphabetical characters
(for example “aa”= two character long field.

x_ " defines a fixed length field of numeric characters.

For binary fields, the length is given in number of bytes plus
“U” for unsigned and “S” for signed data.
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9.3 Input datagrams

Note

168

Introduction

Only a limited number of input formats from external sensors
are accepted. These are primarily in accordance with the NMEA
0183 specification, or based upon the principles of that
specification.

The majority of these formats have not been defined by
Kongsberg Maritime. Thus, these formats are not controlled by
Kongsberg Maritime.

Almost all input formats are ASCII. Serial line input on the
multibeam echo sounder’s Processing Unit is most common, but
some datagrams - which are not time critical - are interfaced on
serial line(s) or Ethernet to the Operator Station.

Position

Overview

The EM Series accepts position data in the following formats:
* NMEA 0183 GGA

* GGK

* SIMRAD 90

* With the GGA and GGK datagrams, information contained in
NMEA 0183 VGST and VTG datagrams will also be
accepted and used.

* A datagram format for Sonar Head depth is provided for the
EM 3002, EM 3000 and the EM 2000. Note that the format is
the same as that used by the Paroscientific Digiquartz
pressure sensor. This format may also be used for input of for
example varying datum heights or other special height
information on all models.

* A datagram format for input of tidal height is provided.

The GGA format is given below according to the NMEA 0183
version 2.30 description.

The GGK format was originally defined by the US Army
Corps of Engineers for their tests with kinematic GPS.
Trimble’s proprietary version of the format is supported. If any
changes to the format are made if it becomes part of the NMEA
standard, this will be implemented.

To preserve the inherent accuracy of the kinematic GPS data it
IS necessary to correct the data for vessel motion. This requires
accurate timing synchronisation between the motion sensor and
the GPS receiver. It is therefore imperative that:
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* the position datagram has a constant and known time delay
or

* the time stamp in the datagram is actually the time of the
position fix, that synchronisation to the 1 PPS signal of the
GPS receiver is enabled, and that the system clock has been
set correctly

As neither of these conditions may not be possible to achieve
with a sufficient accuracy, the application of motion correction
is operator selectable. Motion compensation may be applied to
any position input, not only kinematic GPS.

In addition to position data from the GGA or GGK datagrams,
speed and course over ground from NMEA VTG datagrams
may also be copied into the position output datagram. These
values may be useful in filtering of the positioning during
postprocessing. If a VTG datagram does not follow the GGA or
GGK datagram the course and speed fields of the output
datagrams will be set to their invalid values.

As an alternative to GGA, the SIMRAD 90 format position
datagram may be used. The SIMRAD 90 format is intended to
be the format of choice when the positioning system is not a
stand-alone GPS receiver supplying GGA or GGK format
datagrams. The SIMRAD 90 format can in addition to global
longitude latitude coordinates also be used for Northing Easting
type projection coordinates (e.g. UTM).

To cater for applications where the EM 2000 or EM 3000 Sonar
Head is mounted on a subsea vehicle, the original SIMRAD 90
format has been expanded to allow inclusion of the depth of the
vehicle in addition to its horizontal position in longitude latitude
or Northing Easting coordinates.
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GGA Datagram

Data Description Format Valid range Note
Start identifier = $ Always 24h - -
Talker identifier aa Capital letters -
Sentence formatter Always GGA, - -
UTC of position hhmmss.ss, 000000 to -
235959.9...

Latitude in degrees and minutes, plus .11, 0000 to 9000.0... -
optional decimal minutes

Latitude — N/S a, NorS -
Longitude in degrees and minutes, plus YYYYY.VY, 00000 to 18000.0... | —
optional decimal minutes

Longitude — E/W a, Eorw -
GPS quality indicator X, Oto 8 1
Number of satellites in use XX, 00to 12 -
HDOP X.X, Oto 1
Antenna altitude re mean sea level (geoid) X.X, - 2
Units of antenna altitude M, - -
Geoidal separation (sea level re WGS—84) X.X, - 2
Units of geoidal separation M, - -
Age of differential GPS data X.X, - -
Differential reference station id XXXX, 0000 to 1023 -
Checksum *hh - -

End of sentence delimiter = CRLF

Always ODh 0Ah

Note 1

The HDOP (Horizontal Dilution Of Precision) value will be

scaled and copied to the ”Measure of position fix quality” field
in the position output datagram. The scale factor depends upon
the GPS quality indicator’s value:

* 1-(SPS or standard GPS) => 1000

* 2 - (differential GPS) => 100

* 3 - (PPS or precise GPS) => 200, but 10 if GGA is treated as
RTK. (See Note 2)

* 4 - (kinematic GPS with fixed integers) => 10
* 5 - (kinematic GPS with floating integers) => 50
* 6 - (estimated or dead reckoning mode) => 1000

e 7 - (manual input mode) => 1000

* 8- (test mode) => 1000, but 10 if GGA is treated as RTK.

(See Note 2)

* The ”"Measure of position fix quality” field will be set to
65534 (largest valid number) if the indicator is zero
(non-valid position).
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This scaling is used to give at least a relatively correct position
fix quality change (in the order of cm) if there are dropouts in

differential, precise or kinematic measurements, although

HDORP is not a meter value.

Note 2

When the quality factor is 4 or 5 a height output datagram is
automatically generated, and also if the quality factor is 3 or 8

and the operator has set the GGA position to be an RTK

position. The height is the sum of these two fields which are
assumed positive upwards (antenna above geoid).

GGK Datagram

Data Description Format Valid range Note
Start identifier = $ Always 24h - -
Talker identifier aa Capital letters -
Sentence formatter Always GGK, - -
UTC time of position hhmmss.ss, 000000 to 235959.99... | —
UTC date of position MMDDYY, 010100 to 123199 -
Latitude in degrees and minutes, plus i, 0000 to 9000.0... -
optional decimal minutes

Latitude — N/S a, NorS -
Longitude in degrees and minutes, plus | yyyyy.yyyyyy, 00000 to 18000.0... -
optional decimal minutes

Longitude — E/W , EorW -
GPS quality indicator X, Oto 3 1
Number of satellites in use XX, 00to 12 -
DOP X.X, 0-

Antenna ellipsoidal height X.X, - -
Units of antenna ellipsoidal height M, - -
Checksum *hh - -
End of sentence delimiter = CRLF Always 0Dh OAh | — -
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Note 1

The DOP (Dilution Of Precision) value will be scaled and
copied to the "Measure of position fix quality” field in the
position output datagram. The scale factor depends upon the
GPS quality indicator’s value:

* 1 (SPS or standard GPS) => 1000
» 2 (differential GPS) => 100
* 3 (kinematic GPS) => 10

The ”Measure of position fix quality” field will be set to 65534
(largest valid number) if the indicator is zero (non-valid
position).
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This scaling is used to give at least a relatively correct position
fix quality change (in cm) if there are dropouts in differential,
precise or kinematic measurements, although DOP is not a
meter value.

VTG Datagram

Data Description Format Valid range Note
Start identifier = $ Always 24h - -
Talker identifier aa Capital letters -
Sentence formatter Always VTG, - -
Course over ground, degrees true XX, T, Oto 359.9... 1
Course over ground, degrees magnetic X.X,M, O0to 359.9.. 1
Speed over ground, knots X.X,N, 0- 1
Speed over ground, km/h X.X,K, 0 - 1
Mode indicator a AD,EM,S or N -
Checksum *hh - -
End of sentence delimiter = CRLF Always 0Dh OAh | — -
Note 1

Only true course and the first valid speed field will be used.

Transponder position Datagram
SSB - SSBL Position:

Data Description Format Valid range Note
Start_character $

Address PSIMSSB

Time ,hhmmss.ss 2
TP code ,BO1 3
Status A 4
Error code ,CC_ 1
Coordinate system (always radians) R

Orientation (always north oriented) N

SW filter , 1
X coordinate (Latitiude) XX

Y coordinate (Longitude) XX

Depth (Sonar depth in m) XX

Expected accuracy (Pos. quality in m) XX

Additional info , 1
First add value , 1
Second add value , 1
Checksum *hh

Termination CRLF
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Note 1

Not used by multibeam echo sounders.

Note 2

Is decoded and used if Clock Synchronisation is set from

position datagram.

Note 3
Only this transponder type is accepted by the multibeam.
Note 4
A = OK, V will give bad positions, but datagram will be

accepted for logging.

Simrad 90 Datagram

,CRLF

Data Description Format Length | Valid range Note

Start identifier = $ Always 24h 1 - -

Talker identifier aa 2 Capital letters -

Sentence formatter Always S90, 4 - -

Date of position DDMMYY, 7 010100 to 311299 -

UTC of position as hour, hhmmssss, 9 00000000 to -

minute, second, hundredth of 23595999

second

Latitude in degrees, minutes XXXX.XXXX 9 0000.0000 to A

and decimal minutes 9999.9999

Hemisphere identifier a, 2 NorS A

Longitude in degrees, minutes | XXXXX.XXXX 10 00000.0000 to A

and decimal minutes, or depth 18000.0000

in meters

Hemisphere or depth identifier |a, 2 E,WorD A

Northing or range in meters XXXXXXXXX. X, 12 000000000.0 to B
999999999.9

Easting or depth in meters XXXXXXX. X, 10 0000000.0 to B
9999999.9

UTM zone number XX, 3 01to 60 -

User defined central meridian XXXXX.XXXX 10 00000.0000 to C

longitude or bearing 35999.9999

Hemisphere or bearing a, 2 E, W, orB C

identifier

System descriptor X, 2 Oto7 1

Position fix quality indicator X, 2 Oto9andAto F 2

Speed over ground in m/s XX.X, 5 00.0to 99.9 3

Course over ground in degrees | xxx.x 5 000.0to 359.9 3

End of sentence delimiter = Always 2Ch 0Dh 0Ah 3 - -

852-164371/E
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Note 1

Value of system descriptor defines content of datagram as
follows. (Note that the Kongsberg Maritime EM 12, the EM 950
and the EM 1000 multibeam echo sounders will only accept
values less than 3):

- 0 - The position is longitude latitude in global coordinates
given in the fields noted A.

- 1 - The position is Northing Easting on the Northern
hemisphere given in the fields noted B. If the projection is
defined to be UTM the UTM zone number or a user
definable central meridian longitude may be given in the
field noted C.

- 2 - As for system descriptor equal to 1, but the position is
on the Southern Hemisphere.

- 3 - As for system descriptor equal to 0, but in addition the
depth is given in the Easting field noted B.

- 4 - As for system descriptor equal to 1, but in addition the
depth is given in the longitude field noted A.

- 5- As for system descriptor equal to 2, but in addition the
depth is given in the longitude field noted A.

Note 2
The position fix quality given in the position output datagram

will be derived from the quality indicator (this differs from the
original definition of the format) as follows (in m):

F (E |D |C |B (A |9 |8 (7 |6 |5 (4 (3 (2 (1 |0

0.01 {0.02 |0.05 |0.1 |02 |05 (1 |2 |5 |10 |20 (50 (100 |200 (500 |1000

Note 3

If these fields have valid values they will be copied to
equivalent fields in the position output datagram. They may be
used in filtering of the positioning during postprocessing. (The
original definition of the format had line heading in the course
field and its use was to orient real-time displays).

Tide input

Data Description Format Valid range Note
Start identifier = $ Always 24h - -
Talker identifier a Capital letter -
Sentence formatter Always TIDE, - -
Date and time of prediction / YYYYMMDDhhmm, | 199601010000 to | —
measurement 999912312359

Tide offset in meters and decimal meters | x.x +327.66 1
Optional checksum *hh - -
End of sentence delimiter = CRLF Always 0Dh OAh - -
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Note 1

A negative number will be assumed to indicate an increase in
sea level.

Depth pressure or height input

Data Description Format Valid range Note
Start identifier = * Always 2Ah - -
Sentence identifier ii 00 to 09 1
Talker identifier ii 00 to 99 -
Depth or height in meters and decimal meters X.X - 2
End of sentence delimiter = CRLF Always 0Dh OAh | — -
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Note 1

A sentence identifier equal to 00 is used for underwater vehicle
depth, all other identifiers are customer specific (usually a
datum height).

Note 2

If input is depth, it will be used in the depth output datagram to
offset the transmit transducer depth. If input is height, which
will usually imply a time or position variable datum height, its
use will depend on the sentence identifier and will be
implemented as required by a specific customer. Depth is
positive downwards. Depths may be scaled and offset by
operator settable constants:

output_depth [m] = scale_factor * (input_depth - offset)

Attitude data

Overview

Attitude data is generally accepted on one or more serial input
port(s) as:

* roll, pitch, heave and heading on one port,
or

* roll, pitch and heave on one port and heading separately on
another port.

The data update rate should be commensurate with the expected
dynamics of the vessel (typically up to 100 Hz).

The acceptable format for roll, pitch, heave and optionally also
heading is a 10 byte long message originally defined in the EM
1000 for use with digital motion sensors. It is supported by the
following sensors:
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* Applied Analytics POS/MV
* Photokinetics Octans

e Seatex MRU

» Seatex SeaPath

* TSS DMS-05

Heading will be accepted in the NMEA 0183 HDT format or in
the format used by the Simrad Robertson SKR80(82)
gyrocompass. A current loop to RS-232 converter may then be
required. The Lemkuhl LR40(60) Scan Repeater format is also
accepted, as it is the same as that of the SKR80 with the
exception of an extra status byte. Note that if the attitude sensor
is capable of reading the gyrocompass and transfer the heading
to the attitude sensor datagram (if it does not measure heading
itself), this is preferable to interfacing the gyrocompass directly
to the system.

Attitude data may be supplied from more than one sensor. All
data may be logged, but only one set as chosen by the operator
will be used in real time.

EM Attitude input format

The EM attitude format is a 10-bytes long message defined as
follows:

* Byte 1: Sync byte 1 = 00h, or Sensor status = 90h-AFh
* Byte 2: Sync byte 2 =90h

* Byte 3: Roll LSB

* Byte 4: Roll MSB

* Byte 5: Pitch LSB

* Byte 6: Pitch MSB

* Byte 7: Heave LSB

* Byte 8. Heave MSB

* Byte 9: Heading LSB

* Byte 10: Heading MSB

where LSB = least significant byte, MSB = most significant
byte.

All data are in 2’s complement binary, with 0.01° resolution for
roll, pitch and heading, and 1 cm resolution for heave.

* Roll is positive with port side up with £179.99° valid range
* Pitch is positive with bow up with +179.99° valid range
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* Heave is positive up with £9.99 m valid range
* Heading is positive clockwise with 0to 359.99° valid range.

Non-valid data are assumed when a value is outside the valid
range.

How roll is assumed to be measured is operator selectable,
either with respect to the horizontal plane (the Hippy 120 or
TSS convention) or to the plane tilted by the given pitch angle
(i.e. as a rotation angle around the pitch tilted forward pointing
x-axis). The latter convention (called Tate-Bryant in the
POS/MV documentation) is used inside the system in all data
displays and in logged data (a transformation is applied if the
roll is given with respect to the horizontal).

Note that heave is displayed and logged as positive downwards
(the sign is changed) including roll and pitch induced lever arm
translation to the system’s transmit transducer.

This format has previously been used with the EM 950 and the
EM 1000 with the first synchronisation byte always assumed to
be zero. The sensor manufacturers have been requested to
include sensor status in the format using the first
synchronisation byte for this purpose. It is thus assumed that:

* 90h in the first byte indicates a valid measurements with full
accuracy

 any value from 91h to 99h indicates valid data with reduced
accuracy (decreasing accuracy with increasing number)

 any value from 9Ah to 9Fh indicates non-valid data but
normal operation (for example configuration or calibration
mode)

* and any value from AOh to AFh indicates a sensor error
status

HDT format
Data Description Format Valid range Note
Start identifier = $ Always 24h - -
Talker identifier aa Capital letters | —
Sentence formatter Always HDT, - -
Heading, degrees true XX, T 0to 359.9.. -
Checksum *hh - -
End of sentence delimiter = CRLF | Always ODh OAh | — -

SKR80 format

The SKR80 sends out a stream of data with four bytes for each
measurement. There is one byte for each digit:
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* The first byte for the decimal degree (Example: xxx.X)
* The second for the degree (Example: xxX.x)

* The third for the 10’s degree (Example: XXX.x)

* The fourth for the 100’s degree (Example: Xxx.x)

The two uppermost bits of a byte are always zero, the next two
bits give the digit, 00 for the decimal, 01 for the degree, 10 for
the 10’s degree, and 11 for the 100’s degree. The lowest four
bits give the digit value in 4-bit BCD format. As an example a
heading of 234.5° will give the four bytes 05h 14h 23h 32h. The
LR40 adds a fifth byte at the end for status with the two upper
bits of the status byte set to 11 (11000000 for OK, 11001010 for
alarm). This status byte is ignored.

Clock

The system clock is used to time stamp all data output. The
clock may be set upon start of new survey or power-up on the
Processing Unit (recommended source is a NMEA ZDA format
datagram). The clock will drift, typically some seconds per day,
unless it is synchronised to a 1 PPS (pulse per second) input
signal (the clock millisecond counter will be set to zero
whenever a pulse is received). A fully correct clock is only
necessary if the output data are later to be combined with other
time critical data logged or created by other systems, for
example an accuracy of up to one minute would be necessary to
apply tidal changes. If the timestamp supplied in the position
input datagrams is to be used, it is imperative that the system
clock is correctly set and that 1 PPS synchronisation is used.

ZDA format
Data Description Format Valid range Note
Start identifier = $ Always 24h - -
Talker identifier aa Capital letters -
Sentence formatter Always ZDA, - -
uTC hhmmss.ss, 000000 to 235959.9... | —
Day XX, 01 to +31 —
Month XX, 01to +12 -
Year XXXX, 0000 to 9999 -
Local zone hours XX, —-13to +13 1
Local zone minutes XX 00 to +59 1
Optional checksum *hh - -
End of sentence delimiter = CRLF Always 0Dh OAh - -

Note 1
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Local zone time is not used. An offset time may be entered by
the operator to get the system clock to show a different time
than UTC.

Note 2
Trimble UTC format is also supported.

Sound Speed

Overview

A sound speed profile may be loaded into the Operator Station
either on a serial line or on Ethernet. Formats previously used
with existing Kongsberg Maritime echo sounders (Kongsberg
Maritime ASCII and Binary Sound Velocity Profile input
datagrams) will be accepted, but since their resolution in depth
is limited to 1 m and the number of entries to 100, a new format
given below without these limitations is recommended. This
format is also accepted by the Kongsberg Maritime HIPAP and
HPR underwater positioning systems (but not necessarily
vice-versa). Note that a complete profile may be pieced together
from several datagrams and edited with the Operator Station’s
Sound Speed Editor.

The new format is completely in ASCII and allows 9998 entries
without limitations in resolution. In addition to depth and sound
speed, it allows input of absorption coefficient, pressure,
temperature and salinity or conductivity. The latter parameters
may be used to calculate depth, sound speed and absorption
coefficient. Use of a depth dependent absorption coefficient
allows a more accurate determination of bottom backscatter
strength.

Note that this datagram may also be logged as output, retaining
information not included in the standard sound speed profile
output datagram, such as where and when the profile has been
taken.

Kongsberg Maritime SSP format

Data Description Format Length Valid range Note
Start identifier = $ Always 24h 1 - -
Talker identifier aa 2 Capital letters -
Datagram identifier Always Sxx, 4 S00to S53 1,2
Data set identifier XXXXX, 6 00000 to 65535 -
Number of measurements = N | xxxx, 5 0001 to 9999 -
UTC time of data acquisition hhmmss, 7 000000 to 235959 |3

Day of data acquisition XX, 3 00 to 31 3
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Data Description Format Length Valid range Note
Month of data acquisition XX, 3 00to 12 3
Year of data acquisition XXXX, 5 0000 to 9999 3
N entries of the next 5 fields — See note 4

— Depth in m from water level | x.x, 2 - 0 to 12000.00 -
or Pressure in MPa 0 to 1.0000

— Sound velocity in m/s X.X, 1 - 1400 to 1700.00 -
— Temperature in °C X.X, 1 - —-51045.00 -
— Salinity in parts per XX, 1 - 0to 45.00 -
thousand or Conductivity in 0 to 7.000

S/m

Absorption coefficient in dB/km | x.x 0- 0 to 200.00 -
Data set delimiter CRLF 2 0Dh OAh -
End of repeat cycle

Latitude in degrees and 1, Variable 5— | 0000 to 9000.0... 5
minutes, plus optional decimal

minutes

Latitude — N/S a, 2 NorS 5
Longitude in degrees and YYYYY.VY, Variable 6— | 00000 to 18000.0... |5
minutes, plus optional decimal

minutes

Longitude — E/W a, 2 EorW 5
Atmospheric pressure in MPa | x.x, 1 - 0 to 1.0000 5
User given comments c——-C Variable - 5
Optional checksum *hh - - 6
End of datagram delimiter = 5Ch 0Dh OAh 3 - -
\CRLF

Note 1

The datagram identifier identifies what type of data is included.

This is shown in the following table where D is depth, P is

pressure, S is salinity, C is conductivity, c is sound speed, o is
absorption coefficients, and L is latitude. The notation ¢(T,S)

indicates for example that the sound speed is to be calculated

from the temperature and salinity input data. When pressure is
used, the atmospheric pressure must be given if the pressure is
absolute, otherwise the pressure must be given re the sea level
and the atmospheric pressure must be zero.

Identifier Input data | Data to be used
S00 D, c D, c

S10 D,c D, c

S11 D, c,a D, c, a

S12 D,c, TS D, ¢, a(D,T,S,L)
S20 D, TS D, ¢(D,T,S,L)
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Identifier Input data | Data to be used

S21 DTS, a D, ¢(D,T,S,), a

S22 D, TS D, ¢(D,T,S,L), a(D,T,S,L)

S30 D,TC D, c(D,T,C,L)

S31 D,T,C,a D, ¢(D,T,C,L), a

S32 D,TC D, ¢(D,T,C,L), a(D,T,C,L)

S40 PTS D(RT,S,L), c(PT,S,L)

S41 PTS, a D(RTS,L), c(RT,S,L), a

S42 PTS D(FTS,L), c(PTS,L), a(RT,S,L)
S50 PTC D(PT,C,L), c(RT,C,L)

S51 PTC, a D(FT,C,L), c(PTC,L), a

S52 RTC D(RT.CL), c(RT.CL) , a(RT.C,L)
Note 2

SO0 is a special case because then the sound speed profile will
be taken into use immediately without further operator
intervention. The checksum is then mandatory and must be
correct. Furthermore entries for zero depth and a deeper depth
than expected during the survey must be included.

Note 3

Note that these fields have fixed length and leading zeros must
be used.

Note 4

The depth or pressure field is always required while the other
fields are optional except for those required by the datagram
identifier. The field-delimiting commas must always be included
even if the fields are empty.

Note 5

The positions, atmospheric pressure and comment fields are
optional. Note that the option field must not include a\. It is
recommended to include sensor type in the comment field.

Note 6

The checksum field is calculated between the $ and the *
delimiters by exclusive OR’ing of all bytes. The checksum is
required for datagram SO0, but is optional for the others.
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Note

Note
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AML Smart Sensor format

An AML Smart Sensor may be used directly for sound speed
profile input on a serial line to the Operator Station. The sensor
may also be used to measure the sound speed at the transducer
depth continuously during surveying.

The supported AML Smart Sensor message formats are:
SV = Sound Velocity

SV&P = Sound Velocity and Pressure

SV&T = Sound Velocity and Temperature

Each message from the sensor is transmitted as a sequence of
ASCII characters terminated by a CRLF pair.

The accepted message formats are as follows:
SV Format:

= )X Ix] Jom ]|

where xxxx.x is the measured sound speed in m/s.
SV&P Format:

= DX X e XXX [x] Jer]LF |

where the first field is the pressure in decibars relative to the
surface and the second is sound speed in m/s.

SV&T format:

[ XX XXX o XX XPX]- X JeR]F |

where the first field is the temperature in degrees Celsius and
the second is sound speed in m/s.

The message formats above are presented in table format to
make it easier to see the location and number of spaces in each
message.

Note The ’+’ character should be interpreted as follows. If the
number in the field immediately following this charater is
negative, then this character will be *““-*“ (minus). However, if the
number in the field immediately following this character is
positive, then this character will be a > ” (space).
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Depth input from single beam echo
sounder

Overview

Depth datagrams from a single beam echo sounder are accepted
for display and logging on the system. The following formats
are supported:

* NMEA 0183 DBS
* NMEA 0183 DPT

* binary datagrams from the Kongsberg Maritime EA 500 echo
sounder series.

DBS format
Data Description Format Valid range Note
Start identifier = $ Always 24h - -
Talker identifier aa Capital letters -
Sentence formatter Always DBS, - -
Depth in feet X.X,f, 0.1 - 1
Depth in meters X.X,M, 0.1 — 1
Depth in fathoms X.X,F 0.1 — 1
Checksum *hh - -
End of sentence delimiter = CRLF Always 0Dh OAh | — -

Note 1

The decoding priority will be meter field, feet field and fathom
field with the depth value extracted from the first field with

valid data.

DPT format
Data Description Format Valid range Note
Start identifier = $ Always 24h - -
Talker identifier aa Capital letters -
Sentence formatter Always DPT, - -
Depth in meters from the transducer X.X, 0.1 — -
Offset of transducer from waterline in meters | x.x, 0- 1
Maximum range scale in use X.X - -
Checksum *hh - -
End of sentence delimiter = CRLF Always 0Dh OAh - -

Note 1

A negative value implying that the offset is from the keel should

not be used.
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EA 500 format

Note

Data Description Format Valid range | Note
Start identifier = D Always 34h - -
Channel identifier X, 1t03 1
Time as HHMMSShh XXXXXXXX, 00000000to |1
23595999
Depth in meters from the transducer | 32 bit IEEE 754 floating point | 0.1 — 1
Bottom backscattering strength in dB | 32 bit IEEE 754 floating point | — -
Transducer number 32 bit integer - -
Athwartship slope in degrees 32 bit IEEE 754 floating point | — -
Note 1

Only the channel identifier, depth and time will be decoded by
the system. The least significant byte is transmitted first (the
Intel convention).

The datagram must be sent on Ethernet to UDP port number
2200 on the Operator Station.

Remote control

Overview
A Remote Control datagram has been implemented to allow:

* the multibeam echo sounder to start logging on remote
command.

* the multibeam echo sounder to send out parameter and sound
speed profile datagrams as a response to the remote
command.

* the survey line numbers to be set from a remote location.

Note that the parameter and sound speed profile datagrams are
always sent out when logging is started or any changes are made
to the parameters or sound speed. They may also be sent out
regularly at operator specified intervals.

Data Description Format Valid range Note
Start identifier = $ Always 24h - -
Talker identifier aa Capital letters -
Datagram identifier Rxx, R0OO to R20 1
EM model number EMX=dddd, - -
Responsible operator ROP=a--a, - -
Survey identifier SID=a--a, - -
Survey line number PLN=d..d, - -
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Data Description Format Valid range Note
Survey line identifier (planned line no) PLL=d--d, - -
Comment COM=a--a - -
Optional checksum *hh - -
End of datagram delimiter = \CRLF 5Ch 0Dh OAh - -

Note 1

Rxx defines what action the system is to take with respect to
pinging and logging of data in addition to changes in the
parameters. Note that logging of survey data on local storage is
not affected, this is determined by operator control from the
menu only.

852-164371/E

ROO0 - System to stop pinging (and logging if on)

R10 - System to stop all logging (but continue or start
pinging).

R11 - System to start logging on new line to both local and
remote

R12 - System to star logging on new line but only to local
storage

R13 - System to start logging on new line but only to remote

R20 - System to send installation parameter datagram and
sound speed profile datagrams to remote
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9.4 Output datagrams

Note

186

Introduction

Output datagrams are usually logged to disk or tape on the EM
Series Operator Station. The output datagrams may also be
exported to user provided programs on the Operator Station or
on an external Ethernet network using UDP protocol (remote
logging). An NMEA DPT depth datagram may be exported on a
serial line.

The output datagrams are mostly in binary format using signed
or unsigned integer numbers with lengths of 1, 2 or 4 bytes.

The same endian (little or big) as used in the input datagrams
will be used for the output datagrams. With a PC based operator
station little endian is normally used.

We recommend that software written to decode EM Series data
includes a check for the byte ordering with a provision for byte
swapping. Suitable data fields to check on are the length field at
the start of the datagram, the EM Series model number field and
possibly the date and time fields.

The basic output datagram structure established with the EM
100 echo sounder is retained.

» All datagrams (except the NMEA DPT datagram) start with
STX, datagram type and time tag, and end with ETX and
checksum (sum of bytes between STX and ETX). In addition
the total length of the datagram (not including the length
field) will precede the STX byte, given as a four byte binary
number.

* The length field is only included when logging to tape and/or
disk, but not for datagrams logged to a remote location. The
length can then be derived from the network software.
Systems logging data remotely should add this length at the
start of each datagram. This length is required if the data are
to be used with Kongsberg Maritime post-processing
systems.

* The time stamp resolution is 1 millisecond and includes the
century. The time stamp is binary. The date is given as
10000*year(4 digits) + 100*month + day, for example
19950226 for February 26, 1995. All date fields in the output
datagrams use this format. A time is usually given (in
milliseconds) from midnight.
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The datagrams identify the multibeam echo sounder model
and its serial number. The system model number is 120 for
the EM 120, 300 for the EM 300, etc. For the EM 3000D (the
dual head system) the model number was originally given as
3002 and the serial number is that of Sonar Head number 1.
However in the depth datagram model numbers 3003-3008
are now used to also identify the actual transmit and
sampling frequencies of the two heads. If only one head is
activate on the EM 3000D, it is coded as a single head
system. For EM 3002 the model number is 3020.

Due care has been taken to include all parameters needed in
postprocessing in the relevant datagrams, with a minimum of
data duplication. Where resolution of a data field is variable,
a resolution descriptor is included.

Invalid data are always identified by the highest positive
number allowed in a field unless otherwise noted.

A real-time parameter datagram has been added to enable
logging of parameters not used in postprocessing, but which
may be important in checking the quality of the logged data,
or to allow tracing of reasons for possible malfunctions.

Attitude data as time continuous records and raw ranges and
beam pointing angles are logged to allow eventual
postprocessing corrections. The logged attitudes are valid at
the transmit transducer, and are corrected for any sensor
offsets.

A new Range and beam angle datagram (type f), is now
included, that contains more details. (From January 2004).

Depth
Data Description Format | Valid range Note
Number of bytes in datagram 4U - -
Start identifier = STX (Always 02h) 1U - -
Type of datagram = D(epth data) (Always 44h) 1U - -
EM model number 2U — 4
(Example: EM 3000 = 3000)
Date = year*10000 + month*100 + day 4U - -
(Example: Feb 26, 1995 = 19950226)
Time since midnight in milliseconds 4U 0to 86399999 -
(Example: 08:12:51.234 = 29570234)
Ping counter (sequential counter) 2U 0 to 65535 -
System serial number 2U 100 — -
Heading of vessel in 0.01° 2U 0 to 35999 -
Sound speed at transducer in dm/s 2U 14000 to 16000 -

852-164371/E
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Data Description Format |Valid range Note
Transmit transducer depth re water level at time of | 2U 0 to 65536 1
ping in cm
Maximum number of beams possible 1U 48 — -
Number of valid beams = N 1U 1 to 254 -
z resolution in cm 1U 1 to 254 -
x and y resolution in cm 1U 1 to 254 -
Sampling rate (f) in Hz 2U 300 to 30000 3
or
Depth difference between sonar heads in the EM | 2S —32768 to 32766 4
3000D
Repeat cycle — N entries of : 16*N - -
Depth (z) from transmit transducer 2S —32768 to +32766 2
(unsigned for EM 120 and EM 300) or or
2U 1 to 65534
Acrosstrack distance (y) 2S —32768 to 32766 2
Alongtrack distance (x) 28 —32768 to 32766 2
Beam depression angle in 0.01° 28 —11000 to 11000 3
Beam azimuth angle in 0.01° 2U 0 to 56999 3
Range (one—way travel time) 2U 0 to 65534 3
Quality factor 1U 0to 254 5
Length of detection window (samples/4) 1U 1to 254 -
Reflectivity (BS) in 0.5 dB resolution) 1S —128to +126 -
(Example: —20 dB = 216)
Beam number 1U 1 to 254 6
End of repeat cycle
Transducer depth offset multiplier 1S —-11to +17 1
End identifier = ETX (Always 03h) 1U - -
Check sum of data between STX and ETX 2U - -
Note 1

The transmit transducer depth plus the depth offset multiplier
times 65536 cm should be added to the beam depths to derive
the depths re the water line. The depth offset multiplier will
usually be zero, except when the EM 2000/3000 Sonar Head is
on an underwater vehicle at a depth larger than 655.36 m. Note
that the offset multiplier will be negative (-1) if the actual heave
is large enough to bring the transmit transducer above the water
line. This may represent a valid situation, but may also be due to
an erroneously set installation depth of either the transducer or
the water line.

Note 2

The beam data are given re the transmit transducer or sonar head
depth and the horizontal location of the active positioning
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system’s antenna. Heave, roll, pitch, sound speed at the
transducer depth and ray bending through the water column
have been applied. On the EM 1002/2000/3000/3002 the beam
depths must be regarded as signed values to take into account
beams which may be going upwards. On the EM 120/300 the
beam depths are always positive and the values are therefore
unsigned.

Note 3

The range, beam depression angle (positive downwards and 90°
for a vertical beam) and beam azimuth angle (re vessel
centerline) are given relative to the transducer (sonar head) at
the ping transmit time. Heave, roll, pitch and sound speed at the
transducer depth have been applied, but not ray bending. These
values may thus be directly used for a new ray bending
calculation with a revised sound speed profile to generate new
sounding depths and positions without any need for using
attitude data.

One way travel time = range / sampling rate / 4

Note that if the data need to be reprocessed with a new sound
speed at the transducer depth or new roll, pitch or heave values,
full reprocessing starting with the raw range and beam angle
data is required. Attitude data is also required in this
reprocessing, and both these data types will in the future be
logged as standard.

If the beam azimuth angle has a value larger than 35999, the
beam pointing angle has replaced the beam depression angle,
and the raw two-way travel time has replaced the one-way heave
and beam angle corrected travel time. The transmit tilt angle
plus 54000 is given in the beam azimuth angle field. The use of
this data definition is available on remote output to a port named
as “RawDepth...” for use by other systems which do their own
attitude and sound speed processing.

Note 4

In an EM 3000D the transmit transducer depth is that of Sonar
Head number 1, taking into account the depth offset multiplier
as described in note 1. The range multiplier is replaced by the
difference in depth between Sonar Head number 1 and 2, i.e.
head 2 depth is equal to head 1 depth (possibly modified with
depth offset multiplier) plus the depth difference. The range
sampling rates in Hz of the two heads is given through the EM
model number according to the following table:
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EM model number 3003 3004 3005 3006 3007 3008
Sonar Head 1 13956 14293 13956 14621 14293 14621
Sonar Head 2 14621 14621 14293 14293 13956 13956

Note

Previously the model number of the EM 3000D was given as
3002 with head sample rates of 13956 and 14621 Hz
respectively. The head depths in this case should be assumed to
be equal, and although the mathematical derivation of final
beam depths would otherwise be the same as described above,
the transmit transducer depth was not actually exactly that of the
sonar heads.

Note 5

The quality number’s upper bit signifies whether amplitude (0)
or phase (1) detection has been used. If amplitude the 7 lowest
bits give the number of samples used in the centre of gravity
calculation. If phase the second highest bit signifies whether a
second (0) or first (1) order curve fit has been applied to
determine the zero phase range, and the 6 lowest bits indicates
the quality of the fit (actually the normalized variance of the fit
re the maximum allowed, i.e. with a lower number the better the
fit).

Note 6

Beam 128 is the first beam on the second sonar head in an EM
3000D dual head system.

Raw range and beam angle (new)

New datagram, added January 2004. This datagram replaces the
old F datagram.

This version of the datagram is not yet implemented on the EM
3000. Use the version below.

Data Description Format |Valid range Note
Number of bytes in datagram 4U - -
Start identifier = STX (Always 02h) 1U - -
Type of datagram = f (Always 66h) 1U - -
EM model number 2U - -
(Example: EM 3000 = 3000)

Date = year*10000 + month*100 + day 4U - -
(Example: Feb 26, 1995 = 19950226)

Time since midnight in milliseconds 4U 0 to 86399999 -
(Example: 08:12:51.234 = 29570234)

Ping counter (sequential counter) 2U 0 to 65535 -
System serial number 2U 100 — -
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Data Description Format |Valid range Note
Number of transmit sectors = Ntx 2U 1to 20 -
Number of valid receive beams = N 2U 1 to 1999 -
Sampling frequency in 0.01 Hz (F) 4U 100 to 100000
ROV depth in 0.01 m 4S8
Sound speed at transducer in 0.1 m/s 2U 14000 to 16000 -
Maximum number of beams possible 2U 1 to 1999
Spare 1 2U
Spare 2 2U
Nix entries of : 20*Ntx | —
Tilt angle in 0.01° 28 —2900 to 2900 -
Focus range in 0.1 m 2U 0 to 65535 -
(0 = No focus)
Signal length in us 4U -
Transmit time offset in us 4U -
Center frequency in Hz 4U -
Bandwidth in 10 Hz 2U 1 to 65535 —
Signal waveform identifier 1U 0to 99 1
Transmit sector number 1U 0to 19 -
N entries of : 12*N
Beam pointing angle ref array in 0.01° 25 —11000to 11000 | —
Range in 0.25 samples (R) 2U 0 to 65535 2
Transmit sector number 1U 0to 19 -
Reflectivity (BS) in 0.5 dB resolution 1S —1281to0 127 -
Quality factor 1U 0to 254 -
Detection window length in samples (/4 if phase) 1U 1to 254
Beam number 2S —1999 to 1999 3
Spare 2U
Spare (Always 0) 1U 0 -
End identifier = ETX (Always 03h) 1U - -
Check sum of data between STX and ETX 2U - -
Note 1
O=cw,1=FM
Note 2

Two way travel time=R/(4*F/100)
Note 3

The beam number normally starts at 0.
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Raw range and beam angle

Data Description Format |Valid range Note
Number of bytes in datagram 4U - -
Start identifier = STX (Always 02h) 1U - -
Type of datagram = F (Always 46h) 1U - -
EM model number 2U - -
(Example: EM 3000 = 3000)
Date = year*10000 + month*100 + day 4U - -
(Example: Feb 26, 1995 = 19950226)
Time since midnight in milliseconds 4U 0 to 86399999 -
(Example: 08:12:51.234 = 29570234)
Ping counter (sequential counter) 2U 0 to 65535 -
System serial number 2U 100 — -
Maximum number of beams possible 1U 48 — -
Number of valid beams = N 1U 1to 254 -
Sound speed at transducer in dm/s 2U 14000 to 16000 -
Repeat cycle — N entries of : 8*N -
— Beam pointing angle in 0.01° 2S —-11000to 11000 |1
— Transmit tilt angle in 0.01° 2U —2999 to 2999 1
— Range (two—way travel time) 2U 0 to 65534 1
— Reflectivity (BS) in 0.5 dB resolution 1S —128 to 126 -
— Beam number 1U 1to 254 -
End of repeat cycle
Spare (Always 0) 1U - -
End identifier = ETX (Always 03h) 1U - -
Check sum of data between STX and ETX 2U - -
Note 1

The beam pointing angle is positive to port and the transmit tilt
angle is positive forwards for a normally mounted system
looking downwards. The range resolution in time is the inverse
of the range sampling rate given in the depth datagrams.

Seabed image

Data Description Format |Valid range Note
Number of bytes in datagram 4U - -
Start identifier = STX (Always 02h) 1U - -
Type of datagram = S(eabed image data) (Always 53h) |1U - -
EM model number 2U - -
(Example: EM 3000 = 3000)

Date = year*10000 + month*100 + day 4U - -
(Example: Feb 26, 1995 = 19950226)
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Data Description Format | Valid range Note
Time since midnight in milliseconds 4U 0 to 86399999 | —
(Example: 08:12:51.234 = 29570234
Ping counter (sequential counter) 2U 0 to 65535 -
System serial number 2U 100 — -
Mean absorption coefficient in 0.01 dB/km 2U 1 to 20000 1
Pulse length in us 2U 50 — 1
Range to normal incidence used to correct sample 2U 1 to 16384 -
amplitudes in no. of samples
Start range sample of TVG ramp if not enough dynamic |2U 0to 16384 -
range (0 else)
Stop range sample of TVG ramp if not enough dynamic | 2U 0to 16384 -
range (0 else)
Normal incidence BS in dB (BSN) 1S -50t0 10 -
(Example: —20 dB = 236)
Oblique BS in dB (BSO) 1S -60to 0 -
(Example: —1 dB = 255)
Tx beamwidth in 0.1° 2U 1 to 300 -
TVG law crossover angle in 0.1° 1U 20 to 300 -
Number of valid beams (N) 1U 1to 254 -
Repeat cycle — N entries of : 6*N -
beam index number 1U 0to 253 2
sorting direction 1S —1or1 3
number of samples per beam = Ns 2U 1- -
centre sample number 2U 1- 4
End of repeat cycle
Repeat cycle — 3Ns entries of: >Ns -
Sample amplitudes in 0.5 dB 1S —128to 126 -
(Example: —30 dB = 196)
End of repeat cycle
Spare byte if required to get even length (Always O if 0-1U - -
used)
End identifier = ETX (Always 03h) 1U - -
Check sum of data between STX and ETX 2u - -

Note 1

These fields have earlier had other definitions.

Note 2

The beam index number is the beam number - 1.

Note 3
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The first sample in a beam has lowest range if 1, highest if -1.
Note that the range sampling rate is defined by the sampling rate
in the depth output datagram and that the ranges in the seabed
image datagram are all two-way from time of transmit to time of
receive

Note 4
The centre sample number is the detection point of a beam.

Position
Data Description Format |Valid range |Note
Number of bytes in datagram 4U - -
Start identifier = STX (Always 02h) 1U - -
Type of datagram = P(osition data) (Always 050h) 1U - -
EM model number 2U - -
(Example: EM 3000 = 3000)
Date = year*10000 + month*100 + day 4U - -
(Example: Feb 26, 1995 = 19950226)
Time since midnight in milliseconds 4U O0to -
(Example: 08:12:51.234 = 29570234) 86399999
Position counter (sequential counter) 2U 0 to 65535 -
System / serial number 2U 100 — -
Latitude in decimal degrees*20000000 (negative if 4S8 - -

southern hemisphere)
(Example: 32°34’ S = —651333333)

Longitude in decimal degrees*10000000 (negative if 4S - -
western hemisphere)
(Example: 110.25° E = 1102500000 )

Measure of position fix quality in cm 2U - 1
Speed of vessel over ground in cm/s 2u 0 - 1
Course of vessel over ground in 0.01° 2U 0 to 35999 1
Heading of vessel in 0.01° 2U 0 to 35999 -
Position system descriptor 1U 1to 254 2
Number of bytes in input datagram 1U — 254 -
Position input datagram as received Variable | — 3
Spare byte if required to get even length (Always 0 if used) |0—-1U - -
End identifier = ETX (Always 03h) 1U - -
Check sum of data between STX and ETX 2U - -

Note 1

These data will be valid only if available as input.

Note 2

The position system descriptor shows which source this data is
from and its real-time use by bit coding:
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* xXxX xx01 - position system no 1
* XXxX Xx10 — position system no 2
* XXxX Xx11 — position system no 3

* 10xx xxxx — the position system is active, system time has
been used

* 11xx xxxX - the position system is active, input datagram
time has been used

* XXxX 1xxx — the position may have to be derived from the
input datagram which is then in SIMRAD 90 format.

Note 3

Complete input datagram except header and tail (such as NMEA
0183 $ and CRLF).

Depth (pressure) or height

Data Description Format |Valid range Note
Number of bytes in datagram 4U - -
Start identifier = STX (Always 02h) 1U - -
Type of datagram = h(eight data) (Always 068h) 1U - -
EM model number 2U - -
(Example: EM 3000 = 3000)
Date = year*10000 + month*100 + day 4U - -
(Example: Feb 26, 1995 = 19950226)
Time since midnight in milliseconds 4U 0to 86399999 | —
(EXample: 08:12:51.234 = 29570234)
Height counter (sequential counter) 2U 0 to 65535 -
System serial number 2U 100 — -
Height in cm 4S8 —4294967296 | —
to 4294967295
Heigth type 1U 0to 100 1
End identifier = ETX (Always 03h) 1U - -
Check sum of data between STX and ETX 2U - -

852-164371/E

Note 1

0: The height is derived from the GGK or GGA datagram and is
the height of the water level are the vertical datum (possibly
motion corrected).

1 -99: The height type is as given in the Depth (pressure) or
height input datagram.

100: The input is depth taken from the Depth (pressure) or
height input datagram.

195




EM 3000 / Base version

Tide

Data Description Format |Valid range |Note
Number of bytes in datagram 4U - -
Start identifier = STX (Always 02h) 1U - -
Type of datagram = T(ide data) (Always 054h) 1U - -
EM model number 2U - -
(Example: EM 3000 = 3000)

Date = year*10000 + month*100 + day 4U - -
(Example: Feb 26, 1995 = 19950226)

Time since midnight in milliseconds 4U 0to -
(Example: 08:12:51.234 = 29570234) 86399999
Tide counter (sequential counter) 2U 0to 65535 | -
System serial number 2U 100 - -
Date = year*10000 + month*100 + day (from input 4U - -
datagram)

(Example: Feb 26, 1995 = 19950226)

Time since midnight in milliseconds (from input 4U 0to -
datagram) 86399999
(Example: 08:12:51.234 = 29570234)

Tidal offset in cm 2S -32768 to -

32766
Spare (Always 0) 1U - -
End identifier = ETX (Always 03h) 1U - -
Check sum of data between STX and ETX 2U - -
Attitude

Data Description Format |Valid range |Note
Number of bytes in datagram 4U - -
Start identifier = STX (Always 02h) 1U - -
Type of datagram = A(ttitude data) (Always 041h) 1U - -
EM model number 2U - -
(Example: EM 3000 = 3000)

Date = year*10000 + month*100 + day (at start of data 4U - -
record)

(Example: Feb 26, 1995 = 19950226)

Time since midnight in milliseconds (at start of data 4U Oto -
record) 86399999
(Example: 08:12:51.234 = 29570234)
Attitude counter (sequential counter) 2U 0 to 65535 -
System serial number 2U 100 — -
Number of entries = N 2U 1 - -
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Data Description Format |Valid range |Note

Repeat cycle - N entries of: 12*N -

— Time in milliseconds since record start 2U 0 to 65534 -

— Sensor status 2U - 1

— Rollin 0.01° 25 —18000 to -
18000

— Pitch in 0.01° 28 —18000 to -
18000

— Heave incm 2S —1000 to -
10000

— Heading in 0.01° 2U 0 to 35999 -

End of repeat cycle

Sensor system descriptor 1U - 2

End identifier = ETX (Always 03h) 1U - -

Check sum of data between STX and ETX 2u - -

Note 1

The sensor status will be copied from the input datagram’s two
sync bytes if the sensor uses the EM format. See the input
format description for further details.

Note 2

The sensor system descriptor will show which sensor the data is
derived from, and which of the sensor’s data have been used in

real time by bit coding:

e xX00 Xxxx — motion sensor number 1
e xX01 xxxx — motion sensor number 2
* xxxX xxx1 — heading from the sensor is active
e XxxxX xx0x — roll from the sensor is active

*  XxxXx XOxx — pitch from the sensor is active

* XxxxX 0xxx — heave from the sensor is active

Heading
Data Description Format |Valid range |Note
Number of bytes in datagram 4U - -
Start identifier = STX (Always 02h) 1U - -
Type of datagram = H(eading data) (Always 048h) 1U - -
EM model number 2U - -
(Example: EM 3000 = 3000)
Date = year*10000 + month*100 + day (at start of data 4U - -
record)
(Example: Feb 26, 1995 = 19950226)
Time since midnight in milliseconds (at start of data 4U Oto -
record) 86399999

(System: 08:12:51.234 = 29570234)
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Data Description Format |Valid range |Note
Heading counter (sequential counter) 2U 0 to 65535 -
System serial number 2U 100 — -
Number of entries = N 2U 1 - -
Repeat cycle — N entries of: 4*N - -
— Time in milliseconds since record start 2U 0 to 65534 -
— Heading in 0.01° 2U 0 to 35999 -
End of repeat cycle
Heading indicator (active or not) (0 = inactive) 1U - -
End identifier = ETX (Always 03h) 1U - -
Check sum of data between STX and ETX 2U - -
Clock
Data Description Format |Valid range |Note
Number of bytes in datagram 4U - -
Start identifier = STX (Always 02h) 1U - -
Type of datagram = C(lock data) (Always 043h) 1U - -
EM model number (Example: EM 3000 = 3000) 2U - -
Date = year*10000 + month*100 + day (of EM clock) 4U - -
(Example: Feb 26, 1995 = 19950226)
Time since midnight in milliseconds (of EM clock) 4U 0to -
(Example: 08:12:51.234 = 29570234) 86399999
Clock counter (sequential counter) 2U 0 to 65535 -
System serial number 2U 100 — -
Date = year*10000 + month*100 + day 4U - -
(from external clock input)
(Example: Feb 26, 1995 = 19950226)
Time since midnight in milliseconds 4U 0to -
(from external clock datagram) 86399999
(Example: 08:12:51.234 = 29570234)
1 PPS use (active or not) (0 = inactive) 1U - 1
End identifier = ETX (Always 03h) 1U - -
Check sum of data between STX and ETX 2U - -

Note 1

Shows if the system clock is synchronised to an external 1 PPS

signal or not.

Surface sound speed

Data Description Format |Valid range |Note
Number of bytes in datagram 4U - -
Start identifier = STX (Always 02h) 1U - -
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Data Description Format |Valid range |Note

Type of datagram = G (Always 047h) 1U - -

EM model number 2U - -

(Example: EM 3000 = 3000)

Date = year*10000 + month*100 + day 4U - -

(at start of data record)

(Example: Feb 26, 1995 = 19950226)

Time since midnight in milliseconds 4U Oto -

(at start of data record) 86399999

(Example: 08:12:51.234 = 29570234)

Sound speed counter (sequential counter) 2U 0 to 65535 -

System serial number 2U 100 — -

Number of entries = N 2U 1 - -

Repeat cycle - N entries of: 4*N -

— Time in seconds since record start 2U 0 to 65534 -

— Sound speed in dm/s (including offset) 2U 14000 to -
15999

End of repeat cycle

Spare (Always 0) 1U - -

End identifier = ETX (Always 03h) 1U - -

Check sum of data between STX and ETX 2U - -

Sound speed profile

This datagram will contain the profile actually used in the real
time raybending calculations to convert range and angle to xyz
data. It will usually be issued together with the installation

parameter datagram.

Data Description Format |Valid range |Note
Number of bytes in datagram 4U - -
Start identifier = STX (Always 02h) 1U - -
Type of datagram = U (Always 055h) 1U - -
EM model number 2U - -
(Example: EM 3000 = 3000)

Date = year*10000 + month*100 + day (at start of use) 4U - -
(Example: Feb 26, 1995 = 19950226)

Time since midnight in milliseconds 4U 0to -
(at start of use) 86399999
(Example: 08:12:51.234 = 29570234)

Profile counter (sequential counter) 2U 0 to 65535 -
System serial number 2U 100 — -
Date = year*10000 + month*100 + day 4U - -
(when profile was made)

(Example: Feb 26, 1995 = 19950226)
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Data Description Format | Valid range |Note
Time since midnight in milliseconds 4U 0to -
(when profile was made) 86399999
(Example: 08:12:51.234 = 29570234)
Number of entries = N 2U 1 - -
Depth resolution in cm 2U 1to 254 -
Repeat cycle — N entries of: 8*N - -
- Depth 4U 0 to 1200000 | -
— Sound speed in dm/s 4U 14000 to -
17000
End of repeat cycle
Spare byte to get even length (Always 0) 1U - -
End identifier = ETX (Always 03h) 1U - -
Check sum of data between STX and ETX 2U - -

Kongsberg Maritime SSP output

This datagram will contain the profile as received as input, and
is logged as is to enable use of its data in postprocessing. The
real time use of its data is decided by the operator, the sound
speed profile actually being used is given by the sound speed
profile output datagram (see above).

Data Description Format |Valid range |Note
Number of bytes in datagram 4U - -
Start identifier = STX (Always 02h) 1U - -
Type of datagram = W (Always 057h) 1U - -
EM model number 2U - -
(Example: EM 3000 = 3000)
Date = year*10000 + month*100 + day 4U - -
(Example: Feb 26, 1995 = 19950226)
Time since midnight in milliseconds 4U Oto -
(Example: 08:12:51.234 = 29570234) 86399999
SSP counter (sequential counter) 2U 0 to 65535 -
System serial number 2U 100 — -
Input datagram starting with Sentence formatter and ending | Variable | — -
with Comment
Spare byte if required to get even length (Always O ifused) |0 — 1U | — -
End identifier = ETX (Always 03h) 1U - -
Check sum of data between STX and ETX 2u - -
Single beam echo sounder depth
Data Description Format |Valid range |Note
Number of bytes in datagram 4U - -
Start identifier = STX (Always 02h) 1U - -
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Data Description Format |Valid range |Note
Type of datagram = E(cho sounder data) (Always 045h) 1U - -
EM model number 2u - -
(Example: EM 3000 = 3000)
Date = year*10000 + month*100 + day (of EM clock) 4U - -
(Example: Feb 26, 1995 = 19950226)
Time since midnight in milliseconds (of EM clock) 4U Oto -
(Example: 08:12:51.234 = 29570234) 86399999
Echo sounder counter (sequential counter) 2U 0 to 65535 -
System serial number 2U 100 — -
Date = year*10000 + month*100 + day (from input 4U - -
datagram if available)
(Example: Feb 26, 1995 = 19950226)
Time since midnight in milliseconds (from input datagram if | 4U Oto -
available) 86399999
(Example: 08:12:51.234 = 29570234)
Echo sounder depth from waterline in cm 4U 0 to 1200000 | —
Source identifier (S, T, 1, 2 or 3) ASCII - 1
End identifier = ETX (Always 03h) 1U - -
Check sum of data between STX and ETX 2U - -

Note 1

Identifies the source datagram type, i.e. NMEA DBS, NMEA
DPT or EA 500 series channel 1-3 respectively.

Runtime parameter

Data Description Format |Valid range |Note
Number of bytes in datagram 4U - -
Start identifier = STX (Always 02h) 1U - -
Type of datagram = R(untime parameter) (Always 052h) 1U - -
EM model number 2U - -
/Example: EM 3000 = 3000)

Date = year*10000 + month*100 + day 4U - -
(Example: Feb 26, 1995 = 19950226)

Time since midnight in milliseconds 4U Oto -
(Example: 08:12:51.234 = 29570234) 86399999

Ping counter 2U 0 to 65535 -
System serial number 2U 100 — -
Operator Station status 1U - 1
Processing Unit status 1U - 1
BSP status 1U - 1
Sonar Head or Transceiver status 1U - 1
Mode 1U 1 - 2
Filter identifier 1U 0to 254 3
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Data Description Format |Valid range |Note
Minimum depth in m 2U 0 to 10000 -
Maximum depth in m 2U 1 to 12000 -
Absorption coefficient in 0.01 dB/km 2U 1 to 20000 4
Transmit pulse length in us 2U 1 to 50000 -
Transmit beamwidth in 0.1 degrees 2U 1 to 300 -
Transmit power re maximum in dB 1S 0to —-50 -
Receive beamwidth in 0.1 degrees 1U 510 80 -
Receive bandwidth in 50 Hz resolution 1U 1to 254 -
Receiver fixed gain setting in dB 1U 0to 50 -
TVG law crossover angle in degrees 1U 210 30 -
Source of sound speed at transducer 1U 0to3 5
Maximum port swath width in m 2U 10t0 20000 | —
Beam spacing 1U 0to3 6
Maximum port coverage in degrees 1U 10to 110 -
Yaw and pitch stabilization mode 1U - 7
Maximum starboard coverage in degrees 1U 10to 110 -
Maximum starboard swath width in m 2U 10t0 20000 | —
Spare (Always 0) 2U - -
HiLo frequency absorption coefficient ratio 1U 00to 120 -
End identifier = ETX (Always 03h) 1U - -
Check sum of data between STX and ETX 2U - -

Note 1

The table below shows the system error status coded by one bit
for each detected error. The status bit is set to one if error is

detected.
Operator Station status
Bit Function Model
number
Xxxx xxxx | For future use
Processing Unit status
Bit Function Model
number
xxxx xxx1 [ Communication error with BSP All models
xxxx xx1x [ Communication error with Sonar Head or Transceiver | All models
xxxx x1xx | Attitude not valid for this ping All models
xxxx 1xxx | Heading not valid for this ping All models
xxx1 xxxx [ System clock has not been set since power up All models
xx1x xxxx | External trigger signal not detected All models

XXX XXXX | Spare

202

852-164371/ E




Datagram formats

BSP status (EM 2000, EM 3000 and EM 3002)

Bit Function Model

number

xxxx xxx1 | Error on RX data received by BSP 1 EM 2000, EM 3000,
(May be a bad high speed link) EM 3000D, EM 3002,

EM 3002D, EM 1002

xxxx xx1x [ Too much seabed image data on BSP1 EM 3000, EM 3000D

xxxx X1xx [ Invalid command received by BSP1 EM 3000, EM 3000D

xxxX 1xxx [ Errors on BSP1 EM 3002, EM 3002D

xxx1 xxxx [ Error on RX data received by BSP 2 EM 3000D, EM 3002D
(May be a bad high speed link)

xx1x xxxx [ Too much seabed image data on BSP2 EM 3000D

x1xx xxxx [ Invalid command received by BSP2 EM 3000D

1xxx xxxx | Errors on BSP2 EM 3002, EM 3002D

Sonar Head status (EM 2000, EM 3000 and EM 3002)

Bit Function Model

number

xxxx xxx1 | Temperature to high on Sonar Head 1 EM 2000, EM 3000,
EM 3000D, EM 3002,
EM 3002D

xxxx xx1x | Data link failure on Sonar Head 1 EM 2000, EM 3000,
EM 3000D, EM 3002,
EM 3002D

xxxx Xx1xx [ DC Supply Voltages in Sonar Head 1 is out of range EM 2000, EM 3000,
EM 3000D, EM 3002,
EM 3002D

XXxX 1xxx | Spare

xxx1 xxxx | Temperature to high on Sonar Head 2 EM 3000D, EM 3002D

xX1x xxxx | Data link failure on Sonar Head 2 EM 3000D, EM 3002D

x1xx xxxx [ DC Supply Voltages in Sonar Head 2 is out of range EM 3000D, EM 3002D

TXXX XXXX
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Note 2

The mode identifier byte is used as follows:
* (0000 0000 - Nearfield (EM 3000) or Very Shallow
* (0000 0001 - Normal (EM 3000) or Shallow (default for EM

2000)

* (0000 0010 - Target detect (EM 3000) or Medium

* (0000 0011 - Deep

* 0000 0100 - Very deep

* (0000 0101 - Extra deep (EM 300)
Note 3

The filter identifier byte is used as follows:
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e xxxx xx00 - Spike filter set to Off

e xxxx xXx01 - Spike filter is set to Weak

e xxxX Xx10 - Spike filter is set to Medium
e xxxX Xx11 - Spike filter is set to Strong

* XXXX x1xx - Slope filter is on

* XXxX 1xxx - Sector tracking or Robust Bottom Detection
(EM 3000) is on

* 0Oxx0 xxxx - Range gates have Normal size

* Oxx1 xxxx - Range gates are Large

* 1xx0 xxxx - Range gates are Small

e xx1x xxxx - Aeration filter is on (EM 120 and EM 300)

* x1xx xxxx - Interference filter is on (EM 120 and EM 300)
Note 4

The used absorption coefficient should be derived from the
seabed image or central beams echogram datagram if it is
automatically updated with changing depth.

Note 5

The sound speed (at the transducer depth) source identifier is
used as follows :

e (0000 0000 - From real time sensor
* (0000 0001 - Manually entered by operator

* (0000 0010 - Interpolated from currently used sound speed
profile

Note 6
The beamspacing identifier is used as follows:

* (0000 0000 - Determined by beamwidth (FFT beamformer of
EM 3000)

* (0000 0001 - Equidistant
* (0000 0010 - Equiangle

* (0000 0011 - Equiangle around nadir, equidistant in between
or high density (EM 3002)

Note 7
The yaw and pitch stabilization identifier is set as follows:
e xxxx xx00 - No yaw stabilization

e xxxx xx01 - Yaw stabilization to survey line heading (Not
used)
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e xxxx Xx10 - Yaw stabilization to mean vessel heading
e xxxx Xx11 - Yaw stabilization to manually entered heading
e Ixxx Xxxx - Pitch stabilization is on.

Installation parameters

This datagram is an ASCII datagram except for the header
which is formed as in all other output datagrams. The datagram
is issued as a start datagram when logging is switched on and as
a stop datagram when logging is turned off, i.e. at the start and
end of a survey line. It may also be sent to a remote port as an
information datagram. It is usually followed by a sound speed
profile datagram.

In the datagram all ASCII fields start with a unique three
character identifier followed by “=". This should be used when
searching for a specific field as the position of a field within the
datagram is not guaranteed. The number or character part
following is in a variable format with a minus sign and decimal
point if needed, and with “,” as the field delimiter. The format
may at any time later be expanded with the addition of new
fields at any place in the datagram.

For the EM 3000 and EM 3002 the transducer 1 data are for the
Sonar Head and the transducer 2 data are for the second Sonar
Head of an EM 3000D or an EM 3002. For other new EM
systems with separate transmit and receive transducers,
transducer 1 refers to the transmit transducer, and transducer 2
refers to the receive transducer.

Data Description Example Format | Valid range | Note
Number of bytes in datagram - 4U - 1
Start identifier = STX Always 02h 1U - -
Type of datagram = | or i(nstallation Start = 049h 1U - -
parameters) or r(emote information) Stop = 069h
Remote info =
70h
EM model number EM 3000 = 2U - -
3000
Date = year*10000 + month*100 + day Feb 26, 1995 = |4U - -
19950226
Time since midnight in milliseconds 08:12:51.234 = | 4U 0to -
29570234 86399999
Survey line number - 2U 0to 65534 | —
System serial number - 2U 100 — -
Serial number of second sonar head - 2U 100 — -
Water line vertical location in m WLZ=x.x, ASCII - -
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Data Description Example Format | Validrange | Note
System main head serial number SMH=x.x, ASCIl | 100 — 1
Hull Unit HUN=x ASCIl |Oor1 -
Hull Unit tilt offset HUT=x.x ASCIl | - -
Transducer 1 vertical location in m S1Z=x.x, ASCII - -
Transducer 1 along location in m S1X=x.x, ASCII - -
Transducer 1 athwart location in m S1Y=x.x, ASCII - -
Transducer 1 heading in degrees S1H=x.x, ASCII - -
Transducer 1 roll in degrees re horizontal S1R=x.x, ASCII - -
Transducer 1 pitch in degrees S1P=x.x, ASCII - -
Transducer 1 no of modules S1N=x--x, ASCIl | - -
Transducer 2 vertical location in m S2Z=x.x, ASCII - -
Transducer 2 along location in m S2X=x.x, ASCII - -
Transducer 2 athwart location in m S2Y=x.x, ASCII - -
Transducer 2 heading in degrees S2H=x.x, ASCII - -
Transducer 2 roll in degrees re horizontal S2R=x.x, ASCII - -
Transducer 2 pitch in degrees S2P=x.x, ASCII - -
Transducer 2 no of modules S2N=x——X, ASCII - -
System (sonar head 1) gain offset GO1=x.x, ASCII - -
Sonar head 2 gain offset GO2=x.x, ASCII - -
Outer beam offset OBO=x.x ASCII - -
High/Low Frequency Gain Difference FGD=x.x ASCII - -
Transmitter (sonar head no1) software version | TSV=c-—c, ASCII - 2
Receiver (sonar head 2) software version RSV=c--c, ASCII - 2
BSP software version BSV=c--c, ASCII - 2
Processing unit software version PSV=c--c, ASCII - 2
Operator station software version OSV=c--c, ASCII - 2
Datagram format version DSV=c--c, ASCII - 2
Depth (pressure) sensor along locationinm | DSX=x.x, ASCII -

Depth (pressure) sensor athwart location in m | DSY=x.x, ASCII -

Depth (pressure) sensor vertical location in m | DSZ=x.x, ASCII -

Depth (pressure) sensor time delay in millisec | DSD=x--x, ASCII - -
Depth (pressure) sensor offset DSO=x.x, ASCII - -
Depth (pressure) sensor scale factor DSF=x.x, ASCII -

Depth (pressure) sensor heave DSH=aa, ASCII IN or NI 3
Active position system number APS=x, ASCII Oto 2 7
Position system 1 motion compensation P1M=x, ASCIl  |[Oor1 4
Position system 1 time stamp used P1T=x, ASCIl |Oor1 5
Position system 1 vertical location in m P1Z=x.x, ASCII - -
Position system 1 along location in m P1X=x.x, ASCII - -
Position system 1 athwart location in m P1Y=x.x, ASCII - -
Position system 1 time delay in seconds P1D=x.x, ASCII - -
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Data Description Example Format | Validrange | Note
Position system 1 geodetic datum P1G=c—--c, ASCII - -
Position system 2 motion compensation P2M=x, ASCIl  |[Oor1 4
Position system 2 time stamp use P2T=x, ASCIl  |Oor1 5
Position system 2 vertical location in m P2Z=x.x, ASCII - -
Position system 2 along location in m P2X=x.x, ASCII - -
Position system 2 athwart location in m P2Y=x.x, ASCII - -
Position system 2 time delay in seconds P2D=x.x, ASCII - -
Position system 2 geodetic datum P2G=c--c, ASCII - -
Position system 3 motion compensation P3M=x, ASCIl  |[Oor1 4
Position system 3 time stamp use P3T=x, ASCIl  |[Oor1 5
Position system 3 vertical location in m P3Z=x.x, ASCII - -
Position system 3 along location in m P3X=x.x, ASCII - -
Position system 3 athwart location in m P3Y=x.x, ASCII - -
Position system 3 time delay in seconds P3D=x.x, ASCII - -
Position system 3 geodetic datum P3G=c--c, ASCII - -
Position system 3 on serial line or Ethernet P3S= x, ASCIl |0 for -
Ethernet

Motion sensor 1 vertical location in m MSZ=x.x, ASCII - -
Motion sensor 1 along location in m MSX=x.x, ASCII - -
Motion sensor 1 athwart location in m MSY=x.x, ASCII - -
Motion sensor 1 roll reference plane MRP=aa, ASCII HOorRP |-
Motion sensor 1 time delay in milliseconds MSD=x——x, ASCII - -
Motion sensor 1 roll offset in degrees MSR=x.x, ASCII - -
Motion sensor 1 pitch offset in degrees MSP=x.x, ASCII - -
Motion sensor 1 heading offset in degrees MSG=x.x, ASCII -

Motion sensor 2 vertical location in m NSZ=x.x, ASCII - 6
Motion sensor 2 along location in m NSX=x.x, ASCII - 6
Motion sensor 2 athwart location in m NSY=x.x, ASCII - 6
Motion sensor 2 roll reference plane NRP=aa, ASCII HOorRP |6
Motion sensor 2 time delay in milliseconds NSD=x——x, ASCII - 6
Motion sensor 2 roll offset in degrees NSR=x.x, ASCII - 6
Motion sensor 2 pitch offset in degrees NSP=x.x, ASCII - 6
Motion sensor 2 heading offset in degrees NSG=x.x, ASCIl | - 6
Gyrocompass heading offset in degrees GCG=x.x, ASCII - -
Roll scaling factor MAS=x.x, ASCII - -
Transducer depth sound speed source SHC=x ASCIl  |Oor1 8
Active heading sensor AHS=x, ASCIl |1to4 -
Active roll sensor ARO=x, ASCII 1to4 -
Active pitch sensor port no API=x, ASCIl |1to4 -
Active heave sensor port no AHE=x, ASCII 1to4 -
Cartographic projection CPR=aaa, ASCII - -

852-164371/E
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Data Description

Example Format | Valid range | Note

Responsible operator

ROP=c-—c, ASCII - -

Survey identifier

SID=c--c, ASCIll | - -

Survey line identifier (planned line no) PLL=x——X, ASCII - -

Comment COM=c--c, |ASCI - -

Spare byte if required to get even length Always 0 if 0-1U |- -
used

End identifier = ETX Always 03h 1U - -

Check sum of data between STX and ETX 2U - -
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Note 1

Serial number of head no 2 if that head is the only one in use
with the EM 3000D, otherwise the serial number of head no 1 in
the EM 3000D or the only head in the EM 3000.

Note 2

A version number is given as 3 alphanumerical fields separated
by decimal points, plus date as yymmdd (for example 3.02.11
991124).

Note 3

IN = the heave of an underwater vehicle is presumed to be
measured by the vehicle’s depth sensor and the heave sensor
input is not used by system.

Note 4

1 = the positions are motion compensated

0 = the positions are not motion compensated
Note 5

0 = the system has used its own time stamp for the valid time of
the positions

1 = the system has used the time stamp of the position input
datagram (external time).

Note 6

If entries for a second motion sensor are not included although
two sensors are being used, they are presumed to have the same
parameters.

Note 7
Position system number -1.
Note 8

0 = Transducer depth sound speed is used as the initial entry the
sound speed profile used in the raytracing calculations.
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1 = Transducer depth sound speed is NOT used for raytracing
calculations.

Note that the source of the sound speed at the transducer depth
(and this sound speed is always used to calculate beam pointing
angles if required) is logged in the runtime datagram.
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10 SYSTEM ADMINISTRATION (UNIX)

Note If you have a SIS operator station please refer to the SIS

Operator Manual.

10.1 Introduction

This chapter provides basic reference information useful for the
EM 3000 system supervisor. In order to make the most of the

information provided, you may need some basic knowledge of
the Unix operating system.
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10.2 Passwords
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EM 3000 Installation setup

In order to change the installation parameters on the EM 3000
system, you need to enter a password. This password is common
for all the operators of the EM 3000 system. You will
automatically be prompted to enter the password once you select
Edit enable in the Edit menu.

If a password has not been identified, the first attempt to modify
the installation parameters will prompt you to enter a new
password.

If the password is lost, the current password can be deleted by
deleting the following file:

$HOME/.eso_system/.esoEM 3000 protection

No special privileges are required to delete this file. Once it is

gone, the system will prompt you for a new password next time
you choose Edit enable.
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10.3 EM 3000 File system

Note
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Introduction

The EM 3000 requires a large number of individual files. Some
are used for data storage, others for system setup, while some
are used to store operator and system configurations. This
chapter lists the various file types and provides brief
explanations.

The notation $<name> is an “environment variable”, usually
specifying a filsystem directory.

Survey files

During a survey, the EM 3000 system will record and store the
following file types:

* Raw data
* Survey data

The information is stored on the Operator Station harddisk on
dedicated data formats defined by Kongsberg Maritime..

Survey data

These are the data files generated by the system. Note that files
will only be stored if the Survey Format To Disk option is
checked in the window opened by Options -> Logging.

These files are used by the post-processing software, and by the
Survey Display program.

Unless this data is stored, the Survey Display application will
not work.

Raw data

These are the files containing the raw data retrieved during the
survey. These files are the most important files collected during
a survey. If you accidentally loose your survey data format files
(required by the post-processing software), you can recreate
these files based on the raw data files. Care should be taken to
backup raw data files on a regular basis, using the backup
facilities supplied as an integral part of the system.

Sound speed profiles

All the sound speed profiles are stored as separate files in
directory specified by the environment variable.
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$SHAREDHOME
The files have extension *.asvp

Absorption coefficient file

The absorption coefficient file contains number pairs of
absorption coefficients and corresponding depths. The
coefficients are integrated during loading to the echo sounder
and the integrated value is used. The file is named
absorption.coef and is stored in directory:

$SHAREDHOME

Workstation 1/0

When you define the use of the Operator Station’s serial lines,
the setup information is stored in the following file:

$HOME/.eso_system/esoSetup.serial

Echo sounder parameters

These are the files determining how the current echo sounder
system is set up. The system uses separate files for runtime and
installation parameters.

Installation setup
The installation setup information is saved in the following file:
$HOME/.eso_system/esoEM3000Setup.installation

Every time you save this file, a backup file is generated
automatically. This file is named:

esoEM3000Setup.installation.yyyy mmdd_hhmm

where:
yyyy=year
mm=month
dd=day
hh=hour
mm=minute.

You can also save the setup files with other names you choose
yourself. You can then pick any name, but you must keep the
extension as “.installation”. The extension is added
automatically if you only specify the file name.

Runtime setup

The runtime setup information is saved in the following file:

esoEM3000Setup.runtime
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Every time you save this file, a backup file is generated
automatically. This file is named:

$HOME/.eso_system/esoEM3000Setup.runtime.yyyy mmdd_
hhmm

where:
yyyy=year
mm=month
dd=day
hh=hour
mm=minute.

You can also save the runtime files with other names you choose
yourself. You can then pick any name, but you must keep the
extension as “.runtime”. The extension is added automatically if
you only specify the file name.

Echo sounder status

The information in the Status Field in the Launchpad is stored in
the following file:

$HOME/.eso_system/esoSetup.status

IP_ addresses, ports and datagrams

The IP addresses for the various items in the system, the ports
used for the various applications, and the datagram distribution
are collected in the following file:

$HOME/DPC.addresses.<host>
where <host> is the name of the Operator Station.

You may modify the contents of this file by using the Options
-> Datagram subscriptions choices on the Launchpad.

The datagrams available are listed in the following file:
$HOME/.eso_system/esoSetup.datagrams

This is a static file, and will only be used by the system.
NMEA 0183

The information for the NMEA 0183 depth serial line is stored
in the following file:

$HOME/.eso_system/esoSetup.serial

BIST files

When you run the built-in test applications, the results displayed
in the output area in the BIST window may be saved to disk.
The file is created with the following location and file name:
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$HOME/.eso_system/BISToutput

Every time you save the information, the old file will be
replaced. The information is stored in ASCII format.

Logfiles

Each application in the EM 3000 system issues report and error
messages when required. These messages are collected in
logfiles.

The size of the current logfile is monitored by the system. If it
exceeds 8Mb, a warning dialogue pops up recommending a reset
of the file. The actual reset is done using the File->Reset
Logfile option, as instructed in the popup dialogue.

When you reset the logfile using the File -> Reset logfile
command on the Launchpad, you may create a backup copy of
the logfile. The backup is named:

$HOME/.eso_system/esoLogfile.yyyy mmdd_hhmm
where:

yyyy=year

mm=month

dd=day

hh=hour

mm=minute.

In most cases you do not need to create backup copies of the
logfile, since errors and warnings are logged to the survey
logfiles during active surveying.

In addition to this logfile, the errors and warnings issued during
a survey are saved on a separate file for the active survey. This
file is only created while logging takes place. The file is:

$PROCHOMY/<survey>/esoLogfile
where <survey> is the chosen name for the active survey.

Operator configuration files

These are the individual files containing the operator specified
window layouts and desktop workspaces for the programs
supervised by the EM 3000 Launchpad.

Default window layout

Each operator can define a preferred window and workspace
layout, and then use the Window Layout -> Save Operator’s
Layout command on the launchpad’s main menu to save this
information. The name of the file will be:
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$HOME/.eso_system/esoEmX_config.<operator>

where <operator> is the current operator of the system, as
defined in the Launchpad’s Survey field (below the program
icons).

The default window layout is:
$HOME/.eso_system/esoEmX_config

List of known operators

The list of the operators known to the system is stored in the
following file:

$HOME/.es0_system/esoSetup.operators

User preferences

All the preferences you define during the survey are stored in a
separate file.

$HOME/.eso_system/esoSetup.launchpad

This file is created using the Options -> User preferences
command on the Launchpad’s main menu.

Survey jobs

These are the files generated by the Survey Display’s Planning
module. All these plans are located in the following directory:

$SHAREDHOME/<job name>.asciiplan

TOC files

The TOC (Table of Contents) files are created automatically
when you select the Generate Tape TOC operation in the File
Admin window.

Each TOC file contains a list of oll the files on the tape. This is
normally all the files used for a specific survey, but in general it
can be any file types recognized by the File Admin utility.

The TOC files can be named manually, or they can be assigned
a name automatically. This name is then defined based on the
curernt date and time with extension *. TOC.

The files are stored in the following directory:
$HOME/.eso_system/

Helmsman Display
The Helmsman Display uses a file named:
$PROCHOME/<survey>/courseoffset
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This file contains one single line defining the course deviation
in 1/10 degrees. This factor is added to all the course
calculations made by the Helmsman Display.

The information is entered in the View -> Show/Hide window
in the Survey Display.
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Introduction

The main files are described in this chapter, but the header files
that follow the system are only referred to and must be inspected
by listing the header file of current interest or by checking the
computer display.

Survey format and 170 library

The Survey Format (SF) files are the key files of the
Kongsherg Maritime workstation systems. The files are located
in the $SPROCHOME directory. An I/O library from
Kongshberg Maritime is supplied to the users who wish to access
the data themselves. You can then install the 1/O library
whereever it fits for your development. Header files and
libraries are available.

The SF is a Kongsberg Maritime defined format that fits for all
Kongsberg multibeam echo sounder data, and for the EA 500
and EK 500 single beam echo sounders. The data is converted
directly to this format if a Kongsberg Maritime logging system
is used. As the lines are run, the raw data is fed into the
handleMessage or handleEmX filter and stored correctly on
the SPROCHOME/<SurveyName> directory, while the
survey.lines file on the same directory is updated with
information about the same line.

The survey format

Introduction

This is the Kongsberg Maritime workstation processing format
that applies to all multibeam echo sounders and also to some
single beam echo sounders. The format is used in other
workstation products in addition to Neptune, such as Merlin,
Poseidon and Triton.

The format is based on indexed files. For each line there is an
index file which holds some common index data for each ping.
The files handled by the index file are:

1 Depth file
2 Sonar Image file
3 Classification file

The following files have been defined as system administration
files:
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4 Parameter file
5 sound speed file
These files contain parameter settings and information about the

sound speed that has been used during the data collection. The
information about the used sound speed is vital for reprocessing
old data with new sound speed profiles.

The position files (there might be several due to more than one
positioning system) are treated separately. After position
processing, a new valid position file is generated and will be
used for further processing (Sensor 00), version 02.

A representation of the file structure is described by the

following:
Index file
FileHeadrec
PingHeadRed

IndexFileRec 1
1

IndexFileRec 2

IndexFileRec i
eci

IndexFileRec n
n

Raw sidescan file
FileHeadRec
SideHeadRec
SideRawFileRec 1
SideRawFileRec 2

SideRawFileRec n

Depth file
FileHeadRec
DepthFileRec 1
DepthFileRec 2

Parameter file
FileHeadRec

ParameterRec 1
ParameterRec 2

ParameterRec n

Position file
FileHeadrec
PosHeadRec
PositionFileRec

PositionFileRec

PositionFileRec

sound speed file
FileheadRec
SndVelFileRec 1
SndVelFileRec 2

SndVelFileRec n

219



EM 3000 / Base version

220

Survey format 1/0 library

The 1/0 sub-routine library can be used by a company or
institution who have bought a license for a Kongsberg Maritime
workstation product. It can also be distributed by the Kongsberg
Maritime customer to others after agreement between
Kongsberg Maritime and the institution or company.
Maintenance and help with the library and files are given to
those who have maintenance contract with Kongsberg Maritime.

The Survey format coordinate system

The coordinate system of the vessel has an x-axis along the
ships keel pointing forwards from the origin of the ship. The
y-axis points to starboard, and the z-axis points straight down
giving the depths as positive values increasing with depth.

This generates the right-hand coordinate system on board the
ship. Positive rotation around the axis is defined by the
right-hand rule, giving a positive rotation of angles in the
horizontal plane in the same way as the gyro rotates positively
(Clockwise as seen from above the ship).

The data that is logged on files is in latitude/longitude
coordinates. The data is represented by a 4-byte integer that has
the following resolutions:

Latitude

2*10E7 decimal degrees per number unit (+90 to -90
degrees).

Longitude:

1*10E7 decimal degrees per number unit (+180 to -180
degrees).

Depths are treated with centimetre resolution in the EM 3000
system, and represented in this resolution on the XYZ files.

Use of the Kongsberg Maritime 1/0 library
Introduction

The Kongsberg Maritime 1/0O library consists of two different
parts. One part is intended to be used by those who want to fit
their own data into Kongsberg Maritime’s Survey Format (SF)
file format. The modules supported for this use are msgSim and
handleMessage. The handleMessage takes its input data from
the logging program (Mermaid/Merlin) or from msgSim. The
other part is intended to be used by those who want to use
Survey Format data. This part of the library is called RWlib
(Read and Write library). All routines in the library return an
integer as return parameter. This parameter is negative if
something went wrong or the data returned are not valid.
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Message simulator

The message simulator (msgSim) simulates messages from the
logging system by reading one or more raw data files, putting
the message length in front of each message and writing it to
stdout. If the messages are separated on different data files, the
files containing the depth data message must end with .dpt,
position data with .pos, sidescan data with .rss and
start/stop/parameter data with .inf. The module also handles the
situation when all messages are collected in one file. All of
these data files must only contain valid, complete messages and
nothing else.

Message handling

Messages from Mermaid/Merlin or msgSim may be ’piped’ into
handleMessage. This module reads the messages from stdin,
decodes them into survey format and writes them to file. The
files written are:

* position files (.pos)

* depth files (.depth)

* sidescan files (.sidescan)
* parameter files (.para)

* sound speed files (.svel)
* index files (.ind).

The name of the new file starts with the line number, an
underscore, the date of the start telegram, an underscore, the
time, an underscore, sensor number, an underscore, version
number and the extension.

Example:
0183_19921031_155630_00_01.depth

The module starts decoding and writing when a start telegram
arrives and stops when a stop telegram arrives. If sidescan data
is to be handled, depth data must be present, and if the data is to
be used with ”near real time” visualization (i.e. Merlin), position
data must also be present. For information on how to run
handleMessage, see the section ”Command references”.

Library calls

Introduction

The library is written in the ANSI “C” programming language.
The definition and prototyping is done in the *.h files:

¢ readWriteFile.h
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e SurveyLines.h
* newFormat.h

The return structures that you need to know about are found in
the newFormat.h file. This file is documented internally in the
file, while the other *.h files not are intended to be read, just
included to supply you with the structures required for some of
the calls. These calls are described here, and the prototyping is
found in the above listed header files.

Writing new files

For writing new files in SF the library libRW is supported. With
this library you can open, write and close new files in SF.
Before a file (of any type) can be written, it must be opened by
the appropriate open routine for this file type. The input
parameters for these routines are:

* file directory,

* generic file name,

* sensor number (set to 0->zero)
* type specific header,

* acomment and a description of the process which created the
file.

In addition file handler newFilePnt must be supported for each
file (except for opening the index file) and one common write
handler. E.g. this write handler is used for writing indices to
files. To write new records to file, a set of writing routines are
supported. All those writing routines have their specific record
format, their file handler (except for writing pings) and the
common write handler as parameters. When depth data or
sidescan data is written, it must be specified which sounder (port
or starboard for dual system or single for single system) the data
comes from. To close the file (except the index file which is
closed with a specific routine) the routine closeNewFile is called
with the file handler as input.
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All data are written to file in the native format (little or big
Endian) in which the program is running. The index file (with
ping data) is written every time the ping number changes. This
is done automatically in writeDepth or writePing, which means
that these routines must be called in order to let the index and
ping records be written (ping number must be supplied and
properly changed if not present in the raw datagram). Date and
time must also be supplied for each record (ping and position)
so that it will be possible to index a ping from position through
data and time. When the index file is written, all indices are
written including those for sidescan and position. As sidescan
data only are accessible through the index file, all calls to either
writeDepth or writePing must be made. Position data, on the
other hand, may either be accessed via index (for "near real
time”) or via time. But in order to make indices for the position
data correct, all data must be written in time sequence. The
positions are also filtered for coarse jumps (i.e. more than one
degree) and flagged accordingly before they are written.
Available routines are described in the following paragraphs.

Open files
newlindexFile: Open and init index file

(IN: writeHandler, directory, fileName, sensor,
pingHeader, comment, process)

newPosFile: Open and init position file

(IN: fileHandler, writeHandler, directory, fileName,
sensor, posHeader, comment, process)

newDepthFile: Open and init depth file

(IN: fileHandler, writeHandler, directory, fileName,
sensor, comment, process)

newSideFile: Open and init sidescan file

(IN: fileHandler, writeHandler, directory, fileName,
sensor, sideHeader, comment, process)

newSvelFile: Open sound speed file

(IN: fileHandler, writeHandler, directory, fileName,
sensor, comment, process)

newParaFile: Open parameter (start/stop/parameter) file

(IN: fileHandler, writeHandler, directory, fileName,
sensor, comment, process)

Write files
writePos:- Write position data to file

(IN: fileHandler, writeHandler, positionRecord)
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writeDepth: Write depth data to file (and possible also index and ping)

(IN: fileHandler, writeHandler, sounder, depthRecord)
writeSidescan: Write sidescan data to file

(IN: fileHandler, writeHandler, sounder, sidescanRecord)
writePing: Set current ping data, write ping and index data to file

(IN: writeHandler, sounder, pingRecord)
writeSvel: Write sound speed data to file

(IN: fileHandler, writeHandler, soundVelRecord)
writePara: Write parameter data to file

(IN: fileHandler, writeHandler, parameterRecord)

Close files
closeNewfFile: Close a file

(IN: fileHandler)
closelndexFile: Write last index/ping to file (if necessary), close index
file
(IN: writeHandler)

Reading and updating survey data

For those who only want to read or update data on SF, the
library libRW is supplied. With this library you can open, read,
copy, update and close the files containing SF data.

Before anything can be done with a file, it must be opened by
the appropriate opening routine. These routines have the
parameters:

file mode (r or r+)

directory

file name

sensor number (set to 0)

5 file version number as input

In addition a file handler must be supported for each file. For
the index file an index handler must also be supported. It is
through this index handler that depth, sidescan and (for "near
real time”) position data are accessible. The different opening
routines then return some type specific data (e.g. a file header
and number of record). To open a file for reading, set file mode
to r and for updating set file mode to r+.

If the data is written on a machine with little Endian and read on
a machine with big Endian format (or vice versa), it is
automatically swapped when read, or updated. If the file is
copied, then it is always copied to the native format of the
machine the program is running on.

A W0 DN -
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Compressed data can not be transferred between little Endian
and big Endian machines.

Compressed data can not be transferred between little Endian
and big Endian machines.

The data can be accessed in several different ways. Ping data,
position data, sound speed data and parameter data are accessed
via an index number which starts at 0 (zero) and goes up to the
number of records (minus one) for each file. Depth data and
sidescan data are accessed via the file index. This index is set
with the setFilelndexno routine. If the depth and sidescan data
were produced by a dual echo sounder system, the port and
starboard can be accessed via the port and stb parameters; for
single echo sounder system, the sing parameter is used.

To get an interpolated position for a ping, one must first call the
routine initPoslInter. This routine incudes an index to the first
position and number of positions as input parameters. This is
because all indexing on a file within a region is based on the
indices from the position file. The routine uses a handler
posSearchPnt and returns the first valid ping index and number
of indices within the positions. These parameters should then be
used in the loop to access the ping, depth and sidescan data.

To get a ping with its position the routine getPingPos is used.
This uses the parameter indexHandler set by setFilelndexno.
You may also specify the maximum legal difference in time and
in distance from the ping to the two nearest positions. If you
only want ping data at a specific delta distance, this may also be
set. If the routine returns with a negative number, no valid
position exists for this ping. When finished, freePoslInter is
called.

To update a file, the file must be opened with file mode = r+.
Then all the update routines can be used. Access through the
index handler to depth and sidescan files must still be used.
When the updating is finished, updateHeader must be called to
set the right time and process for file updated. If you want to
change other data in the files than flags, the file should be
copied (with copyFile) before it is updated. The routine
copyFile has as input parameter the file handler and the new
directory, and it returns the new file version number.

To make a new position file from several position files
(combine), the general file header must be copied with
copyHeader. Then the copied file (header) must be opened
with openPosFileAppend and position can be written (in
sequence) with updatePostion.
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There are also some convenience routines to update flags for
position, ping and depth data. These routines read the data,
check if some flags are changed and if so, write the changed
data back. Modules that keep original survey data structures in
memory, should use the ordinary update routines instead. Itis
however strongly recommended that you keep track of what
flags (e.g. one variable that tells whether some of the depth flags
for a ping are changed) that are changed, in order to minimize
input/output. When depth flags are updated only those flags
which are not equal NaN (Not a Number) are updated.

The module does also (for the time being) contain some routines
to transform across- and along-data for each beam to either
latitude and longitude or to UTM and to calculate the distance
between two positions. Supplied routines are described in the
following paragraphs.

Open files

openIndexFile Open index file

IN: fileHandler, indexHandler, fileMode, directory,
fileName, sensor, versionNumber,

OUT: pingHeader, sounderSystem, numbOfPing
openPosFile Open position file

IN: fileHandler, fileMode, directory, fileName, sensor,
versionNumber,

OUT: posHeader, numbOfPos
openDepthFile Open depth file

IN: fileHandler, fileMode, directory, fileName, sensor,
versionNumber

openSideFile Open sidescan file

IN: fileHandler, fileMode, directory, fileName, sensor,
versionNumber,

OUT: sideHeader
openSvelFile Open sound speed file

IN: fileHandler, fileMode, directory, fileName, sensor,
versionNumber,

OUT: numbOfSvel
openParaFile Open parameter file

IN: fileHandler, fileMode, directory, fileName, sensor,
versionNumber,

OUT: numbOfPara
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openPosFileAppend Open position file for append

IN: fileHandler, directory, fileName, sensor,
versionNumber, posHeader)

Reading data

setFileIndexno Set index and get ping data
IN: fileHandler, indexHandler, pingindex,
OUT: pingRecord

getDepth Get depth data
IN: fileHandler, indexHandler,

OUT: singDepthRecord, stoDepthRecord,
portDepthRecord

getSidescan Get sidescan data
IN: fileHandler, indexHandler,

OUT: singSidescanRecord, stbSidescanRecord, portSide-
scanRecord

getPosition Get position data
IN: fileHandler, posindex,
OUT: positionRecord

getManyPos Convenience routine to get many
positions

IN: fileHandler, fromPosIndex, numbOfPos,
OUT: positionRecords
getSvel Get sound speed data
IN: fileHandler, svellndex,
OUT: soundVelRecord
getPara Get parameter data
IN: fileHandler, paralndex,
OUT: parameterRecord
getPosIndDateTime Get position indexes from date and time

IN: fileHandler, totNumbOfPos, fromDate, fromTime,
toDate, toTime

OUT: fromPosIndex, numbOfPos

initPosInter Initiate for accessing interpolated
positions for ping

IN: positionFileHandler, indexFileHandler, posSearchPnt,
posHeader, fromPosIndex, numbOfPos, totalNumbofPing,
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OUT: fromPingIndex, numbOfPing
getPingPos Get ping with interpolated position

IN: indexFileHandler, indexHandler, posSearchPnt,
pingIndex, deltaDistance, maximumbDistance, maximumT
imeDifference,

OUT: pingRecord, positionRecord
freePosInter Free data for position interpolation

IN: posSearchPnt

getManyIndex- Get noPing pings from fromPing
IN: indexFileHandler, fromPing, noPing,
OUT: indexes
getNoPing- Get number of ping in file
IN: indexFileHandler,
OUT: noPing
getInterPos Interpolate position from time and date

IN: positionFileHandler, indexFileHandler, posHead,
maxDist, maxTimeDiff,

OUT: newPos
getPosList Get position data into position list

IN: positionFileHandler, posHead, fromPos, noPos,
deltaDist, maxDist,

OUT: pingPosL.ist
getPingList Get position data into ping list
IN: pingHead, posSearch, fromPing, noPing, deltaDist,
maxDist, maxTimeDiff,
OUT: pingPosL.ist

getFromNoOfPing  Get fromping and no of pings for pings
that are between two valid positions

IN: positionFileHandler, indexFileHandler, fromPos,
noPos, totPing,

OUT: fromPing, noPing

flagPosJump Mark all position with pos_jump_flag
which are outside a given range from the
median of the surrounding positions

IN: posHead, noPos, pos, medianFilterType, maxDist

Copy file
copyFile Copy file

IN: fileHandler, directory,
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OUT: versionNumber

copyHeader Copy general file header
IN: fileHandler, directory,
OUT: versionNumber

Update file
updatePing Update ping data and set index

IN: fileHandler, indexhandler, pinglndex, pingRecord
updateDepth Update depth data

IN: fileHandler, indexHandler, singDepthRecord,
stbDepthRecord, portDepthRecord

updateSidescan Update sidescan data

IN: fileHandler, indexHandler, singSidescanRecord, stbSi
descanRecord, portSidescanRecord

updatePosition Update position
IN: fileHandler, posindex, positionRecord
updateHeader Update file header after updating file
IN: fileHandler, process, comment
Update flags
updatePosFlag Update position flag

IN: fileHandler, posindex, positionFlag
updatePingFlag Update ping flag and set index

IN: fileHandler, indexHandler, pingIndex, pingFlag
updateDepthFlag Update depth flag for current index

IN: fileHandler, indexHandler, singDepthFlagL.ist,
stbDepthFlagList, portDepthFlagList

Close file

closeFile Close a file
IN: fileHandler

Convenience routines

Some routines has been developed to make life easier for the
programmers. These functions are listed below.

Transform
toLL Transform each beam to latitude and
longitude
IN: positionRecord, posHeader, gyroHeading,
depthRecord,

OUT: latLongPositions
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toUTM Transform each beam to UTM
IN: utmSone, positionRecord, posHeader, gyroHeading,
depthRecord,
OUT: utmPositions

getDiffDist Calculate distance between to positions
(in centimetres)

IN: fromPositionRecord, toPositionRecord, posHeader
OUT: distance

calcDirection Calculate the direction from one position
to another (in milli- degrees)

IN: fromPositionRecord, toPositionRecord, posHeader
OUT: direction

Header files

For each file there is a description on what it contains. The
documentation is on the header file itself, and the user should
consult this file. It is found in the 10 library distribution.

For each file there is a description on what it contains. The
documentation is on the header file itself, and the user should
consult this file. It is found in the 10 library distribution.

readWriteFile.h Handlers and prototypes for
readWriteFile.c

newFormat.h Definition of survey format.

process.h Process id. description

datum.h List of datums

cdefine.h Definitions of some C programming

definitions used in the programs.

general.h Definition of some general structures that
are used several places in the code.

Surveylines library

This file is important for all the processing. It includes all the
lines of the survey, and identifies which versions are the most
recent. The file is binary and is located on the
$PROCHOME/<SurveyName> directory.

The file survey.lines is an index of all existing SF data files on
current directory. The file current.line identifies the line
currently being processed. These two files must be updated by
the modules writing or updating SF files. All modules reading
SF files get a list of existing survey format files by reading the
survey.lines file. The sensors that exists for the different lines
are also listed on a specific file. This is the line.sensors file. In
addition a file called adm.data contains the sensors of the
survey with their name and their id numbers.
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Writing and updating
The following routines are supplied:

int SIAdd (

s110FileType ioFileType /*IN: SL_SURVEY_L or SL_CURRENT_L */
char *dir, /* IN:  Directory name */
char *prefix, /* IN:  File name prefix */

SlsurveyFileType survFileType /* IN: SL_POS, SL_INDEX, SL_DEPTH,or
SL_SIDESCAN */

int version, /* IN:  File version */
ProDescType lastProc /* IN:  Process identification */

)

This function adds a new record to the survey.lines file. Ifa
record for the directory/file name prefix combination of current
interest already exists, this record is updated and no new record
is added. For current.line SIAdd has the same functionality as
for survey.lines, except that when a new record is added, the
previous record is deleted.

int SlUpdate (

SlloFileType ioFileType, /*IN: SL_SURVEY_L or SL_CURRENT_L */
char *dir, /* IN:  Directory name */
char *prefix, /* IN:  File name prefix */

SISurveyFileType survFileType /* IN:  SL_POS, SL_INDEX, SL_DEPTH,or
SL_SIDESCAN */

int version, /* IN:  File version */
ProDescType lastProc /* IN:  Process identification */

)

This function is equal to the SIAdd function, except that the
current directory/file name prefix combination must exist. If
the new version number is lower than the version number on the
survey.lines file, then the datafiles (.pos, .ind, .depth, or
.sidescan) with version number higher than the new version
number will be deleted.

int SIDelete(
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SlloFileType ioFileType, /*IN: SL_SURVEY_L or SL_CURRENT_L */
char *dir, /* IN:  Directory name */
char *prefix, /* IN:  File name prefix */

SISurveyFileType survFileType, /*IN: SL_POS,SL_INDEX,SL_DEPTH, or
SL_SIDESCAN */

ProDescType lastPro /* IN:  Process identification */

)

Delete a survey format file by setting the version equal to 0.
The record is deleted in the survey.lines file. The datafile (.pos,
.ind, .depth, or .sidescan) will be deleted.

int SIDeleteLine(

SlloFileType ioFileType, /*IN: SL_SURVEY_L or SL_CURRENT_L */
char *dir, /* IN:  Directory name */

char *prefix, /* IN:  File name prefix */

ProDescType lastPro /* IN:  Process identification */

)

Deletes all survey format files for a line by setting the versions
equal to 0. The datafiles (.pos, .ind, .depth, and .sidescan) will
be deleted and the file [<dir>/]<prefix>_00_01.para will be
deleted

Reading

The following functions return information in a SlList structure
(See the SurveyL.ines.h file for information about the structure).
The following routines are supplied:

SlList *SlICreateL.ist (
SlloFileType ioFileType, /*IN:  SL_SURVEY_L or SL_CURRENT_L */

)

Function for reading survey.lines and current.line. SICreateL.ist
returns a SlList structure.
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int SlUpdateList (

SlloFileType ioFileType, /*IN: SL_SURVEY_L or SL_ CURRENT _L */

SIList *ioList

852-164371/E

/* IN: Pointer to structure from the
SICreateL.ist function */

SlUpdateL.ist updates an existing SIList structure. Use
SlCreateL.ist once to create the list. Then call SlUpdateL.ist
repeatedly to get information on changes made to the
survey.lines or current.line.

Header files

This is where the programmers can find the definitions of the
structures of this library. The actual header files are:

SurveyLines.h Survey line and current line structures.
lineSensors.h Structures and routines for the
line.sensors file.

Administration file 170

File format

The adm.data file contains the names of the different sensors.
The file is an ASCII file named where for each sensor the
following data are written:

sensor <sensorTypel> <N1><namel>
sensor <sensorType2> <N2><name2>
sensor <sensorTypel> <N3><name3>

where NXx is the sensor number on the Survey Format files, and
namex is the name of the sensor. The sensorTypex is position
or depth. This is when more than the usual EM sensor exists.
The Merlin logging system will build this file and the
survey.lines file automatically, and the default EM sensor is
given by:

sensor position 0 undefined

Reading

To read the file, the following routine is called:
AdReadAdm ( EvHandler *evHand )

And to fetch the sensors read:

AdGetSensors ( int *noSensors, SensorPnt *snrPnt )
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Structures and files

The structures are defined in the adm.h file.
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10.5 Survey Predefined Files
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Introduction

When you define and run a survey, you will always need
information describing basic data or set-up, such as:

* projection data

* user defined colours

* user defined show/hide settings
* coastline contours

* course deviation

The Survey Predefined Files function allows you to build a set
of templates to hold this kind of information.

File locations

The Survey Predefined Files are located in the
$SHAREDHOME directory. In this directory, you can create
subdirectories defining specific survey types, where the type can
be defined by your own choice. You can for example create sets
of files to match specific bottom conditions or geographical
locations.

The result may be (for example):
$SHAREDHOME/Oslofjord/*.*
$SHAREDHOME/Mercator_30_degrees/*.*

In order to create the file structure, and to copy in the files you
wish to use, you need to open a terminal window on your
Operator Station and use the standard Unix commands.

—  Refer to the applicable instruction manual(s) for a description
of the terminal window and the Unix commands.

Using the Survey Predefined Files

When you define a new survey using the options on the EM
3000 launchpad, you are asked which of the Survey Predefined
Files you will use. When you select any of the templates on the
list, the files in that directory are copied over to the survey
directory on $PROCHOME.
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10.6 Projection data
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Scope and purpose

This document defines the interfaces and use of the component
Projection. The purpose with the document is to describe how
the component interfaces with other components, and how the

component is to be used.

Projection overview

Each and every survey should have a well defined projection.
The Kongsberg Maritime Software will use the defined
projection in all geographic displays and in many other
programs where a projection is needed.

There are three major different ways to define a projection in
the Kongsberg Maritime Software:

1 You have full access to the library PROJ.4 from USGS.

2 You can give Kongsberg Maritime the source code (in
“C”) to his preferred projection, and make that projection
a permanent part of all Kongsberg Maritime Software.

3 You can program your own projections into the shared
library (libsharedProj.so) which is used in all Kongsberg
Maritime Software. A template of the source code is
supplied by Kongsberg Maritime.

It should be noted that Kongsberg Maritime knows nothing
about what goes on inside your projection routines. Some of
these routines may contain datum transformations which should
be known to the system operator.

Projection protocol

You should for each and every survey define your preferred
projection. The projection used in a survey is defined in the file

$PROCHOME/<survey>/projection.data

The first word in the first line defines which projection to use.
The file may look like this:

1 If the first word is “RijksDriehoksnet”, the preferred
projection for the Netherlands is used.

2 If the first word is “utm”, a UTM-projection is used.
Setting the UTM zone is however a little tricky:

utm
03
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03

If the file looks like the above, UTM zone 31 is selected.
The number 3 is the longitude.

If the first word is “sharedlib”, the projection from the
shared library libsharedProj.so is used

If the first word is “user_defined”, a user defined
projection from the USGS PROJ.4 library is used.

The file SPROCHOME/<survey>/projection.data may
then look like this:

user_defined defaultProjections:proj1

This means that the user defined projection using PROJ.4
is found in the file $PROJ_LIB/defaultsProjections and
that the setup for the projection is taken from <proj1>.

The file $PROJ_LIB/defaultsProjections may look like
this:

(which is standard PROJ.4, ref. [1], [2] and [3]):

<proj1>

proj=stere
x_0=155000
y_0=463000
k=0.9996
lat_0=52.156160556
lon_0=5.387638889
<proj2>

proj=utm

zone=31

If the first word is “GK_AUSTRIA”, the preferred
projection for Austria is selected. There are 16 parameters
which controls this projection and they are all kept in the
same file. These 16 parameters must be in the specified
order in the file, the rest of the file is comments. As we
can see this projection performs a datum transformation
from WGS 84 to Bessel (Europe) prior to the projection.
The projection itself is a Gauss-Kriger.

$PROCHOME/<survey>/projection.data may look like
this:

GK_AUSTRIA
-563.9

-82.3

-463.4

4.47

4.85
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1.88

4.46

6377397.155

299.15281285

16.333333333333

6378137.0

298.257223563

0

-5000000

500

I Linel: GK_AUSTRIA tells Simrad Software

I to use Gauss-Kruger for Austria.
I Transformationsparameter
I fir die Umwandlung von WGS84-Koordinaten
I nach Gauss-Kriiger-Koordinaten bezogen
I auf das Datum MGl

I Zeile 1: Translation in x [m]
I Zeile 2: Translation iny [m]

I Zeile 3: Translation in z [m]

I Zeile 4: Malstab

I Zeile 5: Rotation in x [”]

I Zeile 6: Rotationiny [”]

I Zeile 7: Rotationinz[”]

I Zeile 8: grolle Halbachse [m]

I Nutzersystem (z.B. Bessel)

I Zeile 9: Abplattung Nutzersystem

I (z.B. Bessel)

I Zeile 10: Zentralmeridian Nutzersystem
I (z.B. Bessel)

I Zeile 11: groRe Halbachse [m] WGS84
I Zeile 12: Abplattung WGS84
I Zeile 13: Zuschlag Rechtswert

I Zeile 14: Zuschlag Hochwert

I Last line: Fixed height used in

I projections.

Notes

The setup of the projection is quite important to do right which
means that this should be done by qualified persons only. In the
Neptune/Survey Display system it is possible to set up default
surveys that you can use as templates for new surveys. These
default surveys can then be set up with the correct projections
and given names which makes it easy for the operator to choose
a default survey of the correct type.
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There is already a file $PROJ_LIB/defaultsProjections which is
in use if some of the standard default surveys are used.
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Introduction

This chapter defines the interfaces and use of the component
Dynamic Projection Library.

The purpose is to describe how the component interfaces with
other components and how the component is to be used.

Overview

There need to be defined a shared library where the customer
can implement his own projection routines to use with
Kongsberg Maritime’s Graphic System. This shared library will
then be a permanent part of all graphic windows.

Dynamic projection library definitions

In the graphic system today you can set projection and some
projection parameters in the file

$PROCHOME/<survey>/projection.data.

This file will also be used when you specify that projections
shall be taken from the shared library libsharedProj.so. The
shared library for customer defined projections,
libsharedProj.so, must be put somewhere where the loader
will find it at startup, /usr/lib/libsharedProj.so.

Dynamic projection library protocol

When you wish to use a projection defined in the shared library,
the first line in the file
$PROCHOME/<survey>/projection.data must look like this:

sharedlib 5
The number (here: 5) is defined by you.

When the program (i.e. Survey, Merlin, GridDisplay) starts, it
will look for the file
$PROCHOME/<survey>/projection.data. When it finds the
word sharedlib as the first word in the file, the next word is
read as an integer which identifies which projection will be
used.

The initUserProjection routine is then called with this number
as a parameter. This enables you to do additional initialisation to
the projection. Since only the first line in $PROCHOME/
<survey>/projection.data is used by the system, you can
freely use the rest of this file for additional parameters to be
read at startup time.
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Each and every projection should be associated with a name.

This name will appear when you wish to plot something on a
plotter. For Kongsberg Maritime’s Graphic System to get this

name, you must supply a routine getUserProjectionName

which also has the number as an input parameter and returns a
string with the name to be used for the projection.

When Kongsberg Maritime’s Graphic System is set up to use
projection routines from the shared library libsharedProj.so, it
will do so by calling two routines. The routine used for

projection is userProjectionLatLongToNorthEast, and the

routine used for the reverse projection is
userProjectionNorthEastToLatLong.

Example

This is an example of how the codes for

initUserProjection
getUserProjectionName
userProjectionLatLongToNorthEast
userProjectionNorthEastToLatL.ong

should look like:

/*
* %
* %
* %
* %
* %
* %
* %
* %
* %
* %

* %

**FILEHEADER* *
$Id: dummyRoutines.c,v 1.1.1.1
1997/01/23 08:45:44 tp Exp $

Filename: dummyRoutines.c

Date of creation: 23 Jan 1997

Creator: Terje Pedersen

Purpose: Dummy-routines for the shared
library libsharedProj.so
which can be changed by the customer.

Copyright: Kongsberg Simrad AS

*%* FILEHEADER */

#include <stdlib.h> /*calloc-function*/

#include <string.h> /*memcpy-function*/
/* SRR R R R R R R R R R R

*

*

*

Routine:
initUserProjection
Purpose:
Initialize the user’s preferred
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* projection. The programmer has access to
* the file projection.data in current

* directory which the user controls.

* Parameters:

* int userProjectionNumber (input)

* This is the number found in

* projection.data

* where the first line looks like this:

* sharedlib 4

* In this case userProjectionNumber will be
* 4.

* Return values:

* 0 on success, -1 on error.

* References:

* The Component Interface

* Doucument: Neptune/UserProjections.
* Changes:

* %% G*x% **********************************/

int initUserProjection(int
userProjectionNumber)

{
switch (userProjectionNumber) {
case 1:
break;
default:
return -1;
}/*switch*/
return 0;
}/*initUserProjection*/
/* SRR R R R R R R R R R R R

* Routine:

* getUserProjectionName

* Purpose:

* Get the name to display in the
* menus for this user projection.

* Parameters:
* int userProjectionNumber (input):

* This is the number found in

* projection.data

* where the first line looks like this:
* sharedlib 4

* In this case userProjectionNumber will
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* be 4.

* Return values:

* A dynamically allocated character array
* containing the name of the projection to
* use. On error NULL is returned.

* References:

* The Component Interface Doucument:
* Neptune/UserProjections.

* Changes:

* %% G*x% ************************************/

char *getUserProjectionName(int
userProjectionNumber)

{
char *p;

if ((p = calloc(20,sizeof(char)))==NULL)
return NULL;

switch (userProjectionNumber) {
case 1:
memcpy (p, "User Projection 1”,18);
break;
default:
free(p);
return NULL;
}/*switch*/
return p;
}/*getUserProjectionName*/

/* *hGhk Fhhkhkhkhkhkhkhkhkhkhkhhhkhdrkrdhrdrrdrkrdrkrdrrdhrx

* Routine:

* userProjectionLatLongToNorthEast
* Purpose:

* This routine is called to get the
* projection coordinates from the

* geographic coordinates.

* Parameters:
* int userProjectionNumber (input):

* See initUserProjection.

* double latitude, double longitude (input):
* latitude and longitude in decimal

* degrees.

* double *north, double *east (input/output):
* pointers to doubles where to store the

* projection coordinates north and east

243



EM 3000 / Base version

244

* (in meters).
* Return values:
* 0 on success, -1 on error.
* References:
* The Component Interface Doucument:
* Neptune/UserProjections.
* Changes:
* %% Gx% ************************************/
int userProjectionLatLongToNorthEast(int
userProjectionNumber,
double latitude, double longitude,
double *north, double *east)

if (north == NULL || east == NULL) return
-1;
switch (userProjectionNumber) {
case 1:
break;
default:
return -1;
}/*switch*/
return 0;
}/*userProjectionLatLongToNorthEast*/

/* *hGhk Fhkkhkhkkhkhkhkhhkhkhhhhdrrhhrdrkrdrkrdrrdrrdrx

* Routine:

* userProjectionNorthEastToLatLong
* Purpose:

* This routine is called to get the
* geographic coordinates from the

* projection coordinates.

* Parameters:

* int userProjectionNumber (input):

* See initUserProjection.

* double north, double east (input):

* Projection coordinates (meters)

* double *latitude, double *longitude

* (input/output):

* Pointers to doubles where to store the
* geographic coordinates latitude and
* longitude (desimal degrees).

* Return values:

* 0 on success, -1 on error.
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* References:
* The Component Interface Doucument:
* Neptune/UserProjections.
* Changes:
* %% Gx%k ************************************/
int userProjectionNorthEastToLatLong(int
userProjectionNumber,
double north, double east,
double *latitude, double *longitude)

if (latitude == NULL || longitude == NULL)
return -1;

switch (userProjectionNumber) {
case 1:
break;
default:
return -1;
}/*switch*/
return 0;
}/*userProjectionNorthEastToLatLong*/

The makefile on a DEC OSF1 UNIX workstation looks like
this:

# $Id: Makefile,v 1.1 1997/01/23 11:12:07 tp
Exp $

# Makefile to create libsharedProj.so.
#

# 23 Jan 1997, Terje Pedersen

#

# Copyright: Kongsberg Simrad AS

#

#

.PHONY:install 1lib clean

CC=cc

LD=1d

LDFLAGS=-shared -no_archive
INSTALL=/usr/local/lib
dummyRoutines.o: dummyRoutines.c
€s(cc) -c s<

lib: dummyRoutines.o
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@$(LD) $(LDFLAGS) -0 libsharedProj.so
dummyRoutines.o -lc

install: 1lib

@cp libsharedProj.so

$ (INSTALL)/libsharedProj.so

@cp dummyRoutines.h

$ (NEPTUNEHOME ) /include/simrad/.

@ls -1 $(INSTALL)/libsharedProj.so

@ls -1

$ (NEPTUNEHOME ) /include/simrad/dummyRoutines.h

clean:
@rm dummyRoutines.o libsharedProj.so

The makefile is probably very similar on other platforms.

Notes

There are some restrictions on shared libraries on every
platform. You should be aware of this. When upgrading
Kongsberg Maritime Software the customer’s shared library
should be reinstalled to make sure it is the one being used. You
are encouraged to use the initialisation routine to test that the
projection is working.

Heights are not used in Kongsberg Maritime’s Graphic system.
It is not necessary in the projections since the height varies very
little within one survey that a fixed height will suffice. This can
be a parameter in $PROCHOME/<survey>/projection.data
that you can read at startup time and use in the projections
internally.
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11 SPARE PARTS

11.1 Overview

This chapter contains an illustrated presentation of the spare
parts available for the EM 3000 multibeam echo sounder. All
the parts are not listed her, only those defined as Line

11.2 Spares data presentation

Replaceable Units (LRU) to be changed by the on-board

maintenance personnel.

Spares table

The parts are presented in a table format (’5008”) specified by
the Royal Norwegian Navy.

An example is shown below.

10 11 13 15 18 21 22
SNo | Drawing ref |Prod.p.no Article name Price Unit Quantity
12 14 16 19 26 27
Other ref. TM part.no Technical data ™ User- Base
code spares |spares
24 17 23 20 25
Date NATO No Status Comp Ser.no.
1 Fig.1 290-085827 Powec Power Supply - EA 1
- - - 0 0
05.03.97 - PMP 4M.02 - C N/A
2 Fig.1 299-049179 Fan Drawer Assembly - EA 3
05.03.97 - - 0 0
- - C N/A
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The parts information in this table also conforms to the civilian
standard NS 5820 specified by the Norwegian Standardisation
Society (Norges Standardiserings Forbund).

247




EM 3000 / Base version

Parts list codes
These are the code descriptions for the information in the table.

Key codes to the parts list

No Caption Description

10 Serial no. Row number in list.

11 Drawing no. & item no. | The number of the drawing, and the position on that
drawing, of the part.

12 Other references Any other applicable references are included here.

13 Producer’s part no. The part number to be used when ordering spares from
Kongsberg Maritime AS.

14 True manufacturer’s Part number designated by manufacturer of part. Will be

part no. same as (13) if part is manufactured or assembled by

Kongsberg Maritime AS.

15 Article name The name of the unit or part.

16 Technical data Any additional technical information which may be
relevant.

17 NATO catalogue no. The NATO stock number will be added where appropriate.

18 Currency/unit price Price of the part, and the applicable currency
19 True manufacturer’s This is a code number to identify the suppliers of the parts
code to enableyou to order directly from the suppliers in an

emergency.

20 Component Component definition.
C = a component which cannot be broken down into
smaller units.
P = a part which may contain separately replaceable
components.
S = a set of parts.

21 Unit The Sl units applicable to the component. E.G. m = metric
units for bolts etc.

22 Quantity The total number of that particular part included in the
system.

23 Status Code for use by the Navy. Will be completed by the Navy

24 Date This is the date the row was last updated.

25 Serial number The component serial number where applicable.

26 User spares The suggested number of spares to be held by the user.

27 Spares at base The suggested number of spares to be held at the user’s
home base.
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11.3 Operator Station (HWS 10) spare parts

The line replaceable units in the HWS10 Operator Station are
circuit boards, fans and power supply

Commercial items can be replaced by other manufactureres than

the ones listed here. But be sure of compability.

SNo | Drawing ref | Prod.p.no Article name Price | Unit Quantity
Other ref. TM part.no Technical data ™ User- Base
code |[spares |[spares
Date NATO No Other information Status | Comp Ser.no.
1 Fig.- 719-099078 Motherboard - EA 1
- PC-DL DELUXE - - 0 0
01.04.04 - Commercial item (ASUS) - C N/A
2 Fig.- 719-099080 Memory PC2700, 512 MB - EA 4
CT64722335 DDR DIMM, Unbuffered, ECC - 0 0
01.04.04 - Commercial item (Crucial) - C N/A
3 Fig.- 719-099079 Processor - EA 1 (or2)
BX80532KE2800B | Intel 2.8 GHz Xeon (PC533) - 0 0
01.04.04 - (mounted on the motherboard) - C N/A
4 Fig.- 719-099081 Graphics card - EA 1
V9560XT Nvidia FX5600XT 128 MB - 0 0
01.04.04 - Commercial item (ASUS) - C N/A
5 Fig.- 719-099093 Hard disk - EA 1
WD1200JD IDE, Caviar 120 GB, S-ATA - 0 0
01.04.04 - Comm. item (Western Digital) - C N/A
6 Fig.- 719-099082 Hard disk - EA 2
WD360GD Raptor 36.7 GB S-ATA - 0 0
01.04.04 - Comm. item (Western Digital) - C N/A
7 Fig.- 719-099085 Hot-Swap drive enclosure - EA 2
SuperSwap 1100 Disk enclosure for S-ATA disk - 0 0
01.04.04 - Commercial item (Promise) - C N/A
8 Fig.- 719-099083 DVD recorder - EA 1
PX-708A/T3B 8 x DVD+R - 0 0
01.04.04 - Commercial item (Plextor) - C N/A
9 Fig.- 719-099090 3.5” floppy disk - EA 1
MPF-920-2/121 - - 0 0
01.04.04 - Commercial item (Sony) - C N/A
10 Fig.- 719-099133 Ethernet card - EA 1
PILA8460BN 10/100 Mbs - 0 0
01.04.04 - Commercial item (Intel) - C N/A
11 Fig.- 719-099084 SCSI card - EA 1
DC-315U Ultra Ultra narrow - 0 0
01.04.04 - Commercial item (Tekram) - C N/A
12 Fig.- 719-099086 Power supply - EA 1
EG465AX-VE(W) | ATX 460W PFC - 0 0
01.04.04 FM 24P Commercial item (Enermax) - C N/A
13 Fig.- - Fan - EA 1
FD121225HB 80mm, 12Vdc - 0 0
01.04.04 - Commercial item - C N/A
14 Fig.- - Fan - EA 1
KM128025HB 120mm, 12Vdc - 0 0
01.04.04 - Commercial item - C N/A
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11.4 Processing Unit spare parts
The line replaceable units in the EM 3000 Processing Unit are:
* Circuit boards
* Fans
* Power supply

Note The AUV Processing Unit does not contain a power supply and
serial board.
BIF I BSP |
|:F|
e o =
0
i | @ NECL I =y
i I =
CPU board ||| | | — f
ethernet
adapter L BIFII
{%; 2 s BSP Il
£
power 3 .
8 4-ports serial
supply line board
]
! fan
@
N
NS
: (CD5868c/125-1342521)

Figure 29 The Processing Unit, spare parts

The spare parts in The Processing Unit are those circuit boards
used in the chassis.
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Standard Processing Unit spare parts

SNo | Drawing ref |Prod.p.no Article name Price | Unit Quan-
tity
Other ref. TM part.no Technical data ™ User- Base
code |[spares |spares
Date NATO No Other information Status | Comp Ser.no.
3 Fig.29 719-098382 4-ports Serial Line Board - EA 1
- Cl-104JS - 1 0
21.06.02 - - C N/A
3 Fig.29 719-087002 4-ports Serial Line Board - EA 1
- C114P - 1 0
21.06.02 - - C N/A
3 Fig.29 382-214580 Beamformer & Signal Processor - EA 2
- (BSP, Old PU) - 0 1
21.06.02 - - C N/A
3 Fig.29 382-218016 Beamformer & Signal Processor - EA 2
- (BSP, New PU) - 0 1
21.06.02 - - C N/A
3 Fig.29 382-211722 Beamformer Interface (BIF B) - EA 2
- - 0 1
21.06.02 - - C N/A
5 Fig.29 719-087003 Ethernet Adapter - EA 1
- - 0 1
21.06.02 - Commercial item - C N/A
3 Fig.29 719-097597 Disk On Module - EA 2
- (mounted on the Processor board) |- 0 1
21.06.02 - - C N/A
2 Fig.29 719-087004 Passive Backplane - EA 1
- - 0 0
21.06.02 - Commercial item - C N/A
2 Fig.29 719-098108 Processor Board VIPer - EA 1
- - 0 0
21.06.02 - Commercial item - C N/A
2 Fig.29 719-097239 Processor Board SSC - EA 1
- - 0 0
21.06.02 - Commercial item - C N/A
2 Fig.29 290-133924 Power Supply - EA 1
- - 0 0
21.06.02 - - C N/A
6 Fig.29 129-096870 Fan, axial, 12 Vdc - EA 2
- - 0 1
21.06.02 - Commercial item - C N/A
6 Fig.29 129-096790 Fan, axial, 24 Vdc - EA 2
- - 0 1
21.06.02 - Commercial item - C N/A
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AUV Processing Unit spare parts

CPU

Fan Unit

SC
ﬂ 20209

N,

(Cd6429d/860-218015aa)

Figure 30 The AUV Processing Unit, spare parts

BIF B

BSP |

SNo | Drawing ref |Prod.p.no Article name Price | Unit Quan-
tity
Other ref. TM part.no Technical data ™ User- Base
code |[spares |spares
Date NATO No Other information Status | Comp Ser.no.
1 Fig.30 719-097988 Processor Board - EA 1
- - 0 0
12.03.02 - Commercial item - C N/A
2 Fig.30 382-211722 Beamformer Interface (BIF B) - EA 1
- - 0 1
12.03.02 - Commercial item - C N/A
3 Fig.30 382-218016 Beamformer & Signal Processor - EA 1
- (BSP) - 0 1
12.03.02 - Commercial item - C N/A
4 Fig.30 382-215857 Passive Backplane - EA 1
- - 0 0
12.03.02 - - C N/A
5 Fig.30 719-097987 Disk On Module - EA
- (mounted on the Processor board) |- 0 1
12.03.02 - - C N/A
6 Fig.30 129-098158 Fan, axial, 5 Vdc - EA
- - 0 1
21.06.02 - Commercial item - C N/A
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11.5 Sonar Head spare parts

The line replaceable units in the EM 3000 Sonar Head are:

¢ Circuit boards

* Cable
SNo | Drawing ref |Prod.p.no Article name Price Unit Quantity
Other ref. TM part.no Technical data ™ User- Base
code spares |spares
Date NATO No Other information Status Comp Ser.no.
1 - 382-210927 HCT board - EA 1
- - - 1 0
15.01.04 - - C N/A
2 - 382-112338 HRX board - EA 1
- - - 0 0
15.01.04 - - C N/A
3 - 380-133240 Sonar Head cable - EA 1
- - - 0 0
15.01.04 - - C N/A
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12 DRAWING FILE

12.1 Introduction

This chapter holds drawings that are in addition to the
illustrations in the manual.

12.2 Drawing list
The following drawings are included:

860-211463 (Rev. A)
Sonar Head, complete 1/2(page 255)

869-211463 (Rev. A)
Sonar Head, complete 2/2 (page 256)
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